Xitracs™
System User Guide

© 2022 Concord USA Inc

Version 6.1e

For Xitracs Release 6.1
Build 6.1.12.0 or later

This document is for System Users.
For Portal Users, see the separate publication Xitracs Portal User Guide.
All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.
Table of Contents

Part I Introduction ................................................................. 9
  1 Overview ............................................................................. 9
  2 Getting Started ................................................................. 11
  3 Home Page ......................................................................... 12
  4 Tab Menu ............................................................................ 13
  5 User Details ......................................................................... 13
  6 Using the Text Editor .......................................................... 14

Part II Xitracs Assessment™ ..................................................... 16
  1 Overview ............................................................................. 16
  2 Course Assessments ......................................................... 17
     Section-level Assessment .................................................... 17
  3 General (Juried) Assessment Workflows .............................. 18
     Create a Workflow ............................................................... 18
     Workflow Datasets .............................................................. 20
     Workflow Details ............................................................... 20
     Workflow List ..................................................................... 23
     Workflow LMS Transfer ...................................................... 23
     Workflow Narrative ............................................................ 24
     Workflow Notes ................................................................. 24
     Workflow Progress ............................................................. 24
     Workflow Report ............................................................... 25
  4 Courses .............................................................................. 26
     Courses ............................................................................ 26
  5 Outcomes ............................................................................ 28
     Outcomes Library ............................................................... 28
     Outcomes Methods ............................................................ 28
  6 Reports .............................................................................. 30
     Reports ............................................................................ 30
  7 Rubrics .............................................................................. 31
     Rubric Library .................................................................... 31
  8 Students ............................................................................ 32
     Students ........................................................................... 32
  9 Control Panel ..................................................................... 33
     LMS Integration .................................................................. 33
     Blackboard ....................................................................... 33
     Canvas ............................................................................. 33
     D2L Brightspace® ............................................................... 34
     Manage Outcomes ............................................................. 37
     Manage Students ............................................................... 38
     Student Groups ................................................................. 39
     Operations ....................................................................... 40
     Portal .............................................................................. 40

© 2022 Concord USA Inc  Xitracs Release 6.1e
Part III  Xitracs Credentials™

1 Overview .................................................................................................................. 42
2 Faculty & Staff ............................................................................................................ 43
   Faculty & Staff Details ............................................................................................ 43
   Base Data .................................................................................................................. 43
   Qualifications .......................................................................................................... 44
   Courses ..................................................................................................................... 44
   Eligibility ................................................................................................................... 45
   AACSB ....................................................................................................................... 45
   Activities ................................................................................................................... 45
   Groups ....................................................................................................................... 45
   Documents ............................................................................................................... 46
   Feedback .................................................................................................................... 46
3 Schools & Departments ............................................................................................. 47
   Schools ...................................................................................................................... 47
   Departments ............................................................................................................. 47
   Courses ..................................................................................................................... 47
4 CIP Codes .................................................................................................................. 48
   CIP Codes ............................................................................................................... 48
5 Reports ....................................................................................................................... 49
   Reports ...................................................................................................................... 49
6 File-Q™ ..................................................................................................................... 50
   File-Q™ Channels .................................................................................................... 50
7 Control Panel ............................................................................................................. 51
   Initial Setup .............................................................................................................. 51
   Course Catalog ....................................................................................................... 52
   Course Outcomes .................................................................................................... 56
   CIP Codes ............................................................................................................... 57
   Credentialing Workflows ......................................................................................... 58
   Faculty & Staff Teams ............................................................................................ 59
   File-Q™ Workflow Channels .................................................................................. 59
   Manage Departments ............................................................................................. 60
   Manage Disciplines ................................................................................................. 61
   Manage Schools ....................................................................................................... 62
   Manage Semesters ................................................................................................. 63
   Manage Faculty & Staff Members .......................................................................... 64
   Manage Faculty & Staff Settings .......................................................................... 66
      Qualifications ...................................................................................................... 69
   Reports ..................................................................................................................... 70
   Automap Credentials .............................................................................................. 71
   Synchronize Credentials ......................................................................................... 71
   Xitracs Add-Ons ..................................................................................................... 72

Part IV  Xitracs Planning™

1 Overview .................................................................................................................... 73
2 Plans ........................................................................................................................... 74
   Editing a Plan ........................................................................................................... 74
   Log ............................................................................................................................. 75
<table>
<thead>
<tr>
<th>Contents</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td>76</td>
</tr>
<tr>
<td>Links</td>
<td>76</td>
</tr>
<tr>
<td>Permissions</td>
<td>77</td>
</tr>
<tr>
<td>Dates</td>
<td>77</td>
</tr>
<tr>
<td>Status</td>
<td>78</td>
</tr>
<tr>
<td>Preview</td>
<td>79</td>
</tr>
<tr>
<td>Publish</td>
<td>79</td>
</tr>
<tr>
<td>Teams</td>
<td>80</td>
</tr>
<tr>
<td>Workflow</td>
<td>82</td>
</tr>
<tr>
<td>3 Goals</td>
<td>82</td>
</tr>
<tr>
<td>Goals</td>
<td>82</td>
</tr>
<tr>
<td>4 Summary</td>
<td>83</td>
</tr>
<tr>
<td>Plan Snapshot</td>
<td>83</td>
</tr>
<tr>
<td>5 Surveys</td>
<td>83</td>
</tr>
<tr>
<td>Overview</td>
<td>83</td>
</tr>
<tr>
<td>Activity</td>
<td>84</td>
</tr>
<tr>
<td>Questions</td>
<td>84</td>
</tr>
<tr>
<td>Responses</td>
<td>84</td>
</tr>
<tr>
<td>6 Reports</td>
<td>84</td>
</tr>
<tr>
<td>Activity Log</td>
<td>84</td>
</tr>
<tr>
<td>Due Date</td>
<td>84</td>
</tr>
<tr>
<td>Progress</td>
<td>84</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>84</td>
</tr>
<tr>
<td>7 Control Panel</td>
<td>85</td>
</tr>
<tr>
<td>Manage Plans</td>
<td>85</td>
</tr>
<tr>
<td>Building a Plan</td>
<td>86</td>
</tr>
<tr>
<td>Copying a Plan</td>
<td>89</td>
</tr>
<tr>
<td>Plan Properties</td>
<td>89</td>
</tr>
<tr>
<td>Plan Settings</td>
<td>89</td>
</tr>
<tr>
<td>Plan Field Sets</td>
<td>92</td>
</tr>
<tr>
<td>Plan Groups</td>
<td>93</td>
</tr>
<tr>
<td>Templates</td>
<td>93</td>
</tr>
<tr>
<td>Timeframes</td>
<td>94</td>
</tr>
<tr>
<td>Tracks</td>
<td>94</td>
</tr>
<tr>
<td>Manage Surveys</td>
<td>95</td>
</tr>
<tr>
<td>Building a Survey</td>
<td>95</td>
</tr>
<tr>
<td>Distributing a Survey</td>
<td>96</td>
</tr>
<tr>
<td>Linking to Plans</td>
<td>97</td>
</tr>
<tr>
<td>Respondents</td>
<td>97</td>
</tr>
<tr>
<td>Portal</td>
<td>97</td>
</tr>
<tr>
<td>Survey Distribution Lists</td>
<td>98</td>
</tr>
<tr>
<td>Workflow</td>
<td>98</td>
</tr>
</tbody>
</table>

Part V Xitracs Programs™

<p>| 1 Overview | 100 |
| 2 Programs | 101 |
| Assess | 101 |
| Assign | 103 |
| Report | 104 |
| Archive | 104 |
| Assessments | 104 |</p>
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feedback</td>
<td>105</td>
</tr>
<tr>
<td>Labels</td>
<td>105</td>
</tr>
<tr>
<td>Outcomes</td>
<td>105</td>
</tr>
<tr>
<td>Tags</td>
<td>105</td>
</tr>
<tr>
<td>Workflow</td>
<td>105</td>
</tr>
<tr>
<td>Search</td>
<td>106</td>
</tr>
<tr>
<td>Program Search</td>
<td>106</td>
</tr>
<tr>
<td>Summary</td>
<td>106</td>
</tr>
<tr>
<td>Program Snapshot</td>
<td>106</td>
</tr>
<tr>
<td>Maps</td>
<td>108</td>
</tr>
<tr>
<td>Curriculum &amp; Outcome Maps</td>
<td>108</td>
</tr>
<tr>
<td>Self-Study</td>
<td>109</td>
</tr>
<tr>
<td>Reports</td>
<td>109</td>
</tr>
<tr>
<td>Program Reports</td>
<td>109</td>
</tr>
<tr>
<td>Control Panel</td>
<td>110</td>
</tr>
<tr>
<td>Field Sets</td>
<td>110</td>
</tr>
<tr>
<td>Manage Programs</td>
<td>113</td>
</tr>
<tr>
<td>Maps</td>
<td>114</td>
</tr>
<tr>
<td>Outcomes</td>
<td>114</td>
</tr>
<tr>
<td>Portal</td>
<td>115</td>
</tr>
<tr>
<td>Program CIP Codes</td>
<td>116</td>
</tr>
<tr>
<td>Program Groups</td>
<td>116</td>
</tr>
<tr>
<td>Program Rubrics &amp; Templates</td>
<td>116</td>
</tr>
<tr>
<td>Program Properties</td>
<td>118</td>
</tr>
<tr>
<td>Program Settings</td>
<td>118</td>
</tr>
<tr>
<td>Program Time Track</td>
<td>119</td>
</tr>
<tr>
<td>Program Types</td>
<td>120</td>
</tr>
</tbody>
</table>

### Part VI Xitracs Standards™

#### 1 Overview

- Project Summary ................................................................. 122
- Editing a Standard ............................................................... 122
  - Log .............................................................................. 124
  - Portal User Input .......................................................... 125
  - Narrative ....................................................................... 125
  - Evidence ........................................................................ 127
  - Due Date ........................................................................ 130
  - Status ........................................................................... 130
- Evidence ............................................................................ 132
- Other Collateral ................................................................ 134
- Preview ............................................................................. 136
- Publish ............................................................................. 137
- Response Cycles ............................................................... 138
- Teams & Section Settings .................................................. 139

#### 2 Agencies

- Project Summary ................................................................. 141
- Reports ............................................................................... 141

#### 3 Control Panel

- Manage Standards .............................................................. 142
  - Properties ..................................................................... 145
<table>
<thead>
<tr>
<th>Contents</th>
<th>7</th>
</tr>
</thead>
</table>

- Backup a Standard .................................................................................................................. 146
- Restore a Standard .................................................................................................................... 146
- Settings .................................................................................................................................... 147
- Map Standards .............................................................................................................................. 150
- Multi-Use Standards ................................................................................................................... 151
- Portal Email Settings .................................................................................................................. 151
- Presentation Templates .............................................................................................................. 151

**Part VII** Resource Library

1. Overview ....................................................................................................................................... 153
2. Folders .......................................................................................................................................... 153
3. Items ............................................................................................................................................... 154
4. Search .......................................................................................................................................... 155

**Part VIII** Glossary

1. Glossary ......................................................................................................................................... 156

**Part IX** Administration

1. Overview ......................................................................................................................................... 157
2. Manage Users .................................................................................................................................. 157
   - Add Users .................................................................................................................................... 157
   - Find Users .................................................................................................................................... 159
   - Groups ......................................................................................................................................... 159
   - Import Users ................................................................................................................................ 161
   - User Access ................................................................................................................................ 161
   - User Settings ............................................................................................................................... 161
3. Module Settings ............................................................................................................................ 162
   - Alerts ........................................................................................................................................... 162
   - Announcements ............................................................................................................................ 162
   - Banner ......................................................................................................................................... 162
   - Campuses ...................................................................................................................................... 162
   - Departments, Schools & Courses ................................................................................................. 163
   - Glossary ......................................................................................................................................... 166
   - Libraries ....................................................................................................................................... 166
   - Reviewers ...................................................................................................................................... 166
   - Spellchecker .................................................................................................................................. 168
   - Tags ............................................................................................................................................... 169
   - Xitracs DataPort™ ....................................................................................................................... 169
   - Xitracs DataView™ ....................................................................................................................... 169
4. System Reports ............................................................................................................................... 169
   - Access Logs ................................................................................................................................. 169
   - Current Sessions ........................................................................................................................... 171
   - Software Updates ......................................................................................................................... 171
5. System Settings ............................................................................................................................. 171
   - Add-Ons™ .................................................................................................................................... 171
   - License ......................................................................................................................................... 172
   - Server .......................................................................................................................................... 172
   - Updater ......................................................................................................................................... 173
   - Volumes ....................................................................................................................................... 174

© 2022 Concord USA Inc  Xitracs Release 6.1e
1 Introduction

1.1 Overview

The Xitracs™ System is designed to help organizations manage their accreditation reporting, strategic planning and outcomes assessment processes. It is based on the latest web technology, meaning that the system can be accessed over an intranet/internet connection using a browser and without the need to install any software on a user's local workstation.

There are two types of users that exist: System Users (typically those working directly on an accreditation report or managing various processes, such as a program coordinator) and Portal Users (faculty and staff). Information for Portal Users is available in a separate guide.

Access to the system is controlled by a User ID and password.

The system includes a number of modules which are available depending on the software licensed and a user's role.

Xitracs Assessment™ lets you create reports quickly and easily for both in-course assessments and general (juried) assessments. Outcomes can be defined at course, program and institution level. Rubrics can be linked to outcomes.

With in-course assessments, student score data against outcomes can be captured through teaching faculty input, either directly or via the LMS. With general (juried) assessments, you can create workflows to have multiple scorers score student work (with or without artifacts) using associated rubrics.

Datasets are created for each workflow, providing a comprehensive and permanent record of information gathered.

Xitracs Credentials™ enables users to enter and manage faculty qualification and course syllabus information, plus supporting documents. This data can then be used to generate static or dynamic reports.

For each faculty member you can track details, qualifications, licensure and certifications along with a curriculum vitae (CV) and supporting documents, such as transcripts. Courses and sections for each semester can be recorded and a syllabus for each section stored for reporting and archiving. You can specify which qualification is applicable to each section taught by a faculty member. If there is a justification required you can record a comment.

Accrediting Agency reports such as a Faculty Roster in PDF format can be generated with a single click. A dynamic website view lets you to provide a secure online access to authorized external reviewers who can then search for additional credentials information. You have the option to control what documents and other data that each reviewer is able to see. Built-in management reports show you where there are missing elements, such as faculty without qualifications or course sections without a syllabus.
Xitracs Planning™ enables users to build plans and align goals.

Plans can be linked dynamically, so department plans can report to division plans which in turn can report to institution plans and so on. A timeline feature lets you select a planning cycle by plan, so annual operational plans can link to five-year strategic plans. You can connect plans and budgets and get a snapshot of progress across the institution. The built-in survey tools let you collect input from faculty which can then be linked to objectives and goals. A plan Management Snapshot is included, allowing you to view progress of plan completion. Navigation is made easy via a graphical plan mapping view, which shows you the elements within each plan and the hierarchy of plan linking.

Authorized users can easily build plans, assign tasks with due dates and then link them by reference to other plans. Documents and other files can be added as supporting artifacts. Progress can be tracked with built-in reports and each plan published to a website or PDF document with a click.

Xitracs Programs™ provides a flexible and intuitive solution to managing program assessment reporting.

Programs are managed to a time-frame, so that input across multiple cycles can be tracked and reported on. A flexible field set feature lets you define what input is needed and when. Reports can be output to a website, in PDF or Excel format. Programs can be grouped and linked to departments and disciplines. A powerful search feature makes it easy to find information by keyword.

Curriculum maps can be generated for each program.

Xitracs Standards™ provides a structured means of gathering and managing all of the information required for an agency compliance report submission, using a pre-configured compliance matrix that is available for the major accreditation agencies. Additional agency standards can be added as required, to meet the needs of other compliance and regulatory bodies.

Participants in the process of preparing and reviewing submissions are assigned to teams, which in turn are assigned to one or more standards or requirements. The status of each standard can be set and tracked, together with an optional date to indicate when a particular item is due. Access to materials can be controlled, based on a team member role. The narrative and supporting evidence, which may consist of one or more electronic files, are automatically linked and stored. A log keeps track of the activity for each standard and progress reporting is available. Additional materials, including instructions and examples, may optionally be stored in a Resource Library and linked to each standard.

At any point in the process, an internal draft of the complete submission may be generated to enable the director or relevant institution committee to view how the submission will look. When the project is complete, the final submission may be published in Website, PDF or Microsoft Word® formats, for printing, capture to Flash Drive or DVD. Website report submissions can be made available online to agency reviewers and accessed controlled by logon and password. Responses from the agency may be logged and the compliance approval status of each standard or requirement may be flagged. Where required, a Plan can be added to the relevant standards. Prior submissions and responses may be archived for future reference and audit purposes.

The Xitracs Portal™ provides an intuitive and easy means of sharing information and gathering data from faculty and staff.
1.2 Getting Started

Xitracs is an easy to use web application that you can access via your browser. Supported browsers are Mozilla Firefox®, Microsoft Internet Explorer®, Microsoft Edge®, Apple Safari® for MAC or Google Chrome®. Supported versions are the current released version and one version back.

Logging On
1. Enter the URL address of your Xitracs system in your browser
2. Logon to your Xitracs system by entering a **User ID** and **Password**.**
3. Click the **Logon** button or use the **Enter** key.
4. To log off from the Xitracs system, click the **Logout** link at the top of any page.

Depending on your organization's password management policy, a **Forgotten Password** link may be provided on the logon page.**

** If your organization uses single sign-on (SSO), password authentication is provided through your local SSO server. Check with your IT department for details.

Each time you log on, a **Session** is created with the host application. This is a security feature. If you are inactive for some time, the session will automatically expire and you will need to logon again.

Most functions in the system are accessed by clicking a Link which will be underlined, for example **Click me**.

If you need to go back to a previous page, use the button at the top right hand corner of page, rather than using your browser's back button.

Context sensitive help is available by clicking the button.

Most actions require that you click the button to complete the function. If you want to go back before completing use the button.
1.3 Home Page

After successfully logging on to the Xitracs system, the home page is presented. You can return to this page at any time by clicking the Home tab in any of the available modules.

The default home page view consists of a number of panels as follows:

**Announcements & News**

Informational announcements posted by your administrator are shown.
If you have a system administrator role you can [create and manage] announcements.
Informational announcements posted by Xitracs Support Services will also appear from time to time.

**Projects & Key Statistics**

Depending on the module you are logged in to, certain summary data will be presented, such as progress on accreditation projects or plans.

**My Recent Activity**

Depending on the module you are logged in to, a list of the last seven sections of the standards, credentials, and plans or programs for which you have been editing the narrative are displayed. Clicking on a link takes you to the relevant item.

**Calendar**

The calendar displays in month, week or day view. Events shown can be added manually and are also auto-generated for activities such as [accreditation projects].

**Notepad**

You can post short messages for yourself, such as reminders or notes. Just click on the Edit button and add or edit text.
1.4 Tab Menu

The main functional areas in the Xitracs system are accessed by clicking on a tab at the top of the page. The modules and tabs available to you will vary depending on your role in the system. This is controlled by a System Administration function.

The active tab will be highlighted, as in the example above.

You can choose an available module by using the drop-down selector to the right of the tabs.

Access to the System Administration functions is only available to users with a system role of Administrator.

1.5 User Details

You may edit the following information by clicking on the User Details link at the top of the page.

- First and Last Names
- Email Address

1. Click User Details
2. Click Change Details
3. Enter the new information and click Submit

Note: Your User ID cannot be changed

If enabled by the local system configuration, you may change your password.

1. Click User Details
2. Click Change Password
3. Enter the new information and click Submit

Note: Passwords cannot normally be changed by a user if the Xitracs system has been configured to use a central authentication service for single-sign-on, (SSO). In this case, the Change Password link will not appear.

If the system is configured to provide email alerts of calendar due dates, the function may be managed by clicking the Change alert settings link.

1. Check Enabled to switch on or uncheck to switch off
2. Select preferred email frequency
3. Click Submit

Any teams that you belong to will be listed, together with your team role.
1.6 Using the Text Editor

The built-in WYSIWYG (What You See Is What You Get) text editor lets you enter narratives, preambles, reports and responses.

The editing functions are similar to those found in a typical word processing application. The default font style for the editor is Arial 11pt.

While the editor provides considerable freedom in formatting text, most agencies prefer a simple and consistent text style. Changing fonts and text sizes within the same or across multiple narratives may detract from the look of a published document or website and is not recommended.

To insert an image click on the add image icon and select an image file from the drop-down. You can format the image further by clicking on the Appearance tab.

Hyperlinks may be added by highlighting text first and then clicking the link icon in the toolbar or by using the mouse right-click function. To remove a hyperlink use the unlink icon. Links can be replaced automatically by end-note references in a published submission if the end-note function is available in the presentation template. See Control Panel > Presentation templates.

To avoid possible right margin text overflow in a PDF document submission, avoid including tables or images that exceed 600px in width.
For footnotes, use the \(^2\) superscript icon then create a list of footnotes at a suitable place in the narrative. *(This is a manual function).*

You can check the number of words in the narrative by clicking on the \(\wedge\) icon.

To find and replace a word click on the \(\wedge\) icon.

To remove formatting previously applied, highlight on the word or words and click on the remove formatting icon.

Click on the full-screen icon to toggle between full and normal view of the text editor.

Some useful tips that will help minimize formatting issues when copying and pasting text from other documents:

- Text copied from another narrative should be pasted using the paste as plain text icon.
- Text copied from another document, e.g. a web page, should be pasted using the paste as plain text icon.
- Text copied from an MS Word® document should be pasted using the paste from Word icon.
- Tables copied from another document should be pasted using the paste as plain text icon.

⚠️ Information copied and pasted from other sources may contain proprietary formatting characters or invalid links. This may cause problems later when publishing a submission. Check the quality at any time by using the Preview function. If an invalid link has been pasted, a warning message will be generated when you update the narrative. See also Link Check Report.

If your system is configured to allow direct editing of the narrative HTML, the HTML function will be present. Click on the icon to open an HTML editing window. This also provides access to the Word Redo function. Use this function to remove embedded formatting from a pasted Word document. See also Narrative Cleanup tools.
2 Xitracs Assessment™

2.1 Overview

The Xitracs Assessment™ module allows you to perform two types of student assessment functions:

1. Scoring students in a course section against GenEd, Program and/or Course outcomes. These are termed Course Assessments.
2. Student assessments against one or more GenEd, Program or External (e.g. Agency) outcomes using an associated rubric, typically by multiple scorers. These are termed General or Juried Assessments.

Course Assessments
With this feature, teaching faculty can easily enter student assessment scores for mapped outcomes, using a variety of methods.
For institutions using a Blackboard®, Canvas® or D2L Brightspace® Learning Management System (LMS), an optional connector is available.

General (Juried) Assessments
With this feature, it's easy to set up and manage assessment workflows of student work by semester and report rubric scores against specific outcomes. You can assign one or more scorers to a workflow.

1 Depending on features licensed. Individual student scoring requires the Student-level Data (SLD) option.
2.2 Course Assessments

2.2.1 Section-level Assessment

Xitracs provides a simple and intuitive way for teaching faculty to add student score information at a course section level. Scores relate to outcomes that have been mapped or optionally selected. Entry of this scoring information is via the Xitracs Portal.

The aggregate counts of, for example, Met, Not Met or Above\(^1\) can then be added, either by manually keying the data or by linking the assessment to a gradebook column in the Learning Management System (LMS)\(^2\).

For systems with the Student-level Data (SLD) option, individual student scores can be added directly, via rubric or via the LMS. See also Outcomes Methods.

For completed assessments, a summary report is available. See Courses > Section > Assessment. More extensive reports are also available. See the Reports tab.

The assessment data related to each outcome can be viewed for a single or multiple semesters.

\(^1\) These are the default scoring fields for section-level assessments. A maximum of 3 fields is available. The label for each field can be amended if required. This must be done by Xitracs Support.

\(^2\) Gradebook column linking is an optional feature and is currently available for Blackboard®, Brightspace® and Canvas®. Check with your Xitracs representative for additional LMS availability.

The functions available in the Portal can be controlled. See Control Panel > Portal > Settings. See also Credentials > Control Panel > Manage Semesters re locking a semester.

Refer to the Portal User Guide for usage of this function by teaching faculty.
2.3 General (Juried) Assessment Workflows

2.3.1 Create a Workflow

General (juried) assessments are managed through workflows. These are designed to allow one or more scorers to assess student work against outcomes using an associated rubric. A workflow can be created to assess one of GenEd, External or Program outcomes.

Each workflow can contain two steps, the first of which is optional: (1) Uploading Student Artifacts and (2) Scoring. Artifacts can be uploaded centrally via batch import or requested or teaching faculty*. *Applies to those workflows where the student source is Course Sections (see below).

The source of students in a workflow can be either from Course Sections, Open List or LMS Transfer*. The default student source for a workflow can be set. See Control Panel > Settings > Workflows. If the source is an Open List and artifacts are required, these must be batch imported. See the publication "Xitracs Data Import Guide" for details on file content.

*The LMS Transfer option is only available in those systems where an LMS Connector is installed.

Once a workflow is started, each step is assigned to the relevant user (i.e. teaching faculty and/or scorer) for action via the Xitracs Portal, at which time an email task request will be generated.

To create a new assessment workflow

1. Click on the Workflows Tab
2. Click the Create a new GenEd Outcome, External Outcome or Program Outcome link
3. Enter a Name for the workflow, e.g. SP2019-Assmt01
4. If this is a Program Outcome assessment, select the Program to which it relates
5. Select the Student Source
6. Select the semester to which the workflow relates. (If student source is Course Sections, this will also determine from which course section(s) students can be selected).
7. Enter a Report Due date in the format MM/DD/YYYY. The default value is 3 months from the date the workflow is created.
8. Enter the number of student artifacts that will need to be uploaded. Check if artifact upload is to be Optional. If this number is set to zero, the Upload Artifacts step will be skipped.
   The optional parameter applies only to workflows where the student source is Course Sections.
   If the student source is Open List, all artifacts must be batch uploaded.
9. Enter an Artifacts Due date in the format MM/DD/YYYY. The default value is 1 month from the date the workflow is created (if applicable).
10. Optionally, enter artifact upload instructions which will be displayed with the task to the faculty teaching the selected course section(s) (if applicable).
11. Enter an Scores Due date in the format MM/DD/YYYY. The default value is 2 months from the date the workflow is created.
12. Optionally, enter scorer instructions which will be displayed with the task to the selected faculty scoring the artifacts
13. Click Submit

The new workflow will be added to the workflow list for the selected semester; the status will be Not started - Incomplete details
Click the Details link next to the listed workflow to complete the required information.
2.3.2 Workflow Datasets

When a workflow is complete, a dataset is generated for each outcome associated with the assessment. A dataset is in MS Excel® format and includes the detailed data from the assessment.

You can select one or more datasets to generate an aggregated spreadsheet.

Note that a dataset is a snapshot of the assessment. If you change a rubric value or threshold in a later semester, it will not affect the data for a prior assessment.

2.3.3 Workflow Details

The details of an assessment workflow must be completed before it can be started. You can also change certain information that was entered in the create step using the Edit link associated with a field.

Add Outcomes

One or more outcomes must be associated with an assessment workflow. Click the Add outcomes link and select an available outcome. Note that only those outcomes that have a linked rubric can be selected.

Optionally, set a Threshold for the outcome rubric by clicking the Level link. This information is used in downstream assessment reports. For example, the associated rubric may have a maximum potential score of 20 and the threshold for this specific assessment workflow could be set to 15. Note that the threshold you set will be for this assessment only; in this way, you could set higher thresholds for subsequent assessments if you want.

Add Sections (Applies only to those workflows where the student source is Course Sections).

Select the course section(s) to be associated with the assessment. This will determine (a) the faculty teaching the selected courses who will be asked to submit artifacts and (b) the students that you are able to select (see below).

Add Students

For workflows where the student source is Course Outcomes - Type code [S]

Click the Add student link next to each of the sections you have chosen. Start typing a student name or ID in the search box to find a student. You can also click the Select link to list and select students. Note that only those students who have been enrolled in a course section will be available for selection. Alternatively, use the Import link to add students directly into the workflow and enroll in the course section (if not already enrolled). See the publication "Xitracs Data Import Guide" for details on file content.

For workflows where the student source is Open List - Type code [O]

Use the Import link to add students directly into the workflow. If the workflow requires artifacts, these can be included in the same student import file. See the publication "Xitracs Data Import Guide" for details on file content.

For workflows where the student source is LMS Transfer - Type code [L]

The students and supporting artifacts will be imported from the LMS. See Workflow LMS Transfer.

Artifacts Required (The Edit function is available only to those workflows where the student source is Course Sections).
By default, the number of artifacts to be uploaded is set at 1. You can increase this number, if required. Check the Optional parameter if artifacts can be uploaded but are not mandatory. Set to zero if no artifacts are required.

**Add Scorers**
Click the Add scorer link and select one or more portal users (faculty and staff) that will be assigned the task to score uploaded students against the selected outcome(s) using the linked rubric.

For workflows where the student source is Open List, click the Map link to assign specific students to scorers. Use the Students taught scan link to determine if any scorers are teaching one or more of the listed students. Use the Edit map link to change the settings.

Scorers with a completely blank column will have access to all students listed. Scorers with one or more mapped entry in a column, including an entry of "Student", will only have access to those students showing "Can Score".

Once a workflow enters the Scoring step, the alias given to each student will also be displayed.

**Start a Workflow**
Once all of the above information is complete, you will be able to start the workflow. Click the Start link next to the Current Status row on the details page. You will be redirected to a page where you can confirm all of the workflow information is complete. When the workflow is started, those assigned to upload artifacts will automatically receive an email advising them of the new task. If the required number of artifacts is zero and the Optional parameter has not been set (see above), the workflow will move directly to the Scoring step. When artifact uploading is complete, those assigned to do the scoring will then receive an email advising them of the new task.

⚠️ **Caution!** Once a workflow has been started, depending on the stage of the workflow, you will not be able to change certain details of the assessment. (See below).

**Force Next or Force Complete**
Once a workflow has started, the system will automatically track progress and move the status from the Adding artifacts step to the Scoring step to the Workflow complete step. You can manually move to the next available step by using the Force next or Force complete link.

**Modify a Workflow**
Certain parameters in a workflow can be changed, depending on the stage.

<table>
<thead>
<tr>
<th>Parameter / Stage</th>
<th>Not Started</th>
<th>Adding Artifacts*</th>
<th>Scoring Artifacts</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Workflow Name</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Delete Workflow</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Edit Number of Artifacts*</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Add or Delete Outcomes</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Add or Delete Sections</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Add or Delete Students</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Add or Delete Scorers</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

* Does not apply to workflows where the student source is Open List.

**Workflow Progress**
Click this link to see a snapshot of the status of the workflow tasks.
Complete a Workflow
Once all of the artifacts have been uploaded and scored, the workflow will automatically complete and the assessment report will be generated. An option to manually force completion of a workflow is also available by first clicking on the Details link and then clicking on the Force complete link in the status row of the Assessment Workflow Details.

Delete a Workflow
A workflow can be deleted. This will remove any associated tasks from a faculty member's portal. Any datasets that have been generated by a completed workflow must be deleted separately.

2.3.4 Workflow List
Any general (juried) assessment workflows that have been created will appear in a list sorted by semester. You can change the semester using the select function at the top right of the list. The list includes information about each workflow, including the type, status, artifact source, due dates, number of students, scorers, outcomes and notes. Click the Details link to add or edit information about the workflow.

The type indicates whether the assessment is of GenEd, External or Program outcomes and the source of the students to be assessed, either from Course Sections [S] or an Open List [O]. The percentage values in the Students and Scorers columns show the progress of completion of the particular phase of the workflow. Click the Progress link for more information.

Click the Notes link to add a comment about the workflow. The Narrative link lets you add a preamble to the assessment report. If the workflow is complete, the Report link will appear.

If one or more workflows is complete, you will be able to generate a dataset report in Excel® format by clicking the Download link.

2.3.5 Workflow LMS Transfer
For systems where the LMS Connector is installed, students and their associated assignment artifacts can be transferred into a workflow.

! The course sections to be included in a workflow must already exist in Xitracs.
See Credentials > Control Panel > Course Catalog.

! The Xitracs user administering a workflow must have access privileges in the LMS to the course(s) included in the workflow.

Select the LMS transfer radio button when creating a workflow.

Once the workflow has been created, click the Add section link to add the course section(s) to be included in the workflow.

The sections available will be those that already exist in Xitracs for the relevant semester and must correspond to a course in the LMS.

For each selected course section, click the LMS submissions link to display a list of assignments in the corresponding LMS course.

The list will display the number of students in the course and the number of students with files associated with the assignment.

Select the assignment to be included in the workflow and a list of only those students with files will be displayed.
A checkbox **Add any new students to Xitracs** provides the option to prevent any students in the workflow who do not already exist in Xitracs from being added to the system. This is checked by default. When unchecked, this is useful for testing where you may want students included in a workflow but not added to the system.

Select the student(s) to be included in the workflow.

Repeat for each selected section.

### 2.3.6 Workflow Narrative

If a workflow is complete, you can add a preamble to an assessment report. In the workflow list, click on the **Narrative** link to add a narrative or edit an existing narrative.

Each time you update the narrative a new version of the [assessment report](#) is generated.

### 2.3.7 Workflow Notes

Click on the **Notes** link in the workflow list to add a note about the assessment. This is a useful tool for keeping a record of any additional information you may want to add about the assessment, or to communicate to those uploading or scoring artifacts.

### 2.3.8 Workflow Progress

You can check the detailed status of a workflow that has been started by clicking on the **Progress** link.

The status of Adding artifacts and Scoring artifacts by each assigned user is displayed. You have the option to add or remove artifacts on this page, on behalf of a faculty member.

Note that once all of the artifacts have been uploaded and scored, the workflow will automatically complete and the [assessment report](#) will be generated. An option to manually force completion of a workflow is also available on the [workflow details](#) page.
2.3.9 Workflow Report

Once a workflow is complete, an assessment report PDF format is automatically generated. Click the Report link to view. If a narrative is added, a new version of the report will be generated. The report includes information for each outcome linked to the workflow.

If you choose the Excel report format, you can also select one or more earlier workflows that have matching outcomes (if available). The workbook generated includes a comparison worksheet. Check the Include Student Details parameter if you want each student's name and id included in the report.

You can also view an outcome-specific version of the report by going to the Outcomes tab where a Dataset for each completed workflow is also available.
2.4 Courses

2.4.1 Courses

You can search for courses in the catalog and view the course details, course outcomes (if defined), programs (if the course is included in a program) and course sections (if defined).

Click the Details tab to view course information from the catalog.

Outcomes

Click the Outcomes tab to view any Course [C] outcomes (if defined), plus any linked GenEd [G], External [E] or Program [P] outcomes. These links determine which outcomes will display to the teaching faculty as mapped in the Xitracs Portal. (Courses > Assessment).

In the Outcomes tab view you can create a list of mapped GenEd [G] and Program [P] outcomes (if defined) by clicking the Add link function. (Direct mapping).

If Course outcomes have been defined, these can be linked to GenEd and/or Program outcomes by clicking the Map function. Click the Methods link to set scoring methods and thresholds for course outcomes.

If the course is included as a core course in more than one program, you must first select the program where you want to create any course outcome to program outcome links. For a core course, you can add one or more GenEd outcomes to the map. Check the cell(s) to map a course outcome to a program or GenEd outcome.

! If you are mapping course outcomes, take care not to duplicate outcome reporting links. For example, if Course Outcome A is mapped to GenEd Outcome C, there should be no need to link the entire course to GenEd Outcome C (see Direct course to outcome mapping above).

Click the Programs tab to view a list of programs where the course is included. Click on the Outcome map link to see where outcomes are assessed in the program.

Sections

Click the Sections tab to view any course sections for the current semester. Click the Show prior semesters link to view earlier sections.

In this view, click the Assessment link to view the summary assessment data (if available) for a course section.

If you system has been configured to provide the Assessment Required* function, you will be able to set which course sections are assessed in a specific semester. Click the Yes or No link to toggle the required setting.**

A separate column displays the current status of the assessment, Incomplete or Complete. While this status can be changed in this view by clicking on the status link, it is normally set by the teaching faculty member via the Xitracs Portal.

You can also control the display options in the Portal. See Control Panel > Portal > User Settings. This determines whether only sections requiring assessment are displayed.

*Contact Xitracs Support to have this function enabled.

**These settings can also be imported. Refer to the Xitracs Data Import Guide.
Methods & Thresholds
Depending on features licensed and availability settings, the methods for assessing an outcome in-course are:

- Aggregate score counts - the count of students at each threshold level (e.g. met, exceeded, not met) can be input.
- Alignment with LMS Gradebook column - the outcome can be aligned with a gradebook column in the LMS and student scores pulled.
- Direct entry of student scores - the score for each student in the course can be input.
- Rubric linked to the outcome - each student in the course can be scored using the rubric associated with the outcome.
- Teaching faculty can set - the teaching faculty member can select from one of the available methods.

1. Select an available method or leave the default setting
   The Rubric method will not be available if there is no rubric associated with the outcome.

2. Check the M-Lock parameter to prevent faculty from changing the method
   The M-Lock parameter will be ignored if the method set is 'Teaching faculty can set'.

3. Enter a threshold level for each level
   If the method selected is 'Rubric', a threshold cannot exceed the maximum score generated by the rubric.

4. Check the T-Lock parameter to prevent faculty from changing the thresholds
   The T-Lock parameter will be ignored if:
   a. The method has not also been locked (see above)
   b. One or more thresholds is set to zero or is blank
   c. The method set is 'Aggregate score counts' or 'Teaching faculty can set'

These method and threshold settings can also be imported. See Control Panel >
2.5 Outcomes

2.5.1 Outcomes Library

The Outcomes Library is a convenient way to view learning outcomes and associated information.

General Education (GenEd) and External (e.g. Agency) outcomes are viewed by Group > Set. Outcome groups, sets and the outcomes themselves are defined via the Control Panel > Manage outcomes.

Program outcomes are viewed by School > Department > Program.

For each outcome set or program, click the Course map link to list the courses where each outcome is assessed. This mapping is generated by the outcome links associated with a course. See Assessment > Courses > [Course] > Outcomes. If course level has been defined in the catalog, a column will be generated for each respective level. Otherwise, courses will be listed in a Level N/S (not specified) column.

Click the Outcome map link to generate a diagram of mapped outcomes.

Click on the name of the Outcome Set or Program to list any outcomes.

Click the Assessment link to view any assessment reports. In this view, you can toggle between General assessments and Section assessments.

If there are any general assessment workflows, these will be listed by semester. If a workflow is complete, click the View link to open the workflow report. For each completed workflow, a Dataset will be available. This includes the quantitative information in an MS Excel® format.

If there are any section assessments, a report will be generated for each mapped course section included in the selected semester.

Click the Courses link to view any course assessments that may be available for a single or multiple semesters.

Click the Select rubric link to assign a specific rubric to an outcome.

2.5.2 Outcomes Methods

Depending on features licensed and availability settings, the methods for assessing an outcome in-course are:

- Aggregate score counts - the count of students at each threshold level (e.g. met, exceeded, not met) can be input.
- Alignment with LMS Gradebook column - the outcome can be aligned with a gradebook column in the LMS and student scored pulled
- Direct entry of student scores - the score for each student in the course can be input.
- Rubric linked to the outcome - each student in the course can be scored using the rubric associated with the outcome.
- Teaching faculty can set - the teaching faculty member can select from one of the available methods.
- Not scored in this semester - the outcome is not assessed in the current semester.

1. Select an available method or leave the default setting
   The Rubric method will not be available if there is no rubric associated with the outcome.
2. Check the M-Lock parameter to prevent faculty from changing the method
The M-Lock parameter will be ignored if the method set is 'Teaching faculty can set'.

3. Enter a threshold level for each level
   If the method selected is 'Rubric', a threshold cannot exceed the maximum score generated by the rubric.

4. Check the T-Lock parameter to prevent faculty from changing the thresholds
   The T-Lock parameter will be ignored if:
   a. The method has not also been locked (see above)
   b. One or more thresholds is set to zero or is blank
   c. The method set is 'Aggregate score counts' or 'Teaching faculty can set'

The label for each threshold (e.g. met, exceeded) is set when the assessment module is installed. Contact Xitracs Support to request any change in these labels.
2.6 Reports

2.6.1 Reports

Output, status and exception reports are provided. Output reports are typically available in Excel® and/or PDF format.

Click the View link to generate a report. If available, select a filter to determine the level of data to be included.
2.7 Rubrics

2.7.1 Rubric Library

You can create a library of rubrics and associated information. Create Folders to organize and categorize rubrics.

To add a rubric to the library, you must first create the rubric as an MS Excel® spreadsheet file.

![The Excel file must have a .xls file type. A .xlsx file type will be rejected. If you are using Excel version 2007 or later, use the Save As function as select type Excel 97-2003 Workbook.]

To Create a Rubric using MS Excel®

1. Add the text you want to appear as Levels in cells A2, A3, A4 and so on. Optionally, include a weight in square brackets [] at the end of the text. If no weight is included, a value of 1 is assumed.
2. Add the text you want to appear as Criteria in cells B1, C1, D1 and so on. Optionally include a weight in square brackets [] at the end of the text. If no weight is included, a value of 1 is assumed.
3. Add the text you want to appear as the rubric in the appropriate cells, e.g. B2, C2 and so on.
4. Save the file, e.g. myRubric.xls, to a folder on your workstation.

Example

To Add a Rubric to the Library

1. Click the Rubric button
2. Browse for a rubric (.xls) file
3. Enter a Title and optional Description
4. Click Submit

![If a possible error in weighting is detected (e.g. no weights or all weights equal 1), the rubric will be flagged.]

Once a rubric has been added to the library, you can use the Modify link to change the content, including weights, if required.

To link a rubric to an outcome, click the Rubric link next to the outcome and select the appropriate rubric.
2.8 Students

2.8.1 Students

⚠️ This function requires the Student-level Data option license.

You can search for a student by name, email or ID. Click on a student to view information stored in Xitracs, including the course sections and programs in which he or she is enrolled.

**Base Data**
Information such as name, student ID and email will be displayed.

**Courses**
A list of courses in which the student is enrolled is provided, in descending order of semester.
- Click the **Details** link to view the course catalog information for the course.
- Click the **Assessment** link to view any outcomes assessment score information.
- Click the **Roster** link to view a list of students enrolled in the course section.

**Groups**
A list of groups in which the student is enrolled is provided.
- Click the **Add** link to select a group and the in and out dates.
- Click the **Edit** link to change the information for an existing group enrollment.
- Click the **Remove** link to remove an existing group enrollment.

⚠️ Use caution when editing or removing group enrollments as this may impact downstream reporting.

**Programs**
A list of programs in which the student is enrolled is provided.
- Click the **Add** link to select a program, the **enrollment type** and the in and out dates.
- Click the **Edit** link to change the information for an existing program enrollment.
- Click the **Remove** link to remove an existing program enrollment.

⚠️ Use caution when editing or removing program enrollments as this may impact downstream reporting.
2.9 Control Panel

2.9.1 LMS Integration

You can define the parameters for linking to your Learning Management System (LMS)* in order to retrieve gradebook columns and student scores via the Xitracs Portal.

Select the LMS provider and complete the information required. This will require you co-ordinate with your institution's LMS administrator.

* Gradebook column linking is an optional feature and is currently available for Blackboard®, Canvas® and D2L Brightspace®. Check with your Xitracs representative for additional LMS availability.

2.9.1.1 Blackboard

1. Go to Assessment > Control Panel > LMS Integration > Blackboard
2. Check the **Enabled** parameter
3. Enter the **Server values** provided by your Blackboard administrator

2.9.1.2 Canvas

Integration with your Canvas LMS requires a optional Xitracs feature license.

1. Go to Assessment > Control Panel > LMS Integration > Canvas
2. Check the **Enabled** parameter
3. Enter the **Server values** provided by your Canvas administrator
2.9.1.3 D2L Brightspace®

Integration with your D2L Brightspace LMS requires an optional Xitracs feature license.

1. Go to Assessment > Control Panel > LMS Integration > Brightspace
2. Check the Enabled parameter
3. Enter the Server values provided by your Brightspace administrator

Refer to the relevant Knowledge Base (KB) article for additional information.

Once integration is enabled and depending on the outcome assessment methods configured, teaching faculty using the Xitracs Portal will have the option to align a gradebook column in their Brightspace course with an outcome in Xitracs.

Refer to the Xitracs Portal User Guide for additional information.

See also CLOE Import below.

CLOE Import

If your Brightspace system provides Course Learning Outcome Evaluation (CLOE) files, you can import this data into Xitracs.

1. Go to Assessment > Control Panel > LMS Integration > Brightspace
2. Click Import a batch assessment data file
3. Select Brightspace Outcomes data in the drop-down
4. Browse for a CLOE file on your local workstation or network drive
5. Enter a Name for the imported file (e.g. Spring 2019) - otherwise the file name will be used
6. Enter an optional Description
7. Click Submit

No outcomes assessment information in Xitracs is updated until a batch is verified and explicitly transferred, (see below).

If the import is successful, you will next see the batch in a list of assessment data batches in Xitracs. As part of the import operation, the system will attempt to verify information by matching CLOE data such as course sections, semesters and students with information already in Xitracs.

If not all of the imported data can be verified, the Validation column shows the percent of CLOE data verified and which data elements cannot be matched.
Verifying a CLOE batch file
1. Click the Verify link next to a batch
2. Click the Synchronize link next to each unmatched data element (see below)

<table>
<thead>
<tr>
<th>Field</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Rows</td>
<td>57</td>
</tr>
<tr>
<td>Semesters</td>
<td>OK</td>
</tr>
<tr>
<td>Sections</td>
<td>OK</td>
</tr>
<tr>
<td>Students</td>
<td>Unmatched students: 19 [57 rows]</td>
</tr>
<tr>
<td>Outcomes</td>
<td>Unmatched outcomes: 3 [57 rows]</td>
</tr>
<tr>
<td>Learning Objective: MSN6414-3 Create Data Representation Methods</td>
<td></td>
</tr>
<tr>
<td>Learning Objective: MSN6414-4 Articulate Strategies</td>
<td></td>
</tr>
<tr>
<td>Outcome Levels</td>
<td>Unmatched outcome levels: 2 [57 rows]</td>
</tr>
<tr>
<td></td>
<td>Synchronize to add these missing students</td>
</tr>
<tr>
<td></td>
<td>Synchronize outcomes to MSN6414</td>
</tr>
<tr>
<td></td>
<td>Synchronize to resolve these unmatched outcome levels</td>
</tr>
</tbody>
</table>

3. Follow the synchronization instructions selected element  The example below is for synchronizing outcome assessment levels, (if required).

<table>
<thead>
<tr>
<th>Source Data Level</th>
<th>Matching Xitracs Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Not met</td>
</tr>
<tr>
<td>Distinguished</td>
<td>Above</td>
</tr>
<tr>
<td>Proficient</td>
<td>Met</td>
</tr>
</tbody>
</table>

Transferring a CLOE batch file
Once all the data elements in a batch file have been verified, the validation percentage changes to 100% and the Transfer link is enabled.
1. Click Transfer
2. Check Lock scores to prevent teaching faculty from changing a score in the Xitracs Portal
3. Select whether missing student assessment data should be ignored or default to a level equivalent to Not met
4. Select whether assessment data should be at a student level or in aggregate

If the Aggregate option is selected, Xitracs will use the imported data to determine the number and percent of students in the course at each outcome assessment level. Individual student scores will not be stored.

<table>
<thead>
<tr>
<th>Field</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>Lock scores</td>
</tr>
<tr>
<td>Missing data</td>
<td>Not met</td>
</tr>
<tr>
<td></td>
<td>Ignored</td>
</tr>
<tr>
<td>Score data</td>
<td>Aggregate</td>
</tr>
<tr>
<td></td>
<td>Per student</td>
</tr>
<tr>
<td>Comment</td>
<td>CLOE import from: CLOE_sample2</td>
</tr>
</tbody>
</table>
Batch Data Results

Once the data has been transferred, click the **Results** link to generate a graphical view of the information. This data will have been associated with the respective outcome, course and student. It will also be viewable via the teaching faculty member's Xitracs Portal.
2.9.2 Manage Outcomes

Outcomes, other than those defined specifically for a program or course, can be created. These outcomes may be GenEd (institution internal) or External (e.g. agency defined).

General and external outcomes are managed in Outcome Sets, which in turn are managed in Outcome Groups.
A GenEd or external outcome can be linked to a course and/or field in a program assessment field set. A general outcome can also be included in a Curriculum Map.

You can create one or more Outcome Sets for a selected group. For example, under an external outcome group you might create two sets, “ABET Engineering 2015” and “ABET Computer 2015”, within the “ABET” group.

Click the Outcomes link to add or edit the appropriate outcomes to each set.

To Add an Outcome

1. Click Create an Outcome
2. Enter a short Label for the outcome and a description
3. Enter an optional Outcome Code
4. Click Submit

*The Outcome Code field is optional and provided to make it easier to identify the outcome in certain reports.*
2.9.3 Manage Students

This function requires the Student-level Data option license.

The Control Panel function provides an option to add students by manual entry or file import.

To Add a Student Manually

1. Click the Add new student link
2. Enter a Last name and First name - these fields are required
3. Add an optional Middle name or initial(s)
4. Enter a Student ID address - this field is required
5. Enter an Email Address - this field is optional

Note: An email address is not mandatory, but if not included, a non-functioning placeholder ‘STUDENTID@’ will be generated.

6. Enter a Password - this field is optional

Note: A password typically is not required, except for testing purposes. Student authentication is normally handled through an LTI or SSO function.

If a student is also a faculty/staff member (see below), the indicator [FS] will appear in the Type column

To Add or Remove Students by File Import

See the publication “Xitracs Data Import Guide” for details on file content.

1. Click the Import link
2. Browse for the relevant import file
3. Select the data Separator
4. Click Submit

To Edit a Student

1. Click the Find link
2. Search for a student or click List all
3. Click the Edit link for the relevant student
4. Update the Fields as appropriate
5. Click Submit

To Change a Student Password

1. Click the Find link
2. Search for a student or click List all
3. Click the Password link for the relevant student
4. Update the password as appropriate
5. Click Submit
To Make a Student also a Faculty or Staff Member

Requires the Credentials module and also Credentials module Control Panel access privileges

1. Click the Find link
2. Search for a student
3. Click the Edit link for the relevant student
4. Check the Faculty/Staff Attribute parameter
5. Click Submit

Note: The related faculty or staff member will initially exist with a provisional status and with no reporting or portal access.

Edit the new faculty or staff member to set attributes such as department.

2.9.3.1 Student Groups

This function requires the Student-level Data option license.

Students may belong to one or more groups. A group is associated with a group type, e.g. Cohort.

To Create a Group Type

1. Click the Types link
2. Click Create a type
3. Enter the type name
4. Click Submit

Use the Edit and Delete links to change or remove a group type.

To Create a Student Group

1. Click the Types link
2. Click Create a student group
3. Enter the group name and description and optional code
4. Select an available group type
5. Click Submit

Use the Edit and Delete links to change or remove a student group.
2.9.4 Operations

**Import Assessment Requirement Settings**
The requirement for assessment in each course section can be set via import.

*Refer to the Xitracs Data Import Guide for the file format and instructions.*

**Import Course Outcomes**
Learning outcomes can be imported for each course.

*Refer to the Xitracs Data Import Guide for the file format and instructions.*

**Import Course Outcomes Settings**
The initial scoring method and thresholds for each course outcome can be set via import if required.

*Refer to the Xitracs Data Import Guide for the file format and instructions.*

**Import Section Outcomes Settings**
The course outcome scoring methods and thresholds for specific course sections can be set via import if required.
This is useful if there are changes in later semesters.

*Refer to the Xitracs Data Import Guide for the file format and instructions.*

2.9.5 Portal

**Email Address**
The task requests from a general (juried) assessment workflow will be emailed to the respective faculty and scorers. You can set the email to originate either from the user that generated the workflow or from a specific email address.

⚠️ Check with your IT department to make sure the email address will not be blocked by the institution's spam filter.

**Settings**
Check the relevant parameter to control which assessment functions are available in the Xitracs Portal.

You can control which outcomes panel appears in the Portal for the teaching faculty member. If you have course outcomes defined and these in turn are mapped to GenEd and/or Program outcomes, you would typically enable the Course Outcomes Panel and not display the GenEd and Program Outcomes Panel. Alternatively, if you no course outcomes defined and have GenEd and/or Program outcomes mapped directly to a course, you should enable the relevant panel so it is displayed in the Portal and not display the Course Outcomes Panel.
2.9.6 Settings

Assessment Methods

The methods available to teaching faculty for in-course assessment of outcomes can be managed.

If neither the Student-level Data or LMS Integration option has been licensed, the system will default to the Aggregate Score Counts method.

Depending on features licensed, these methods are:

- Aggregate score counts - the count of students at each threshold level (e.g. met, exceeded, not met) can be input.
- Alignment with LMS Gradebook column - the outcome can be aligned with a gradebook column in the LMS and student scored pulled
- Direct entry of student scores - the score for each student in the course can be input.
- Rubric linked to the outcome - each student in the course can be scored using the rubric associated with the outcome.
- Teaching faculty can set - the teaching faculty member can select from one of the available methods.
- Not scored in this semester - the outcome is not assessed in the current semester.

Check the Available parameter to make the method available. Select the Default parameter to make the method the default selection.

The method for GenEd and Program outcomes can be set in the outcomes library. See Outcomes > Methods.

The method can also be set for Course outcomes.

The label for each threshold (e.g. met, exceeded, not met) is set when the assessment module is installed.

Contact Xitracs Support to request any change in these labels.

Reports

The header, footer and title page of the PDF assessment report can be customized.

Workflow Default Rubric

Check the parameter to enable the scorer comment field for assessment rubrics in a workflow.

Workflow Student Source

The default source of students for a new workflow can be set. This avoids having to select the source each time a workflow is created.

If the student source is Open List, check the parameter to allow students to be added while a workflow has a status of Scoring.
3 Xitracs Credentials™

3.1 Overview

The Xitracs Credentials™ module allows information to be captured and managed for:

- **Faculty and Staff members** - Qualifications, Curriculum Vitae (CV), Courses taught, Documents
- **Courses** - Course Sections (instances), Semesters, Instructors (faculty), Syllabi

The information can be categorized by **School** and by **Department** within a school and also by **Campus** (if the campus feature is installed).

Various management and agency **Reports** can be generated, for example, the mapping of faculty qualifications to courses taught. In addition, a **dynamic website** view of credentials information can be made available for **external reviewers**.

*Information regarding the import format of credentials information is available in a separate publication: Xitracs Data Import Guide.*

! **When the Credentials module is first set up, information must be added to the system in the correct sequence of steps.** See the **Control Panel** function or the Xitracs Data Import Guide for more information.

Faculty and course information may be added via import or manual entry and consist of the following main elements:

**Faculty information**
1. Base Data
2. Qualifications
3. Course mapping

**Course information**
1. Course catalog
2. Course sections by semester

*Course Sections are the actual instances of a course; a course may have multiple sections across multiple semesters.*

*The course catalog may be published if the optional Catalog Publisher Add-On™ is installed.*

**Documents**

Faculty and staff documents are added manually via the Documents tab.

If the Documents tab in the Xitracs Portal is enabled, certain documents such as a CV can be added by a faculty or staff member using the **Feedback** function.

If the optional Xitracs File-Q™ feature is installed, documents can be profiled and added to a faculty or staff record by viewing a queued item.

**Credentialing** (optional feature)

Create **workflows** to review and approve credentials for new and existing faculty.
3.2 Faculty & Staff

3.2.1 Faculty & Staff Details

Information for each faculty or staff member may be viewed and edited via the Faculty & Staff tab.

To Find a Faculty or Staff Member

1. Enter data into the Search Box.
2. Check the Last Name (default), First Name, ID or Email radio button.
3. Click the Search button or hit the Enter key.
4. Select a Filter if required.
5. Alternatively, click the List by department, School or List all link.

Click on the Details link for a faculty or staff member in the list and the information will be displayed in the right panel. The availability of certain tabs and functions is dependent on agency templates and modules licensed.

3.2.2 Base Data

The availability and content of many of the fields may be changed via the Control Panel > Faculty & Staff > Settings.

1. Using the function links Edit the fields as appropriate.
2. Select the Highest Degree Earned from the drop-down. The options available are set via the Control Panel > Qualification types function.
3. To add a CV document, use the Upload link (to add from a local resource), Library link to add from the library or Replace link if a CV already exists.

If Extended Data fields have been defined, these will also appear under the Base Data tab.

Note: The member Name, Department and School are not editable in this view. This is a Control Panel function.

You can add Tasks with a priority setting as a notation or reminder. These are internal only and are never published.

Optionally, you can set the status of the information for a faculty member by clicking the Information status link to the right of the tabs.
Management reports are available for both these functions in the Reports section.

Position Data

1. Click the Edit link to update the Job Title and Job Description fields
2. Click the Assign role link to select a role and add an optional comment

Roles are defined in the Control Panel. See Faculty & Staff Settings > Roles
3.2.3 Qualifications

The qualifications for a faculty or staff member may be added or edited.

Use the **Add new**, **Edit** and **Delete** function links as appropriate.

1. For **Degree Awards** you can add the year and indicate if a transcript is on file. Select the award from the drop-down and add additional detail. Click the **Add Credits** link to optionally enter credit information for the qualification.

   *Note: The awards available for selection in the drop-down are managed via the Control Panel > Faculty Settings > Qualifications*

2. For **Licensures**, a license validity start and end date can be added. To exclude a start date, check the box.

   If the **CIP Code** module is licensed, you will be able to assign one or more CIP codes to a qualification. This data may also be imported.

3.2.4 Courses

If the faculty member is enrolled in any course sections, these will be listed in order of most recent semester.

*Note: Course section enrollments are added or removed via the Control Panel > Course Catalog*

1. To add a **Course Section Syllabus**, click the icon and upload a new or replacement syllabus document. The syllabus availability icon will change from (no syllabus) to (syllabus available).

   *Note: To Remove a syllabus from a course section go to the Departments tab, find the relevant course section and click on Details > Remove.*

2. Optionally, select whether the qualification is **Compliant**.

3. Click the **Add** link to select an appropriate **qualification** from the list in the drop-down. The selections available are from the Qualifications tab (see above).

4. Optionally, indicate whether this is an **additional qualification** by checking the box in the drop-down.

   *Note: Qualifications that are flagged as Additional are shown separately in certain roster reports (e.g. SACS)*

5. Add a **Comment or Justification** if appropriate.

6. **Edit** or **Remove** a qualification by clicking on the relevant link.
3.2.5 Eligibility

If the Course Eligibility feature is enabled in the Control Panel, this tab will list courses that the selected faculty member is eligible to teach. Eligibility is determined either by CIP Code matching or by a match to a Direct Mapping List that can be imported and managed as part of the Course Catalog.

If a faculty member is teaching a course for which he/she has not been listed as eligible, an alert flag will appear next to the relevant section under the Courses tab. This alert message is not included in the published roster report.

Faculty eligible for teaching a specific course can be found by using the Reports > Course eligibility report.

3.2.6 AACSB

This Tab and function is only available if the AACSB agency template is licensed.

1. Add or Edit the AACSB Details as appropriate.
2. Select AQ, PQ, or both to enable/disable the relevant Details panel.
3. Select the Highest Degree Earned from the drop-down. The selections available are from the Qualifications tab (see above).

This information can be output to an Excel spreadsheet. See Reports.

3.2.7 Activities

This Tab and function is only available if the AACSB agency template is licensed.

1. Select a Semester.
2. Click the Edit link at the top right of the relevant panel
3. Add or Edit the Activities as appropriate. Data may be added directly or by using the spin control functions.

This information can be output to an Excel spreadsheet. See Reports.

3.2.8 Groups

A list of groups in which the faculty or staff member is enrolled is provided.

- Click the Add link to select a group and the in and out dates.
- Click the Edit link to change the information for an existing group enrollment.
- Click the Remove link to remove an existing group enrollment.

Use caution when editing or removing group enrollments as this may impact downstream reporting.
3.2.9 Documents

You can add documents for a faculty or staff member. These can be General items or in support of Credentials.

Note: Faculty documents are viewable by external reviewers only if enabled using the Administration > System Extensions > Reviewers function.

1. Add a document by clicking the Add file link next to the relevant area.
2. Browse for the file.
3. Add a Title and select the Document Type. To manage the types see Control Panel > Faculty Settings > Documents.
4. Click Submit.
5. After uploading you can View, Edit, Replace or Delete a document by clicking the relevant link next to the item.

If the Xitracs File-Q™ feature is installed, documents may also be added via a File-Q channel.

3.2.10 Feedback

In the Xitracs Portal™ certain information added by a portal user will be available to department administrative personnel via the Feedback tab.

If the Feedback function is enabled, a faculty or staff member can comment on base data, qualifications and add certain documents, such as a CV or course syllabus. After review, administrative personnel can update the respective member's credentials information as appropriate.

Note: Faculty and staff members cannot edit credentials information directly via the portal.

If pending faculty input is present, the Feedback tab will appear. Click on the tab to list the input. A Source field (e.g. Base data) will be shown, together with the date and time the feedback was created. If a file is included, it will be shown under the feedback detail.

Click the View link to open the file; click the Copy link to add the file to the appropriate area, such as a qualification or course.

Use the Respond link to generate an email to the portal user via your email application, e.g. Outlook.

When you have finished processing a feedback item, check the box in the list and click the Delete button to remove it from the pending list.

See also Reports > Feedback to list faculty members with pending feedback.
3.3 Schools & Departments

3.3.1 Schools

The Schools tab allows a user to filter faculty members and courses by school and department and add or edit certain information.

A list of available departments is presented. See the Departments function for additional information.

If the Campus function is enabled, this information will also be displayed.

3.3.2 Departments

The Departments tab allows a user to filter faculty members and courses by department and add or edit certain information.

A list of available departments is presented.

To View Courses and Course Sections for a Department
1. Click on the Courses link for a department to view a list of courses
2. Click on the Sections link (if available)
3. Click on the Details link
4. Add or replace a Syllabus as appropriate

To View Faculty Members for a Department
1. Click on the Faculty & Staff link for a department link to view a list of faculty members
2. Use the Edit link to update a faculty member as appropriate, or Add new
3. See Manage Faculty & Staff for more information

3.3.3 Courses

A list of all courses can be accessed using the Departments tab.

To View Courses and Course Sections for a Department
1. Click on the Courses link for a department to view a list of courses
2. Click on the Details link
3. Click on the Sections link to list any available course sections
4. Click on the Faculty link to view faculty eligible to teach the course
5. Add or replace a Syllabus as appropriate
3.4 CIP Codes

3.4.1 CIP Codes

Classification of Instructional Programs (CIP) Codes can be mapped to both courses and faculty qualifications. This is a Control Panel function.

The CIP Code tab will list the codes loaded into the system and let you drill down and find any faculty or courses that are linked.

A search function is available to find codes by Titles, Definitions and Examples.

Click the **Switch to Course view** link to search for courses in the catalog and view the course details and CIP code mapping (if defined).

Click the **Details** tab to view course information from the catalog.

Click the **CIP Codes** tab to view mapped codes, plus any faculty that match. If any matching faculty are listed, you can view their details and any course section taught.

Click the **Sections** tab to view any course sections for the current semester. Click the **Show prior semesters** link to view earlier sections.
3.5 Reports

3.5.1 Reports

General Reports

1. Credentials Online
   This report generates a website which contains dynamic information in a view-only mode. A viewer can look at faculty credentials and course information.
   If the viewer is external (i.e. not a user logged on to the Xitracs system), access is controlled via the Administration > System Extensions > Reviewers function.

2. Faculty Report
   A static report in PDF format is generated. The report can be filtered by School, Department and Semester.

Agency Reports

Certain accrediting agencies define specific faculty reports, e.g. SACS Faculty Roster.

The availability of these reports is determined by the Agency Templates that are installed.

Management Reports

A suite of management reports is provided, including Missing CVs and Syllabi, Expired Licenses, Open Tasks and Pending Feedback.

Statistics Reports

These reports provide faculty counts by department and location (if the faculty member location has been specified).

CIP Reports (if CIP Code module is installed)

These reports provide usage and exception information by CIP code.

Note: For systems with the Campus module installed, if the user running the reports is not assigned to a specific campus a drop-down will be available to select the campus to which the report applies.
3.6  **File-Q™**

3.6.1  **File-Q™ Channels**

The Xitracs File-Q™ feature is a productivity tool that makes it easy to catalog and add existing documents to the Credentials module. Documents may be added to a channel directly using a Drag/Drop function.

If the feature is installed, the File-Q™ tab will be available. See also Administration > Manage Users to determine who has access to this module. Queued documents can be added to faculty credentials, courses or course sections.

Click on the tab to list any workstations connected to the Xitracs system. If there are any queued documents pending, the number will be shown together with a View link. Click the link to open the list of documents.

The list of any queued documents will appear in the left side panel. Click the Refresh icon to update the list at any time.

**To Profile a Queued Document**

1. Click the View link next to the item at the top of the list to display the file in the right panel.
2. Select the Faculty, Course or Section tab as appropriate.
   
   **If Faculty**
   
   1. Start to enter a name and then click on the relevant faculty member in the list displayed.
   2. Select the document Type.
   3. Select the area to Add the document, e.g. General documents, CV or a specific credential.
   4. Click the Add button.

   **If Course**
   
   1. Start to enter a course code and then click on the relevant course in the list displayed.
   2. Select the document type, e.g. Syllabus.
   3. Click the Add button.

   **If Course Section**
   
   1. Start to enter a course code, select a course section then click on the relevant section in the list displayed.
   2. Select the document type, e.g. Syllabus.
   3. Click the Add button.

3. When finished with the scanned item, click the Summary tab.
4. Click Complete to finish processing the file and remove it from the queued documents list.

*Note: A queued document will not be added to the selected document area until the Complete button has been clicked.*
3.7 Control Panel

3.7.1 Initial Setup

Before using Credentials module for the first time, it is important that these steps are followed in the sequence shown below.

Most of this data can also be imported. See the separate publication Xitracs Data Import Guide.

1. If the optional Campus Module is installed, add the campuses. See Administration > System Extensions > Campuses.
2. Add Schools. See Control Panel > Manage Schools for more information.
3. Add Departments - for each School add one or more departments. See Control Panel > Manage Departments for more information.
4. Add Qualifications, both types and awards. See Control Panel > Faculty Members > Settings > Qualifications for more information.
5. Add Faculty Members. The Department to which a faculty member belongs must be specified. See Manage Faculty Members for more information.
   ! A faculty member may belong to one department only.
6. Add Faculty Credentials. If this data is not imported, see the Faculty tab > Qualifications for manual entry.
7. Add Semesters. See Manage Semesters for more information.
8. Add Courses. See Course Catalog for more information.
9. Add Course Sections. See Course Catalog for more information.
10. Add Faculty Enrollments. These are the course sections being taught by each faculty member.
11. Add Faculty Course Section Credentials. These are the faculty qualifications that apply to course sections taught.

! By default Section Codes are globally unique and cannot be reused for different semesters, unless your system is configured to support semester-unique section codes.

Check with Xitracs Support if you are unsure whether semester-unique codes are configured.
3.7.2 Course Catalog

The Course Catalog is used by the Credentials module to map faculty qualifications to courses taught by semester. The information contained in the catalog can be imported easily by using text files. See the separate publication Xitracs Data Import Guide for information on how to prepare these files. The course catalog consists of two parts:

Courses - these are the "parent" course catalog entries
Course Sections - these are the actual instances of courses delivered

A Course must be linked to a Department and must have at least one Course Section. A Course Section, in turn, must be linked to a Semester and one or more Faculty Members.

For systems where the Assessment module is installed and an LMS Connector is enabled, the Create and Edit functions will include an option to include an LMS Name and LMS Key field. This is to support matching courses and sections in Xitracs to LMS data.

Courses

To Add a Course Manually

1. Click the Courses link
2. Click the Create a new course link
3. Enter the Course Code, Title and short Description (these field are required)
4. Select a Department from the drop-down
5. Enter data for other optional fields (e.g. Level, Hours, Credit) if appropriate
6. Click Submit

Note: If no department is available in the drop-down, there are no departments in the system - see Manage Departments.

To Add or Remove Courses by File Import

See the publication "Xitracs Data Import Guide" for details on file content.

1. Click the Import Courses link
2. Browse for the relevant import file
3. Select the data Separator
4. Click Submit

To Edit a Course

1. Click the Courses link
2. Click the Edit link for the relevant course
3. Update the Availability as appropriate
4. Update the Title and Description or other fields as appropriate
5. Click Submit
Course Sections

To Add a Course Section Manually
1. Click the Courses link
2. Search for a course or click List all courses
3. Click the Sections link for the relevant course
4. Click the Create a section link
5. Enter a Code and Title
6. Select a Semester
7. Specify the Location, Type and Delivery (if applicable) See Other settings
8. Specify an LMS Key (this is optional and only applies if the Assessment module LMS Connector feature is installed)
9. Click Submit

Note: If no semester is available in the drop-down, there are no semesters in the system - see Manage Semesters

To Add or Remove Course Sections by File Import
See the publication “Xitracs Data Import Guide” for details on file content.
1. Click the Import Course Sections link
2. Browse for the relevant import file
3. Select the data Separator
4. Click Submit

To Edit a Course Section
1. Click the Courses link
2. Search for a course or click List all courses
3. Click the Sections link for the relevant course
4. Click the Edit link for the relevant course section
5. Update the Section Code, Section Title and Semester as appropriate
6. Click Submit
Teaching Faculty

To Add Faculty to a Course Section
1. Click the Faculty link
2. Click the Add a faculty member link
3. Search for the relevant faculty member
4. Check the box next the listed faculty member(s)
5. Click Submit

To Remove Faculty from a Course Section
1. Click the Faculty link
2. Check the box next to the relevant faculty members
3. Click Remove

To Add or Remove Faculty Enrollments by File Import
See the publication "Xitracs Credentials Import Guide" for details on the process and file content.

To Add or Remove an Eligible Faculty Member to a Course Manually
1. Click the Courses link
2. Search for a course or click List all courses
3. Click the Eligibility link for the relevant course
4. Click the Add a Faculty Member link or select an existing faculty member to remove
Note: The Eligibility option must be enabled for this function to be available - see Control Panel > Manage Faculty Settings

To Add or Remove Eligible Faculty Members by File Import
See the publication "Xitracs Data Import Guide" for details on file content.
5. Click the Import Courses link
6. Select the Add or Remove eligible faculty radio button
7. Browse for the relevant import file
8. Select the data Separator
9. Click Submit
Other Catalog Settings

Field & Labels

The course catalog fields can be managed. This includes controlling visibility and editing labels for default and custom fields.
1. Click the Field & Labels link
2. Optionally, edit the default label
3. Optionally, select if the field is to be visible (i.e. displayed in the course catalog)
4. Click Submit

Delivery

The course section delivery can be managed, such as On-campus, Online.

Status

The course status can be managed. This includes editing labels for default fields and adding custom statuses.

Type

The course section type can be managed, such as Dual.

Note: If the Standards module and SACSCOC template are installed, the Type (e.g. Dual) will be included in the SACSCOC Roster report.
3.7.3 Course Outcomes

Learning Outcomes for each course can be defined. These outcomes are used in the Assessment module (if installed) for outcomes assessment and outcomes mapping.

Course outcomes can be added manually or imported. See the Xitracs Data Import Guide.

To Add a Course Outcome

1. Click the Outcomes link for the relevant course
2. Click Create an Outcome
3. Enter a short Label for the outcome and a description
4. Click Submit

Use the Edit and Delete link to update or remove an outcome.

For systems where the Assessment module is installed and an LMS Connector is enabled, the Create and Edit functions will include an option to include an LMS Name and LMS Key field. This is to support matching courses and sections in Xitracs to LMS data.

Outcomes are active and available for selection by default. You can set an outcome to inactive by clicking the Edit link. The outcome will remain visible, but can no longer be selected.

Optionally, set an Inactive Date for informational purposes. Inactive outcomes have an indicator [I] next the outcome label.

See also Outcome Scoring Methods.
3.7.4 CIP Codes

If the Credentials module is licensed, the Classification of Instructional Programs (CIP) Code feature will be available. This will enable you to assign one or more CIP codes to both courses and faculty credentials.

Codes may be added and managed on a National, State and Local level depending on institution usage.

For information on how to import CIP codes, see the separate publication: Xitracs Data Import Guide.

In the Control panel, you can use the View link to see the hierarchy of codes.

To assign one or more codes to a specific course, see Course Catalog > Manage courses > CIP Codes. This data may also be imported.

Note: CIP codes are assigned to parent courses, not to course sections. A section will automatically inherit the code(s) from the parent.

To assign one or more codes to a specific faculty qualification, see Faculty > Qualifications > CIP. This data may also be imported.
3.7.5 Credentialing Workflows

This function is only available if the Credentialing Workflows Add-On is installed.

Credentialing activities in the Xitracs Portal are managed via Task Workflows. Using this function, one or more portal users can be assigned to activities such as form completion or approval.

Task workflows are defined in Templates. Click the Create template link to add a new workflow template.

A task workflow template is linked to a Xitracs module (e.g. Credentials) and consists of a sequence of Steps, each of which can be assigned to one of:

- The workflow initiator - the person who starts the workflow
- A team - either a specific team or to allow the initiator to select a team
- A role - to allow the initiator to select a role
- A person with a role - to allow the initiator to select a person with a specific role
- A specific person - to allow the initiator to select a person (from faculty & staff)

A Step can be one of three types:

- Form - The assignee completes the form associated with the step - see below
- Approval - The assignee(s) marks the step approved
- Signature - The assignee(s) marks the step as signed

If the step is a type Form, a Fields link will appear in the function column. Click this link to add fields to the form or edit/remove existing fields.

Each field can be of a Type, depending on the input required at the associated step. If the type is Person the field will include a search look-up from faculty and staff in the system; check the Person Details parameter if you want a link to the selected person's details to appear in the form. If the type is Courses the field will include a search look-up from courses in the system.

You can specify the layout of fields in a form by specifying a Field Width and whether the next field should be Inline. (Note that there are a maximum of 12 columns available for each line of a form. For example, a width of 6 will occupy 50% of the row.) Check the No Label parameter to suppress the field name; this is useful if you have multiple rows of the same fields and do not need the column header repeated.

Check the Allow Attachments parameter to add a file upload capability for a field. You can also specify if at least one file must be uploaded in order to complete the form.

You can change the position sequence of a field in a form by clicking the Edit link for a field and then entering a new position number. You will get a warning message if you have duplicate position numbers in the form.

If a step is assigned to a person with a role or a specific person, you can specify whether the assignee is able to send the workflow task back to a earlier step, for example if not approved.

Click the Access link to assign the faculty and staff roles able to use a template when starting a workflow.

The Report template function controls the MSWord® .dotx template that is used when generating workflow reports in Word or PDF format.
3.7.6 Faculty & Staff Teams

*This function is only available if the Credentialing Workflows Add-On is installed.*

You can create teams with members selected from faculty & staff who are portal users.

A team is linked to a specific module (e.g. Credentials). A team may be associated with certain activities, such as Task workflows.

3.7.7 File-Q™ Workflow Channels

Users with Control Panel access can create channels for adding documents using the drag/drop function. Creating additional channels allows you to separate documents into different queues, for example, transcripts in one channel and course syllabi into another.

Note that in order to have access to a File-Q channel for either uploading or profiling documents, a user must have the necessary privilege enabled. See Administration > Manage users.
3.7.8 Manage Departments

Departments are a subset of a school, therefore at least one school must exist in order to create a department.

Department Names must be unique. For example, there cannot be more than one "Finance Department". However, "Finance Department" and "International Finance Department" is acceptable.

If the Campus extension is installed, department names must be unique within a campus. For example, both Campus A and Campus B may have a department named "Finance Department".

To Add a Department Manually
1. Click the Departments link
2. Click the Create a department link
3. Select a School with which the department is to be associated
4. Enter the Name and short Description for the department
5. Click Submit

To Add or Remove Departments by File Import
See the publication “Xitracs Data Import Guide” for details on file content.
1. Click the Import Departments link
2. Browse for the relevant import file
3. Select the data Separator
4. Click Submit

To Edit a Department
1. Click the Departments link
   Alternatively you can locate a department within the Schools listing
2. Click the Schools link
3. Click the Departments link for the relevant school
4. Click the Edit link for the relevant department
5. Update the School as appropriate
6. Update the Name and Description as appropriate
7. Click Submit
3.7.9 Manage Disciplines

A list of academic disciplines can be created manually or imported. A discipline may be linked to a faculty member and/or to a program if the Programs module is installed. Each discipline must belong to a Classification.

To Create a Classification
1. Go to Control Panel > Schools & Departments > Disciplines
2. Click the Create link
3. Add a Name and optional Description
4. Click Submit

Use the Edit link to amend the name and/or description of an existing classification.

To Create a Discipline
Use the Discipline link next to the relevant classification to add a new discipline or edit an existing discipline.

Disciplines may also be imported. Refer to the Xitracs Data Import Guide.
3.7.10 Manage Schools

Schools are the highest level of organization within an institution. For example: School of Business, School of Medicine. There must be at least one school defined in the system.

School Names must be unique. For example, there cannot be more than one "School of Business". However, "School of Business" and "Graduate School of Business" is acceptable.

If the Campus extension is installed, school names must be unique within a campus. For example, both Campus A and Campus B may have a school named "School of Business".

*Note: The term "School" is used generically. An actual school may be named to fit the institution's terminology, e.g. "College of Business"*

In the system hierarchy, Schools have Departments. Departments have Faculty Members and Courses.

To Add a School Manually
1. Click the Schools link
2. Click the Create a school link
3. Enter the Name and short Description for the school
4. Select a Campus (only available if the campus extension is installed).
5. Click Submit

To Add or Remove Schools by File Import
See the publication "Xitracs Data Import Guide" for details on file content.
1. Click the Import Schools link
2. Browse for the relevant import file
3. Select the data Separator
4. Click Submit

To Edit a School
1. Click the Schools link
2. Click the Edit link for the relevant school
3. Update the Name and Description as appropriate
4. Update the Campus or set to blank to remove the association (only available if the campus extension is installed).
5. Click Submit
### 3.7.11 Manage Semesters

Semesters are used in conjunction with Course Sections to establish the periods during which courses are delivered. This information is used to filter certain reports by semester or date range.

**To Create a Semester**

1. Click the **Semesters** link
2. Click the **Create a semester** link
3. Enter a **Name** for the semester, e.g. Spring 2014
4. Enter the **Start** and **End** dates for the semester
5. Click **Submit**

**To Edit or Delete a Semester**

1. Click the **Semesters** link
2. Click **Edit** or **Delete** next to the relevant semester
3. Edit the semester **Name** and/or **Dates** if appropriate
4. Click **Submit**

For systems where the [Assessment module](https://www.assessmentmodule.com) is installed, a semester can be locked using the **Edit** function above. When a semester is locked, portal users will no longer be able to update assessment scores.

For systems where the [Assessment module](https://www.assessmentmodule.com) is installed and an [LMS Connector](https://www.lmsconnector.com) is enabled, the Create and Edit functions will include an option to include an **LMS Name** field. This is to support matching a semester in Xitracs to LMS data.
3.7.12 Manage Faculty & Staff Members

The Control Panel function provides an option to add faculty members by manual entry or file import. This is also the means by which users are added and managed for the Xitracs Portal.

To Add a Faculty & Staff Member Manually

1. Click the Add new faculty member link
2. Enter a Title (e.g. Professor, Doctor) - this field is optional
3. Enter a Last name and First name - these fields are required
4. Enter an Email address - this field is required
5. Select a Department
6. Select a Location - this field is optional. See Settings > Locations
7. Select a Status (and associated date if applicable) this field is optional. See Settings > Status
8. Select a Discipline - this field is optional. See Disciplines
9. Enter a UserId and/or Network Name if used by your institution - these fields are optional
10. Select a Type - this field is optional. See Settings > Types
11. Select a Supervisor - this field is optional. The user selected will be able to view the credentials information for this faculty or staff member. **Note:** The selected user must be another faculty or staff member.

**Note:** If no department is available in the drop-down, there are no departments in the system - see Manage Departments.

To Add or Remove Faculty & Staff Members by File Import

See the publication “Xitracs Data Import Guide” for details on file content.

1. Click the Import link
2. Browse for the relevant import file
3. Select the data Separator
4. Click Submit

If a faculty/staff member is also a student (see below), the indicator [S] will appear in the Type column
To Edit a Faculty or Staff Member

1. Click the Find link
2. Search for a faculty member or click List all
3. Click the Edit link for the relevant faculty member
4. Update the Fields as appropriate
5. Click Submit

To Change a Faculty or Staff Member Password

Not applicable if Single Sign-on enabled

1. Click the Find link
2. Search for a faculty member or click List all
3. Click the Password link for the relevant faculty member
4. Update the Password as appropriate
5. Click Submit

To Make a Faculty or Staff Member also a Student

Requires the Assessment module and also Assessment module Control Panel access privileges

1. Click the Find link
2. Search for a faculty member or click List all
3. Click the Edit link for the relevant faculty member
4. Check the Student Attribute parameter
5. Click Submit

Note: A User Id field value must exist for the Student Attribute parameter to operate.

Masquerade Mode

If your system has masquerade mode enabled, system users with a role of Administrator are able to logon with a portal user session by clicking the Masquerade link for a faculty or staff member. This is a useful function for validating information.

Contact Xitracs Support if you wish this function to be enabled.
3.7.13 Manage Faculty & Staff Settings

The options available in the Edit Faculty view can be managed through the Faculty Settings function.

Base Data
1. Click the Field Settings link to control which fields are visible on the Base Data tab
2. Check the box next to the base data fields that are to appear. (These cannot be edited).
3. Click on each of the other fields (e.g. Faculty Rank) to edit or add values to the drop-down selection.

For certain base data fields (e.g. faculty Rank), the drop-down values can be edited.

Groups
Faculty & staff members may belong to one or more groups. A group is associated with a group type.

To Create a Group Type
1. Click the Types link
2. Click Create a type
3. Enter the type name
4. Click Submit

Use the Edit and Delete links to change or remove a group type.

To Create a Faculty & Staff Group
1. Click the Types link
2. Click Create a group
3. Enter the group name and description and optional code
4. Select an available group type
5. Click Submit

Use the Edit and Delete links to change or remove a group.

Other
Document Types
1. Click the Documents link to edit or add values to the drop-down selection.
This function controls which document types are available in the portal to individual faculty and staff members and supervisors (if applicable). To control which items are available to external reviewers. See Administration > System Extensions > Reviewers
2. Click the Create link to add a new document type.
3. Click the Edit link to rename a type or to change portal access.

See also Faculty > Documents tab
Extended Data
1. Additional fields can be added to the Base Data tab at Institution, School and Department level.
2. Click the Add new link to create a field set for a School or Department.
3. Specify the relevant field type. If the field type is Selection, use the Parameters link to define the available drop-down selections.
4. After a field is created, use the Edit link to change and/or set if the field will be Hidden in the Portal (not visible to faculty & staff).

Locations
1. Click the Location link to edit or add values to the drop-down selection.

   ! If you try to delete a drop-down value while it is in use, you will receive a warning message.

Status
1. Click the Status link to edit or add values to the drop-down selection (e.g. Resigned, Retired).

Types
1. Click the Types link to edit or add values to the drop-down selection (e.g. Faculty, Staff).

Portal
You can control whether the credentials Feedback button is enabled in the Portal. Check the parameter to enable or disable this setting.

Position

Roles
You can create roles (e.g Committee Chair) that can be assigned to faculty and staff members via the Base Data tab or via import.

   Roles that have been assigned cannot be deleted.

Note: Role names are globally unique. If the Programs module is installed and the role name is already in use, it cannot be used as a faculty & staff role.

Teams
This function is available if you have the Credentialing feature installed. See Credentialing workflows.

Qualifications
See qualifications for more details about this function, including faculty eligibility.

See the Course Catalog for information on how add eligibility information.
3.7.13.1 Qualifications

Qualifications can be added to the Credentials system and subsequently selected when editing a faculty member.

Qualifications - Award Types

Each qualification award must belong to a Type. The system includes four default types: Associate, Bachelors, Masters, and Doctorate.

The default types may be edited and additional types added. These types will be available for selection in the Highest Degree Earned field when editing a faculty member.

Create a Qualification Type

1. Click the Types link
2. Click the Create link
3. Enter a Name for the type
4. Click Submit

An existing type may be Edited or Deleted by clicking the appropriate function link.

! Deleting a type will cause any associated qualifications to be without a type. After deletion, check to see if there are any “orphaned” qualifications and associate them with another type.

Qualifications - Awards

The system includes 4 default qualification awards which are linked to the default types and have the same names: Associate, Bachelors, Masters & Doctorate. The default qualifications may be edited and additional ones added. These qualifications will be available for selection in the Qualifications field when editing a faculty member.

You may add as many more qualifications as you need, depending on the level of granularity you require. For example:

- Bachelor of Arts
- Bachelor of Arts - Music
- Master of Business

Create a Qualification

1. Click the Qualifications link
2. Click the Create link
3. Select a Type
4. Enter a Name for the qualification
5. Click Submit

An existing qualification may be Edited or Deleted by clicking the appropriate function link.

! Deleting a qualification will cause any associated faculty links to be lost. After deletion, check to see if there are any “orphaned” faculty and associate them with another qualification.

Qualifications - Other
You can edit the drop-down selections available for Other Qualifications & Experiences.

**Qualifications - Settings**

You can control whether the system will force entry of an Institution and Year for each qualification award.

Check the box to enable Course eligibility tracking if required. Select the source: either CIP Code matching or Direct Mapping list.

*Qualifications and Qualification Types may also be imported if preferred. See the Xitracs Credentials Import Guide for more information.*

### 3.7.14 Reports

Static data (title page, header and footer) contained in the Credentials PDF Report and certain Agency Credentials Reports (e.g. SACSCOC Roster) can be set.

1. **Enter** data in the available fields
2. Click **Submit**

If you have a custom SACSCOC Roster template, it can be uploaded and selected here.

Click the **User Access** link to view which system users have access to which schools and departments.

For more details on available credentials reports, see the main **Reports** section.
3.7.15 Automap Credentials

In the Xitracs system, faculty credentials are linked to course sections. This lets you generate reports which show the relevant qualification(s) for a course being taught in a specific semester. This is important when there is an external reporting requirement to show the specific qualifications held by an individual faculty member at the time a course was being taught. Mapping of course credentials to specific sections may be done manually via the courses tab for each faculty member or, more typically, via data import. (See the separate publication Xitracs Data Import Guide).

For those institutions which do not have a need to track specific credentials for each course section, the Automap function will automatically map a faculty member's credentials to the course sections being taught in a selected semester. This eliminates the need to import the course credential mapping data. Once an initial semester has been updated using Automap, subsequent semesters can then be updated using the Synchronize function.

To Initiate Automap
1. Select the Semester in which course sections will be updated.
2. Select the Department(s) for which course sections will be updated.
3. Select the Qualification types to map and whether each type should be included as a main or additional qualification.
   
   Note: Qualifications that are flagged as Additional are shown separately in certain roster reports (e.g. SACS)

4. Click Submit
5. After automapping, a report will be generated.

3.7.16 Synchronize Credentials

The Synchronize Credentials function allows you to carry forward existing mapped qualifications to course sections in a subsequent semester without having to import a new credentials mapping file or update a faculty member manually.

For example, if faculty qualifications have already been mapped for course sections in the Fall Semester, they can be carried forward to sections of the same course in the following Spring semester automatically.

Course sections in the selected semester with no mapped faculty qualifications will be updated as follows:

From another section of the same course in the selected semester that already contains mapped qualifications

OR, if no other section of the same course in the selected semester exists:

From the most recent prior semester that contains a section of the same course with mapped qualifications.

Note: You cannot synchronize retroactively; i.e. update earlier course sections from a later semester.

To Initiate Synchronization
1. Select the Semester in which course sections will be updated.
2. Select the Department(s) for which course sections will be updated.
3. Click Submit
4. After synchronization, a report will be generated.
3.7.17 **Xitracs Add-Ons**

The **Xitracs Add-Ons™** panel will list any available optional Add-ons that relate to the Credentials module.

If any of these has been licensed, the link will be active.

See [Add-Ons](#).
4 Xitracs Planning™

4.1 Overview

The Xitracs Planning™ module allows you to create plans, gather input from a number of sources, track progress and publish in a website or PDF format.

Depending on your Xitracs system configuration, you can create two types of plan: Free-form or Goal-based. Free-form plans can be built with a more flexible structure in terms of headings and editable rows, whereas Goal-based plans only have headings under which goals can be added. The advantage of a goal-based plan is that it lets portal users create and link goals. The goals themselves can then be tracked over time.

In systems where goal-based planning is not enabled, all existing and new plans are designated as Free-form.

Plans are managed in cycles and associated timeframes. For example, a strategic plan cycle may be on a three-year timeframe, whereas an operational plan cycle may be on a one-year timeframe. Plans may also be linked for reporting purposes, such that a row in Plan A might be linked to another row in Plan B.

Plan input is managed through Fields. The fields are defined by the plan builder and are consistent for all rows in the same plan, but may differ from plan to plan. Fields may be completed through either (1) the assignment of a plan row to a team or (2) the assignment of a plan row to one or more portal users. Plan rows may optionally be linked to a Survey or to individual survey questions. This is a useful tool for gathering input.

Click on the Plans tab to go to a list of plans available to you. The availability is determined by your membership of one or more teams.

If your plan list is empty or a particular plan is not listed, it is typically due to either: (1) you are not a member of any team or (2) you are a member of a team, but the team has not been assigned to any rows in the plan or (3) the plan has been set to Offline.

See the Teams function for further information about how to assign team members and Properties about how to set the status of a plan.

Plans can be organized by group and associated with a department via the Control Panel > Manage Plans function.

To switch views, click on the relevant link or click list to view all available plans. A user must belong to a plan's team for the plan to be available. A user's plan list will look similar to the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Type</th>
<th>Cycle</th>
<th>Timeframe</th>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Division Plan</td>
<td>Division Plan example</td>
<td>Free-form</td>
<td>2</td>
<td>2015-2016</td>
<td>Online</td>
<td>Edit Preview Publish Teams</td>
</tr>
<tr>
<td>Institution Strategic Plan</td>
<td>Institution-wide strategic plan</td>
<td>Free-form</td>
<td>1</td>
<td>2013-2016</td>
<td>Online</td>
<td>Edit Preview Publish Teams</td>
</tr>
<tr>
<td>Strategic Goals</td>
<td>Strategic Goals for the department</td>
<td>Goal-based</td>
<td>1</td>
<td>2015-2016</td>
<td>Online</td>
<td>Edit Preview Publish Teams</td>
</tr>
<tr>
<td>Strategic Objectives</td>
<td>2013-2016 Strategic Objectives</td>
<td>Free-form</td>
<td>1</td>
<td>2013-2016</td>
<td>Online</td>
<td>Edit Preview Publish Teams</td>
</tr>
</tbody>
</table>

If a user's plan is not associated with a group or department, it will only be visible in the list view.

The Title and Description identify the plan.

The Type column identifies the plan as Free-form or Goal-based. (see above).

The Cycle contains the number of the cycle that the plan is currently in. Plan cycles are set via Control Panel > Manage Plans > [Plan] > Properties.
For additional information see Manage Plans > Plan Cycles.

The Timeframe contains the name of the timeframe that is associated with the cycle. Timeframes are set via Control Panel > Manage Plans > [Plan] > Properties. For additional information see Control Panel > Timeframes.

The Status indicates the current state of the plan. This is set via Control Panel > Manage Plans > [Plan] > Properties.

- Online - the plan is available for editing by assigned team members.
- Locked - the plan can be viewed by assigned team members but cannot be edited.

The Function column contains a number of links which will take the user to an operation in the Xitracs system. Availability of these links is determined by the type of team that you belong to for a specific plan. See the next section to understand how these functions work.

4.2 Plans

4.2.1 Editing a Plan

In the Edit mode, the Plan is available to system level team members to view, add to or edit information for assigned rows.

The first example is of rows in a Free-form plan. Portal users are assigned by clicking on the portal icon.

<table>
<thead>
<tr>
<th>Row</th>
<th>Information</th>
<th>Links</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goal</td>
<td>Facilities</td>
<td>Log</td>
<td>Budget</td>
</tr>
<tr>
<td>Goal</td>
<td>Retention</td>
<td>Portal</td>
<td>In</td>
</tr>
<tr>
<td>Goal</td>
<td>Faculty</td>
<td>Survey</td>
<td>In</td>
</tr>
</tbody>
</table>

In the example above, there are three action rows listed. If a row is grayed out, it is because a team member is not assigned to a row. See Teams on how to assign teams to a plan row.

The example below is of a Goal-based plan. Portal users can be assigned to header rows by clicking on the portal icon.
To assign a plan row to a portal user

1. Click on the icon
2. Click the Add a user link by role - can be Editor, Reviewer or Viewer
   Editors can create and edit goals; Reviewers can view, add comments to and approve goals (if workflow is enabled); Viewers can only view goals.
3. Start typing the portal user name into the box, this will initiate the auto search
4. Select and click on the required portal user from the search result
5. Click the icon to add the name to the list or use the Enter key; to remove highlight the name(s) in the list and click the icon
6. Click Submit

Goals can then be added and updated by assigned portal users. Goals can also be added and updated in this system user view. If a goal is not linked and/or was not started in a prior reporting cycle, it can be Deleted.

If a goal was started in a prior cycle, the Delete goal function link will be replaced by a Finish goal function link. Finishing a goal has the effect of retaining all of the associated information but will not repeat the goal in the next and subsequent reporting cycles. To finish a goal in the current cycle or to reinstate a goal as active, see the Goals tab.

If the plan includes a budget, this field will be enabled and the value entered will appear in the budget column. See Fields below.

4.2.1.1 Log

Each time a user edits a section of a plan, the action is recorded automatically by the system. The last action is visible by placing the mouse cursor over the icon.

1. Click on the icon to see all actions for the section
2. A comment may be added manually by a user by clicking on the Post Comment link

The log is not included as part of the published plan.
4.2.1.2 Fields

Fields are the work area where information is entered into a plan. The fields may be edited by clicking the icon.
If there is no icon present, it means that you are not a member of the team that has been assigned to the row.

If a plan includes a Budget, the budget field will be available.

To enter information into a specific field, click the Edit link, which will open the input area. The required input will vary depending on field format. For example, if the field input format is free-form text, the text editor will open. For other fields, the format may be a drop-down selection or quantitative (e.g. numeric or percentage). Field names and associated formats are defined when the fields are created by the plan builder.

For more information see Using the Text Editor. Note that the editor does not support embedded images or hyperlinks in plan fields.

If a field has been configured to allow supporting files, you will be able to add files from a local resource such as your hard drive by clicking the Add a file link.

After editing a field, click the OK button to save. If the field input is complete, check the Mark as complete box.

Note: Plan fields are defined in the Control Panel. See Manage Plans > Settings > Fields

4.2.1.3 Links

Linking is a useful feature that lets you create relationships for data gathering or reporting purposes.

For Goal-based plans, you can also set permissions that will allow portal users assigned to a plan row to link to a row in another plan that has not been set as a target. For example, this allows a goal in plan A to link to one or more goals in plan B. See permissions.

There are three ways of linking a plan row:
1. To one or more portal users
2. To a survey or to specific survey questions
3. To one or more rows in another plan

Link to Portal Users

When you link a plan row to one or more portal users, field input can be completed via the Xitracs Portal. The linked portal users can access the plan row fields via the Plan tab in the portal.

You can advise portal users of the assignment via email. See Control Panel > Manage Plans > [Plan] > Settings > Portal Settings > Email Users.

1. Click on the icon
2. For Free-form plans, click the Add a portal user link.
3. For Goal-based plans, click the Add a plan Editor or Add a plan Reviewer link.
4. Start typing the portal user name into the box, this will initiate the auto search
5. Select and click on the required portal user from the search result
6. Click the icon to add the name to the list or use the Enter key; to remove highlight the name(s) in the list and click the icon

7. Click Submit

**Link to Surveys**

Surveys or specific questions within a survey may be linked to a plan row using the Control Panel. See Manage Surveys > [Survey] > Link to plans.

If a survey is linked, the icon in the plan row will be active; if not, the icon will be grayed out.

1. Click on the icon

2. A list of linked surveys and questions will be shown.

3. Click the View link to show a list of responses or the Excel link to download the survey in an MS Excel® file format

**Link to Other Plans**

You can link a plan row to a row in another plan. The number of Links In and Links Out are displayed.

*Note: Links In are only editable using the Links Out function in the source plan.*

1. **Links In** - You can click on the number if it is more than 0 to view other plans linked to this row.
2. **Links Out** - Click on the number and select a plan and row(s) to create links.

**4.2.1.4 Permissions**

*This function applies to Goal-based plans only.*

In goal-based plans, by default, a portal user with a role of plan editor can link a goal to one or more goals at a higher level in the same plan, for example allowing a Dean to link a goal to a President's goal. A portal user can also link to one or more goals in another plan that has been defined as a target. For example, to link a goal in a department plan to a goal in an institution-wide plan.

You can also set up additional link privileges on an exception basis by using the Permissions function. For example, unless Department Plan A has been set as a target, portal users in Department Plan B will not be able to link to goals in Department Plan A. However, there may be a requirement to link only certain goals between the two plans.

You can do this by clicking the Set permissions link for a specific plan row. When you click this link you will be able to select from a list of available plans that have not been set as link targets. Select a plan and then select one or more available rows.

**4.2.1.5 Dates**

A date can be set to indicate when a particular section is to be started or due as a visible aid to team members and is also used in the generation of the Due Date Report. The Set Date function is only available to users who are members of the Manage Team.

**Start Dates**
• To set the date, click on the icon, select a date from the pop-up and click Submit.
• To edit an existing date, click on the date, select a new date and click Submit.
• To clear an existing date, click on the date and click Clear.

Due Dates

• To set the date, click on the icon, select a date from the pop-up and click Submit.
• To edit an existing date, click on the date, select a new date and click Submit.
• To clear an existing date, click on the date and click Clear.

Due dates are automatically added to the Calendar for each team member enrolled in the plan.

4.2.1.6 Status

A status is used to indicate progress through the planning process. The absence of a status is indicated by the □ symbol.

The ability to set a status is controlled by a user's Team Membership for a specific plan row as follows:

The Status column indicates the status of activity for each plan row.

- Users who are members of an Action Team can set a status of Draft or For Review
- Users who are members of a Review Team can set a status of Resubmit or Approved
- Users who are members of a Manage Team can set any available status, including Complete

To set a status:
1. Click the □ icon or the existing status link
2. In the pop-up, select an available status
3. Optionally, check the box to post a Comment
4. Click Submit

Note: An inactive link indicates that the user does not have the privilege to edit the status. See team membership.

To clear a status:
1. Click the Clear button in the status pop-up

Note: This function is only available to Manage team members
4.2.2 Preview

The Preview function allows a user to view how the plan will look without having to publish it. In the Preview mode, no document files are copied and are available for viewing only.

To Preview a Plan
1. On the Plans page, click the Preview link.
2. Select the Cycle to be included. The selection will default to the current plan cycle.
3. Select the Format for the preview.
4. Optionally, select specific Field(s) to be included. (The default is all fields).
5. Optionally, select any Linked data to be included.
6. Click Submit. Depending on the size of the plan, the preview may take a few moments to generate.

*Note: Previews in website format cannot be saved and will reset when the browser window is closed.*

4.2.3 Publish

The Publish function will generate a plan in a selected format, which can then be used for one or more of a Printed Copy, Website or Electronic Media such as CD or DVD. When a plan is published, all of the narrative and documents (if selected) are copied as part of the plan file. Therefore, any changes made to the plan using the Edit function will have no effect on a previously published plan.

The Publish function is only available to users with a Manager or Administrator role.

To see how a plan will look prior to publication, use the Preview function.

To Publish a Plan
1. On the Plans page, click the Publish link.
2. Select the Cycle to be included. The selection will default to the current plan cycle.
3. Select the Format.
4. Select a Destination.
5. If the format is Website the submission may be published to a website location (if defined) or downloaded as a compressed (.zip) file.

*Note: Website locations must be predefined. See Control Panel > Manage Plans > [Plan] > Settings > Website > Locations*
6. Optionally, select any Linked data to be included.
7. Click Submit. Depending on the size of the plan, the file may take a few moments to generate.
4.2.4 Teams

System Users are assigned to a plan through membership of a Team. There are three types of teams: Action, Review and Manage. The team type controls which functions in the Xitracs system are available to users. There can be multiple Action and Review teams, but there is only one Manage Team for the entire plan; users who are members of the Manage Team can edit or update the status of all plan rows.

<table>
<thead>
<tr>
<th>Functions available</th>
<th>Team type</th>
<th>Action</th>
<th>Review</th>
<th>Manage</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Set Preparation Status (assigned rows only)</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>• Set Start/Due Date (all rows)</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• Edit Fields (assigned rows only)</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>• Post Comments (assigned rows only)</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>• Link to Other Plan Rows (assigned rows only)</td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• Link to Faculty (assigned rows only)</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>• View linked Surveys (assigned rows only)</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>• Manage Teams</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• Add/Edit Preamble</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• Preview Published Plan</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• Publish Plan</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• View Reports</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>• Access Library</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>• Post to Discussions</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Note: Preparation Status selections will differ depending on team type. See Editing a Plan > Status for more information.

There is one team of each type created automatically when a plan is first created; these are the default teams and they cannot be edited or deleted. Additional Action or Review teams can be created as required, then edited or later deleted as appropriate. Creating additional teams is optional, however, it provides a greater level of granularity in assigning users to plans. For example, the preparation and review certain rows in a plan may relate to a specific department, say the English Department. By creating separate Action and Review teams, the relevant rows can be assigned only to the members of those teams, (see Manage Team Access below ). Users who are members of other Action or Review teams will not be able to edit these rows or update the statuses.

⚠️ A user must belong to an assigned team in order to have access to a plan. If a user belongs to a team that has not been assigned to one or more rows, the plan will not appear in the user’s plans list.

**To Create a New Team**

1. Click the Create a new team link
2. Enter a team Name
3. Enter a team Description
4. Select the team Type, either Action or Review
5. Click Submit
To Add Team Members
1. Click the Members link
2. Click the Add member link
3. Enter a User ID, Last Name or First Name to find the user (partial entry allowed)
4. Click Submit
5. Matched user(s) will be listed
6. Check the box next to the relevant user
7. Click Submit

To List Team Members
1. Click the List or Remove members link

To Remove Team Members
1. Click the List or Remove members link
2. Check the box next to the relevant user(s)
3. Click Submit

To Manage Team Access to Rows of the Plan
1. Click on the Manage team assignment link
2. In the matrix, click on an Action Team or Review Team cell
3. Select a team from the pop-up

Note: You must first have created additional teams for them to appear in the pop-up. See Create a New Team above.
4.2.5 Workflow

Note: This function only applies to Free-form plans. The approval workflow feature for goal-based plans is built-in.

If a workflow channel has been assigned to a plan via the Control Panel, a workflow status column will appear in the Edit plan view and also in the plan fieldset.

You may also view any pending workflow items by clicking the inbox icon in the plans page header bar.

To select and update a workflow step, open the fieldset and click on the Edit link. If the step is not available it will show Locked. Availability is determined by the access setting in the Control Panel. For example, if you are on the Action Team for a plan section, you might be able to select a 'Request Approval' workflow step not the 'Approved' step. If you are the Manage Team you will be able to select any step by clicking the Manage link next to the locked status in the fieldset.

When you select a step, you can also add an optional comment.

To assign a channel to a free-form plan, see Manage Plans > [Plan] > Properties

4.3 Goals

4.3.1 Goals

Note: This function only applies to Goal-based plans.

If goals have been added to a Goal-based plan, they will be listed here.

<table>
<thead>
<tr>
<th>Goal ID</th>
<th>Goal Detail</th>
<th>Reporting Unit</th>
<th>Plan</th>
<th>Started</th>
<th>Finished</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering-G001</td>
<td>Achieve a graduation rate of greater than 80%</td>
<td>Engineering</td>
<td>Strategic Goals</td>
<td>26/15/2016</td>
<td></td>
<td>Details</td>
</tr>
<tr>
<td>Engineering-G002</td>
<td>Complete the new mechanical engineering test facility</td>
<td>Engineering</td>
<td>Strategic Goals</td>
<td>26/15/2016</td>
<td>2016/2017</td>
<td>Details</td>
</tr>
<tr>
<td>Engineering-G003</td>
<td>Assessment process</td>
<td>Engineering</td>
<td>Strategic Goals</td>
<td>26/15/2016</td>
<td></td>
<td>Details</td>
</tr>
</tbody>
</table>

Use the search option at the top of the list to filter results by plan, date and keyword.

If a goal has been finished, the last cycle will be shown in the Finished column. You can reinstate to active, a goal that has been set as finished, provided it was set in either the current or prior reporting cycle. Goals set as finished in an earlier cycle cannot be reinstated.

Click the Details function link to view the input for this goal for each applicable reporting cycle. Click the Links function to see what other goals are linked.
4.4 **Summary**

4.4.1 **Plan Snapshot**

Users with a role of Manager can view a snapshot report of all active plans. The list will look similar to the following:

**Management Snapshot**

<table>
<thead>
<tr>
<th>PLAN</th>
<th>Overall Plan (Cycle: Plan cycle - 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overall Institution Plan</td>
</tr>
<tr>
<td></td>
<td>Linked Plans/Rows: 4/13</td>
</tr>
<tr>
<td></td>
<td>Linked Budgets: $60,000</td>
</tr>
<tr>
<td>Progress:</td>
<td>5% Complete 5% Started</td>
</tr>
<tr>
<td>Budget:</td>
<td>$12,000,000</td>
</tr>
<tr>
<td></td>
<td>Linked Plans/Rows: 2/3</td>
</tr>
<tr>
<td></td>
<td>Linked Budgets: $0</td>
</tr>
<tr>
<td>Progress:</td>
<td>14% Complete 38% Started</td>
</tr>
<tr>
<td>Budget:</td>
<td>$1,000,000</td>
</tr>
<tr>
<td></td>
<td>Linked Plans/Rows: 3/12</td>
</tr>
<tr>
<td></td>
<td>Linked Budgets: $735,000</td>
</tr>
<tr>
<td>Progress:</td>
<td>11% Complete 11% Started</td>
</tr>
<tr>
<td>Budget:</td>
<td>$5,000,000</td>
</tr>
</tbody>
</table>

A number of metrics are shown for each plan:

- **Progress Bar** shows the percent of fields started and completed.
- **Budget** for the plan (if applicable).
- The total of **Budget Input** (if applicable).
- The number of **Links In** from Plans, and Rows in those plans (if applicable).
- The total of any **Budget Fields** from linked plan rows (if applicable).

If in List view, the left panel of the summary report lists the plans with two function links. In Group or Department view, these links are shown in the snapshot summary panel.

Click on **View** to open the plan summary. Overall progress is displayed and the current status of rows, fields and budget input can be viewed.

Click on **Map** to display a graphical representation of the links to the selected plan. You can view other plan maps, plan rows or surveys from the tree by clicking on the appropriate link.

4.5 **Surveys**

4.5.1 **Overview**

The Xitracs Survey feature lets you gather information from faculty members using a familiar survey tool. Surveys can be built with different response options, such as text input or radio button selection. Files may also be uploaded in support of a response.

Building, linking and distributing a survey is via Control Panel > **Manage Surveys**. Respondents may access a survey via an email (See Manage Surveys > **Distributing a Survey**) or via the optional Xitracs Portal.
4.5.2 Activity

The activity report for a survey shows list of participants and the status of response. The status may be one of the following:

- **Not started**: The survey has not yet been started by the participant.
- **Started**: The survey has been started but not completed.
- **Finished**: The survey has been completed.
- **Finished (U)**: The survey was previously completed and has been reopened and updated.

4.5.3 Questions

This report lists the questions in the survey, together with an indication of whether a response is required.

*Note: Setting questions is a Control Panel function. See Control Panel > Manage Surveys > [Survey] > Questions*

4.5.4 Responses

The current responses for the selected survey are returned in this report. The responses may be viewed by Participant or by Question, or downloaded to an MS Excel® spreadsheet.

4.6 Reports

4.6.1 Activity Log

The Activity log lists, in descending chronological sequence, all of the user activity that has occurred for a plan in the Edit mode, including due date changes, status changes and document updates.

Included in the report are the Section Reference ID (where applicable), the Section Description, the Activity, Date and Time, and the User Name.

4.6.2 Due Date

The Due Date Report lists all sections that meet a set of criteria. These can be Past Due and Due within a specified period of days.

The preparation Status may be filtered, as required. Any sections with a status of Complete are excluded.

*Note: The generated report will be in View mode. Changes to a plan section must be made using the Edit function.*

4.6.3 Progress

The Progress Report lists the number of sections by status and as a percentage of total sections.

4.6.4 Spreadsheet

You can download the plan fields in an MS Excel® format (.xls file). Click the link to generate the spreadsheet. Two worksheets are included: Plan Fields and Field Keys.
4.7 Control Panel

4.7.1 Manage Plans

The Manage Plans function allows a manager with control panel access or a system administrator to control which plans are available to users, plus perform a number of administrative activities.

To Create a Plan

1. Click the Create a new plan link. (If the Goal-based plan option is enabled, you will be able to select either a Free-form or Goal-based plan.
2. Enter a plan Title and Description. The title must be unique. You will receive an alert message if you enter a title that is already in use.
3. For a Goal-based plan, you have the option of having the system automatically build plan headers from all or selected departments.
4. Check Budget if you want to associate a budget with the plan. You can set a budget value later using Manage Plans > Settings.
5. Check Report Target if you want to allow other plans or surveys to link to this plan.
6. For a Goal-based plan, check the Workflow parameter if you want each goal to have an approval workflow associated with it.

Note: Free-form plans can also have workflow associated if required.

7. Select the Field Set to be used. A list of the fields in the set will be displayed. This function defines the input fields to be completed by users assigned to the plan. You can edit these fields later; see Plan fields. See also Control Panel > Field Sets.
8. Click Submit

As you add plans, the list will look similar to the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Cycle</th>
<th>Timeframe</th>
<th>Status</th>
<th>Target</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOP Action Projects</td>
<td>Sample AOP Action Projects</td>
<td>1</td>
<td>2009-2010</td>
<td>Offline</td>
<td>Yes</td>
<td>Edit Build Copy Delete Properties Teamas Settings</td>
</tr>
<tr>
<td>Institution Strategic Plan</td>
<td>Institution-wide strategic plan</td>
<td>1</td>
<td>2009-2012</td>
<td>Online</td>
<td>Yes</td>
<td>Edit Build Copy Delete Properties Teamas Settings</td>
</tr>
<tr>
<td>Operational Plan</td>
<td>Department planning activities</td>
<td>2</td>
<td>2011-2012</td>
<td>Online</td>
<td>Yes</td>
<td>Edit Build Copy Delete Properties Teamas Settings</td>
</tr>
<tr>
<td>Program Example</td>
<td>Program Plan example</td>
<td>2</td>
<td>2010-2011</td>
<td>Online</td>
<td>Yes</td>
<td>Edit Build Copy Delete Properties Teamas Settings</td>
</tr>
<tr>
<td>Science Department</td>
<td>Science Department Annual Plan</td>
<td>1</td>
<td>2009-2012</td>
<td>Online</td>
<td>Yes</td>
<td>Edit Build Copy Delete Properties Teamas Settings</td>
</tr>
</tbody>
</table>

Each plan is listed with a Title and Description. It may also be listed as Free-form or Goal-based.

The Cycle contains the number of the cycle that the plan is currently in. Plan cycles are set using the Properties function. For additional information see Manage Plans > Plan Cycles.

The Timeframe contains the name of the timeframe that is associated with the cycle. Timeframes are set using the Properties function. For additional information see Control Panel > Timeframes.

The Status of a plan determines its availability to team members. The status is set using the Properties function. There are three possible settings:

- **Online** - the plan is available and may be edited by the assigned team members
- **Locked** - the plan is available for viewing only; it cannot be edited by the assigned team members
- **Offline** - the plan is not available; it will not appear on the assigned team members list of plans
The Build function lets you add rows to your plan. A plan is not useable unless it is first built. See *Building a Plan*.

⚠️ You cannot build a plan unless it has a status of Offline. See *Properties*.

A plan may be removed from the list by using the Delete link, provided that it has a status of Offline.

⚠️ Removing a plan is irrevocable and will delete all associated field data and supporting documents.

To be available, users must next be assigned to one or more of the plan's teams. Click the Teams function link and follow the process described in the Teams section to achieve this.

### 4.7.1.1 Building a Plan

Once plan has been created, you can put it together it using the Control Panel > Manage Plans > [Plan] > Build link. *Note that this link is only active if the plan status is Offline.*

A plan consists of rows that are analogous to headings, sections or paragraphs in a written document. For Free-form plans the structure can be made hierarchical and can consist of Action Rows and Information Rows. For Goal-based plans, only Header Rows can be defined. The goals under each header are added and updated by assigned portal users.

A Header Row lets you add child rows to group other rows. Does not allow field input or linking.

An Action Row allows for field input, linking and due dates but does not let you add child rows.

An Information Row is intended for information only and does not allow field input, linking or child rows.

The build page consists of two panels:
- The left panel contains the Plan Tree. This is a dynamic representation of the plan structure. You can edit a plan using this tree.
- The right panel contains the Row Attributes. This displays details about the selected row. You can edit the row attributes in this panel.
- You can re-size the panels by clicking on the vertical divider bar and dragging it to the right or left.

**To Start Building a New Plan**

When you start building a new plan, the left panel will display only the Plan root. In the right panel, click the Add row link and the following row attributes will display:
The editable attributes consist of the following:

1. **Type**: Select the type of row. The default setting is an Action row.
2. **Class**: Select the row class. This sets the graphic displayed in the Edit plan and Snapshot views. Not available for information rows.
3. **Label**: Enter a label for the row, e.g. a paragraph number such as 2.1 or a short title. Cannot exceed 20 characters.
4. **Name**: Enter a name for the row.
5. **Description**: Enter an optional description. This will appear below the row name in the Edit plan view.
6. **Target**: Check this box to allow other plans or surveys to link to this row. Only available if overall plan allows report linking; see Manage plan. Not available for information rows.

As you continue to add rows, the tree in the left panel will grow and show the hierarchy. If you need to view an existing row, click on the link and the detail screen will open in the right panel.

At the top of the detail screen there will a number of links. You can **Edit** the row details or **Insert a row** above or below it. If the row type you have selected is a header, you will also be able to **Add a row under** (i.e. add a child row). If the row type is Header and it has child rows (as in the example below), the **Delete row** link will not appear until any child rows have first been deleted.
You can change the order or hierarchy of rows by clicking the Move this row link.

When you want to stop building the plan, click the Close build link to return to the plan list. You can continue building the plan later as required.
4.7.1.2 Copying a Plan

You can copy an existing plan rather than creating a new plan. This is useful if you are using a similar plan structure across multiple entities, such as departments or programs. Once you have copied a plan, you can edit the new plan using the Build function if you want to change certain rows or the Fields function to change the input fields.

To Copy a Plan
1. Click the Copy link next to the source plan you wish to copy
2. Edit the Title and Description. Note that you cannot have two plans with an identical title.
3. Edit the Row and Column Labels if appropriate.
4. Check Report Target if you want to allow other plans or surveys to link to this plan.
5. Check the Fields you want to copy. Note that no existing input is copied.
6. Click Submit

4.7.1.3 Plan Properties

The availability of plan, its status and cycle is controlled via the Properties function.

To Set the Properties of Plan
1. Select a Status There are three possible settings:
   - Online - the plan is available and may be edited by the assigned team members.
   - Locked - the plan is available for viewing only; it cannot be edited by the assigned team members.
   - Offline - the plan is not available; it will not appear on the list of plans for assigned team members or on the summary snapshot.
2. Add an optional Comment (this will display for each team member below the plan description field, but will not be included in any published version).
3. Start an initial Cycle for the plan. You must select a timeframe before the plan may be put online. For information about starting subsequent cycles, see Plan Settings.
4. Select a Website Template to be used for this plan (if none is available, the default template will be used). See the templates function for more detail.
5. Select a PDF Template to be used for this plan (if none is available, the default template will be used). See the templates function for more detail.
6. For a Free-form plan, you can select a Workflow Channel if available and required. Workflow channels cannot be associated with Goal-based plans.
7. Click Submit

4.7.1.4 Plan Settings

Plan Budget
You can set an overall budget for the plan in whole dollars (no cents). This will be displayed on the Summary snapshot page.
Note: Only available if plan includes a budget. See Manage plans.

Plan Cycles
Click on the Cycles link to list the current and prior cycles for this plan. Use the Edit link to change the cycle Name as appropriate.
Note: Once you have started the new cycle, assigned team members will not be able to edit information in the prior cycle, unless your system has been configured to allow this for Goal-based plans.

To move a plan to a new cycle, use the New Cycle function. You can only start a new cycle if there is a timeframe available with dates later that the current cycle. See Timeframes.

- To copy forward the content and status of any existing fields to the new cycle, check the relevant fields.
- Check the Omit if Complete parameter if you do not want those fields that are marked 'Complete' to be copied. (See below).

For fields where the Omit if Complete parameter has been checked, the system will not copy forward the content of the field. In the case of repeatable fields [R] any repeated instances of the field itself that are complete will not be copied. If the field is a parent, any child fields will also not be copied, irrespective of status.

Additional parameters are provided to determine what to copy, i.e. responses, links, files, assigned portal users.

Plan Fields
The input fields for a plan may be edited. You can add and delete fields or change the attributes of an existing field.

To Add a Field
1. Click the Add link.
2. Enter the field Name and optional Detail.
3. Select the field Type. Field types that require a selection must have parameters. See Edit a Field below.
4. Check the Attachments box if you want to allow files to be uploaded.
5. Enter a field Key (optional). Keys can be used to identify fields in spreadsheet reports.
6. Click Submit.

To Edit a Field
1. Click the Edit link next to the field.
2. Change the field attributes as appropriate.
3. Change the field Position if required. This determines the order in the list of fields.
4. Click Submit.
5. If the field requires a selection, click on the Parameter link.
6. Click the Create a Field parameter link.
7. Enter the parameter Name and optional Description.
8. Enter an answer Key (optional). Keys can be used to identify answers in spreadsheet reports.
9. Click Submit.

Published Plan Settings
Each plan may have its own set of specific attributes for the published plan website or document (PDF) format.

Note: Some of these functions may not apply to custom designed website templates.

**Document Banner**

1. Click the **Banner** link.
2. **Browse** for a suitable graphics file. This must be a GIF image file that conforms to the required dimensions. A minimum of 300dpi is recommended for good print quality.
3. Click **Submit**.

**Document Header & Footer**

1. Enter text for the **title**, **header** and **footer** as appropriate.
2. Click **Submit**.

**Preamble**

Click the Preamble function link to open the Text Editor and add an introduction to a plan in both website and PDF formats. When finished, click the Submit button and the preamble will be updated. It may be edited at any time as required.

**Website Banner**

1. Click the **Banner Upload** link.
2. **Browse** for a suitable graphics file. This should be a GIF image file that conforms to the required dimensions.
3. Click **Submit**.

   ! Images that exceed the recommended dimensions may cause problems with the tabs on the website.

**Website Header & Footer**

1. Enter text for the **header**, **sub-header** and **footer** as appropriate to appear on each website page (excluding the welcome page).
2. Click **Submit**.

**Website Locations**

The locations feature allows you to specify one or more web-server locations for your published plan. At least one location must be specified in order to publish a plan website to a web-server.

1. Click the **Create** location link.
2. Enter a **Name** for the location.
3. Enter the **Server** information. This will typically be an IP address or FTP path.
4. Enter a **Logon** and **Password**.
5. Enter a **Path**. This is a directory location on the server.
   
   Note: If you are not familiar with these settings, contact your Network Administrator.

**Website Tabs**

The standard website template format uses a tab metaphor to access the various parts of a plan. These labels can be edited if required. Check the box to enable/disable a tab.
Website Welcome Message

The home page of the plan website includes an area for a welcome message. Use the text editor to add a message.

Portal User Settings

Email Portal Users

If any rows in the plan have been assigned to portal users, you can email each of them a secure link to the plan fields.
1. Edit the email Subject if appropriate.
2. Add a Message which will appear in the body of the email. For example “Click on this link to access and update your plan input.”
3. Click Submit. The email(s) will be generated.

Import Portal Assignments

You can assign portal users to a plan via import. Follow the onscreen instructions to generate and complete the spreadsheet.

4.7.2 Plan Field Sets

The Field Set function provides a convenient tool to pre-build fields that may then be used when you create a new plan. After the plan is created, individual fields may be edited if required by using the Plan Settings > Fields function.
Note: Depending on your system configuration, certain default field sets may have been pre-loaded at the time your Xitracs system was installed or updated. You can edit or remove these if appropriate.

To Create a Field Set
1. Click Create a field set.
2. Enter a Name and optional Description for the set.
3. Select a fieldset Type (applies to goal-based plans only)
   For columnar field sets, see Column Fields below.
4. Click Submit.
   Once you have created the field set, you need to add the fields.
1. Click the Fields link next to the new set.
2. Click the Add a field link.
   If a field already exists, you can create a child field by clicking the Add link next to the existing field.
3. Enter a Name and optional Description for the field.
4. Select the field Type. This determines the type of response required.
5. Check the Allow Attachments box to allow a respondent to upload files in support of the input.
6. Enter an optional field Key if appropriate. You can use this to define a unique key value to a field for report analysis. See Reports > Spreadsheet.
7. Check **Repeatable** if a respondent can additional instances of the field.
8. Check **Optional** if a respondent can mark the field Not Applicable.
9. Click **Submit**.

*For fields that require a selection as a response, you will need to set the parameters.*

1. Click on the **Parameters** link next to the new field.
2. Click **Create** a field parameter.
3. Enter the parameter details. The details will differ depending on the parameter type.
4. Click **Submit**.
5. Add additional parameters if appropriate.

**Column Fields**

If the field set supports columns (goal-based plans only) you will be able to designate certain fields to be in contiguous columns when the plan is output to a report.

The number of columns is determined by the fieldset type and can be 3, 4 or 5 columns.

### 4.7.3 Plan Groups

Plans can be associated with a **group**, making it easier to organize and navigate plans lists. A plan can be linked to a subgroup via the Control Panel > Manage Plans > **Edit** function.

These groups and subgroups will appear when the Group view option is chosen by a user after selecting the main Plans tab.

Plans can also be associated with a **department**. The department and its parent school must first exist.

For those systems **with** the Xitracs Credentials™ module installed, Schools and Departments are managed via the Credentials > Control Panel > **Departments** function.

For those systems **without** the Xitracs Credentials™ module, Schools and Departments are managed via the Administration > System Configuration > **Departments & Schools** function.

### 4.7.4 Templates

The published format of a plan can be configured to provide a customized 'look-and-feel' using a template.

You can assign a **Website** or **PDF** template to a specific plan via the Manage plans > **Properties** function.

Website templates have a `.xtm` extension. PDF templates have a `.xtf` extension. Both can be provided by Concord as a professional service or customer developed.

**Note:** Template development requires knowledge of HTML and XSL. A design guideline document is available from Concord on request.

**To Upload a Plan Template**

1. Click the Website or PDF **Template Upload** link
2. **Browse** for a template file
3. **Edit** the template name as appropriate
4. Click **Submit**
The template name may be changed later if required by using the Edit link. To remove a template from the system, use the Delete link. If the template is already assigned to a standard, it will be replaced by the system default website template.

If the template supports image graphics, these may be changed using the Image link. Use the Replace function to upload a new JPEG image file which must have a JPG extension.

**Note:** The new image may be of any dimension, but care should be taken that the size is consistent with its position and appearance on the page when the website is rendered. This can be verified by generating a preview of the plan. If the image does not look suitable, upload a replacement.

### 4.7.5 Timeframes

This function has been replaced if the Tracks feature has been enabled on your system.

Timeframes define the period of time for a planning cycle. For example, you might create a timeframe named "2016 Fiscal" which has a timeframe of July 1, 2016 to June 30, 2017. This can then be associated with a plan using the Manage Plans > [Plan] > Properties function.

**To Create a Planning Timeframe**

1. Click the Create link.
2. Specify a Name for the timeframe. *Hint: Giving the timeframe an obvious name such as "2013-2014" might help you remember it later.*
3. Specify a Start end End date.
4. Click Submit.

Use the Edit or Delete links to change or remove a timeframe.

**! You will not be able to delete a timeframe if it is associated with a plan. Change the plan cycle first using the Properties function.**

### 4.7.6 Tracks

The Plan Tracks feature must be enabled and configured by Xitracs support.

Each plan belongs to a track which in turn is associated with timeframes. Timeframes define the period of time for a planning cycle.

By default, there are three tracks available: 1-year, 3-year and 5-year. *These can be changed by contacting Xitracs support.*

The system will automatically generate future timeframes for each track, when required.

Click the Plans link to view a list of any plans associated with a track. The Timeframes link provides a list of any timeframes associated with a track.
4.7.7 Manage Surveys

The Xitracs Survey feature lets you gather information from faculty members using a familiar survey tool. Surveys can be built with different response options, such as text input or radio button selection. Files may also be uploaded in support of a response.

*Note: Respondents must be existing faculty members.*

The control panel list of surveys will look similar to the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Available from</th>
<th>Closing date</th>
<th>Available</th>
<th>Status</th>
<th>Plan Links</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018 Department Survey</td>
<td>12/20/09</td>
<td>12/31/10</td>
<td>Yes</td>
<td>Open</td>
<td>1</td>
<td>Edit Delete Link Questions Distribute Respondents</td>
</tr>
<tr>
<td>Library Upgrade</td>
<td>5/10/09</td>
<td>12/10/09</td>
<td>no</td>
<td>Closed</td>
<td>1</td>
<td>Edit Delete Link Questions Distribute Respondents</td>
</tr>
<tr>
<td>Pregrade Improvement</td>
<td>1/1/10</td>
<td>5/15/10</td>
<td>Yes</td>
<td>Open</td>
<td>13</td>
<td>Edit Delete Link Questions Distribute Respondents</td>
</tr>
<tr>
<td>Pregrade Review Process</td>
<td>2/9/10</td>
<td>2/29/10</td>
<td>Yes</td>
<td>Open</td>
<td>0</td>
<td>Edit Delete Link Questions Distribute Respondents</td>
</tr>
</tbody>
</table>

The from and closing *Dates* columns show when the survey will be available to respondents. Outside of these dates the survey will have a status of *Closed* and will not be available.

The *Available* and *Status* columns show whether the survey will be included in a respondents survey list. *Availability is set automatically (see dates above) or can be set manually using the Edit function.*

The *Plan Links* column displays the number of plan links in the survey. *See Link to Plans below.*

The *Function* column includes links for managing and building a survey. *See below.*

**To Create a Survey**

1. Click the *Create* link.
2. Enter a *Name* and *Description* for the survey.
3. Check the box if the survey is *Available.*

*Note: This manual setting allows you to pre-build surveys and then determine availability later.*

4. Set the *From* and *Closing dates. Outside of these dates the survey will not be available to respondents.*
5. Enter any optional *Welcome text* to be displayed with the survey, if appropriate.

To change any of the above survey settings, use the *Edit* function link. To delete a survey, use the *Delete* function link.

If you want to link the entire survey click the *Link* function. To link individual survey questions, see *Building a survey.*

Once a survey has been created, you need to *build the survey* by adding *Questions.*

Once the survey is complete, you can send it to respondents by clicking the *Distribute* link. *See also Distribution Lists.*

The *Respondents* function will let you resend an email survey invitation and access other functions.

**4.7.7.1 Building a Survey**

Once survey has been *created,* you can put it together it using the Control Panel > Manage Surveys > [Survey] > *Questions* link

**To Add a Survey Question**

1. Click the *Create* link.
2. Enter the *Question* and optional *More Detail.*
3. Enter an optional *Question Key. This is a value you can enter that will be included in survey response reports, to support analysis.*
4. Select the question **Type**. Depending on the type, you may need to add selection parameters. (See Edit a Survey Question below).

5. Check the **Required** box if a respondent must answer this question in order to complete the survey.

6. If the question type is Selection, check the **Multi-Answer** box if a respondent may select more than one answer.

7. Check the **File Attachments** box if a respondent may upload one or more files in support of an answer.

8. Check the **Page-break Before** box to have the question presented on a new page.

9. Click **Submit**.

**To Edit a Survey Question**

1. Click the **Edit** link next to the question.

2. Change the question attributes as appropriate.

3. Change the question **Position** if required. *This determines the order in the list of questions.*

4. Click **Submit**.

5. If the question requires a selection, click on the **Parameter** link.

6. Click the **Create a Question parameter** link.

7. Enter the parameter **Name** and optional **Description**.

8. Enter an answer **Key** (optional). *Keys can be used to identify answers in spreadsheet reports.*

9. Click **Submit**.

You can link a survey question to a plan row if the target plan and row are configured to accept reporting links. See Control Panel > Manage plans.

**To Link a Survey Question**

1. Click **Link** next to the question.

2. Any plans that are available as targets will be listed in the drop-down.

3. **Select** a plan.

4. **Select** one or more available rows in the plan.

5. Click **Submit**.

6. Repeat to add to another plan.

   *Note: To remove a link, follow the above steps and uncheck the row(s) then click submit.*

**4.7.7.2 Distributing a Survey**

Once a survey has been built, it can be distributed by email to respondents. To do this you must have created at least one **Distribution List**.

1. Click the **Distribute** link.

2. Select the required **Distribution List** from the drop-down. *You can verify the list of respondents by clicking the Show members link.*

3. Enter a **Subject** and **Message** to be included in the email containing a link to the survey.

4. Click **Submit**. An email will be generated and sent to each of the respondents on the list.
The confirmation page will show the number of email addresses to which the survey has been sent. If there is an exception it will be shown.
For example, a duplicate email will not be sent if a respondent has already been notified by a previous email.
If you need to re-send an email to one or more of the respondents, see Control Panel > Manage Surveys > Respondents.

4.7.7.3 Linking to Plans

You can link an entire survey to a plan row if the target plan and row are configured to accept reporting links. See Control Panel > Manage plans.
If you just want to link specific survey questions see Building a Survey.

To Link a Survey
1. Click Link next to the survey.
2. Any plans that are available as targets will be listed in the drop-down.
3. Select a plan.
4. Select one or more available rows in the plan.
5. Click Submit.
6. Repeat to add to another plan.

Note: To remove a link, follow the above steps and uncheck the row(s) then click submit.

4.7.7.4 Respondents

Use the Respondents function link to list the status of each respondent and for the following actions:

- To Re-send a survey invitation email.
  Click the link to send another email invitation to the respondent.
- To Remove a respondent.
  If you remove a respondent, the survey will no longer be available to that individual.
- To display the invitation Token.
  The token is a secure link that was included in the specific respondent's invitation email. You can click on the link to verify it opens the survey correctly.

4.7.8 Portal

Email
Portal users assigned to plans can be notified by email. The settings function will let you define the default email message.
Use the variables defined between <%- %> to include this information in the body of the email. If you are including a specific sender email address, make sure that this will not be blocked by your institution's firewall.

See also portal settings for a specific plan.

Settings
Certain functions in the Portal can be enabled or disabled. Check the relevant parameter to enable or disable a function.

4.7.9 Survey Distribution Lists

Survey invitations are emailed to respondents via distribution lists of faculty members.

To Create a Distribution List
1. Click the Create link.
2. Enter a Name and Description for the list.
3. Click Submit.

Use the Edit link to change the information above or the Delete link to remove the list.

Once a list has been created, click the Members link to build and manage the list of respondents.

Use the Add link to create a list manually or the Bulk add link to paste from a separate list, e.g. from Notepad.

To Build a Member List Manually
1. Click the Add link.
2. Enter a Name. The system will automatically display name matches.
3. Select the required name.
4. Use the Enter key or click the icon. Use the icon to remove.
5. Once the list is built, click Submit.

To Build a Member List by Bulk Addition
1. Click the Bulk add link.
2. Paste a list of email addresses into the box, only one entry per line allowed.
3. Click Submit.

Note: An email addresses must match an existing faculty member or it will be rejected.

Members may subsequently be deleted from a list by clicking the Remove link.

4.7.10 Workflow

Note: This function only applies to Free-form plans. The approval workflow feature for goal-based plans is built-in.

A simple workflow feature for plans provides the ability to define steps such as 'Prepare', 'Review', and 'Approve', and select which team members are able to select a step. Workflow steps are defined within a workflow channel and a channel can then be assigned to a plan via the Manage Plans > [Plan] > Properties function.

To Create a Channel
1. Click the Create link.
2. Add a Name and optional Description
3. Check the box to make the channel available for assignment
4. Click **Submit**

Use the **Edit** link to update any of the above information

**To Add Steps to a Channel**

1. Click the **Add Step** link
2. Add a **Name** and optional **Detail**
3. Select the **Access Type**. This relates to the team type for a plan
4. Make sure that the 'None - end of flow' access type is the last step
5. Click **Submit**

Use the **Edit** link to update any of the above information
5  Xitracs Programs™

5.1 Overview

The Xitracs Programs™ module allows you to manage program assessment reporting and curriculum mapping. Used in conjunction with the Xitracs Portal™, assessment reports may be gathered easily by assigning programs to a portal user for input or peer review. Programs can belong to a group and a department, making it easier to organize them. Creating and managing a program is via the Control Panel.

Program assessments are managed in cycles, according to a time track which is specified by the institution. Three cycles are always displayed to a program assessor or peer reviewer: the Current cycle (i.e. falls within the current timeframe), Prior cycle and Next Cycle. For example, if the cycle timeframe is Jul 1 - Jun 30 and today’s date is Mar 15, 2017, then the Current cycle will be Jul 1, 2016 - Jun 30, 2017, the Prior cycle will be Jul 1, 2015 - Jun 30, 2016 and the Next cycle will be Jul 1, 2017 - Jun 30, 2018.

Input for each program assessment cycle is via fields which are defined using the Control Panel > Field Sets function. The available or open cycle for each field can be specified at the time the field set is created. In the example below, there are four fields: Goal, Objective, Result and Reflection. The Goal field in this case is set to be available for editing for the Next cycle; in other words, during the current cycle Jul 1, 2016 - Jun 30, 2017, a program assessor will be able to enter the goal for the next cycle (time frame Jul 1, 2017 - Jun 30, 2018). Similarly, a program assessor will be able to add the Reflection for the Prior cycle.

The field names in a program can be changed if this function is enabled. See Control Panel > Program Settings. This is a convenient way of having a standardized field set across multiple programs, while still providing the flexibility to change one or more field names in a specific program.

Example:

<table>
<thead>
<tr>
<th>Field</th>
<th>Available Cycle for Assessment Input</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Prior</td>
</tr>
<tr>
<td>Outcome</td>
<td>No</td>
</tr>
<tr>
<td>Objective</td>
<td>No</td>
</tr>
<tr>
<td>Result</td>
<td>No</td>
</tr>
<tr>
<td>Reflection</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The transition from one cycle to the next is managed by the system automatically, based on the specified time track. So, using the example of a Jul 1 - Jun 30 time track, on Jul 1, 2017 the Jul 1, 2016 - Jun 30, 2017 cycle will move from current to prior. A grace period can also be specified to keep fields open after the cycle availability closes. A field can also be manually locked in the portal by a manager. This is useful when you do not want a program reviewer to edit a particular field, such as a mission statement.

If the Planning Module is installed, fields may optionally be linked to one or more sections of a plan. This is a useful way of generating a plan report that includes data from one or more program assessment reports, for example to use in a program review.

Courses in a program can be defined. If the Assessment Module is installed, course assessment data can be collected and reported by semester. Program Fields may also be linked to one or more courses, for example, to show how a course is part of addressing a particular objective.
The Curriculum Mapping feature lets you manage your maps online. A map consists of a matrix which includes both outcomes and courses, together with a level such as 'Introduced' or 'Emphasized'. Both general maps and program-specific maps can be created and then linked to a program. With Outcomes Mapping, you can map course outcomes to program or GenEd outcomes.

Programs will be listed in the left menu on the page by group or department and the number of available programs will be shown. Click on the group or department link to list the programs, then click the View link to open the selected program.

5.2 Programs

5.2.1 Assess

The Programs tab opens the program coordinator/administrator view of the selected program.

By default, the fields for the Current Cycle will be displayed. Click on the Prior Cycle or Next Cycle tab to view these fields. Note that the fields themselves and their associated properties are defined in Control Panel > Field Sets.

Click on the Assess tab to open the fieldset for editing. See below for information about other tabs in this view.

The header bar shows the date range of the selected cycle. This is determined by the cycle time track defined in the system. Also in the header bar are a number of buttons:

Click the Copy button to select fields from a previous cycle. Select a cycle, then the field(s) to be copied and whether you want to include any links.

Click the Rubric button to open an available program rubric for scoring. You can also generate a snapshot view of program rubric scores by assessor, peer and coordinator by clicking the Rubric Report button.
Click the **Settings** button to change the workflow status (if enabled) or to toggle whether a program assessment reporting cycle is to be skipped.

If a program rubric has been defined and assigned to this program type, click the **Rubric** button to open for scoring.
You can also generate a snapshot view of program rubric scores by assessor, peer and coordinator by clicking the **Rubric Report** button.

In the example above, the field set consists of three main (or top-level) fields: 'Program Mission', 'Outcome' and 'Reflection'. Under the field 'Outcome', there is a sub-field 'Objective', which in turn has sub-fields 'Assessment', 'Metric' and 'Result'. See also the **Labels** tab function which lets you change the field name. If the Labels function is enabled, an additional tab is displayed.

If the fieldset has been configured to include a **Workflow** function, the current status is displayed. This can be updated using the **Settings** button.
If the fieldset includes an Outcome field, a link is available to toggle between an **outcome fields only view** or an **all fields view**.

If a field has been configured to be open for editing in another cycle, a lock icon will appear with a letter indicating the applicable cycle: 'P' for Prior, 'C' for Current and 'N' for Next. The Reflection field above shows the lock icon with the letter P; this means the field can be edited by portal users only for the prior cycle. An 'M' lock code indicates that the field has been manually locked, meaning that it cannot be edited by an assessor in this cycle.

**Editing Fields**
Click anywhere on the field header to open it for editing. You can also use the **Expand All** button in the header bar to open all fields. Once open, any existing field content will be visible, together with available links as follows:

**Outcomes**
Click the **+Program** or **+GenEd** button to select and add an available outcome to the list of fields.
*Note: The Field Set must contain an outcome field for these buttons to be enabled.*

**Settings**
Click to mark the field as 'Complete' or 'Not applicable' (if allowed in the field set parameters). You may also lock a field in the portal or, if the field is locked by the cycle, override the cycle lockout.
*Note: The Settings link is not available to Portal users.*

**Add new**
This link appears if the field set parameters allow an additional field of the same type to be created; for example, to add a new Goal. If the field has dependent or 'child' fields, these will also be added and the numbering updated automatically.

**Edit**
Click this link to edit/update the response for a field. The format of the response will depend on the field type, e.g. text, a number, selection from a drop-down etc. The field type is part of the field set parameters. You can also enter a **short name**, unless the field is an Outcome, (see below). If the field has been configured with the **Autocode** parameter (text and rich-text fields only), a unique code consisting of the cycle start year and a sequence number will be generated and displayed with the field name. Fields with
a code can optionally be linked to a another coded field in a previous cycle (see Link function below). Autocodes are useful for downstream analysis of field data.

Copy
You can copy a response from a previous cycle. Select a cycle, then the field to be copied and whether you want to include any links.

Course
This link appears if the field set parameters allow supporting courses to be added as part of a response; for example, to indicate that a course addresses an objective. The courses available are those belonging to the program. See Control Panel > Manage Programs > Courses.

File
This link appears if the field set parameters allow supporting files to be added as part of a response.

Link
For systems with the Planning Module installed, you can link a field that has the link option enabled to a section of a plan. The plan sections available are dependent on those plans that have been set up to support reporting links. See Manage Plans > Building a Plan for more details. The linked program review data can then be output as part of publishing a plan. Note: if the field is a Program Outcome you cannot link it to another program outcomes. However, you can link it to a GenEd or external outcome. If an autocode has been generated for a field, click the Field link to select an available coded field in a previous cycle.

Tag
You can add a tag consisting of one or more words. As you type, the system will auto-search to list any existing tags. The tags are used to generate a word cloud based on the frequency in the review cycles.

Comment
Program coordinators, assessors and peer reviewers can add in-line comments. If the field has been set to include a Result (e.g. Approved) you will also be able to select this option when adding a comment.

5.2.2 Assign
Portal users can be assigned as an Assessor, or Peer Reviewer/Approver or Viewer.

- An Assessor has the ability to input information (i.e. write the assessment report)
- Peer Reviewer/Approver can view reports in progress but can provide feedback using the Comments function and approve reports if the workflow feature is enabled.
- A Viewer can only view reports in progress.

While a portal user cannot have different assignments in the same program, these may differ in other programs. e.g. an Assessor in Program A and a Viewer in Program B.

If a field has the Result parameter set, a peer reviewer can also set a status when entering a comment, such as Approved.

Select a portal user to assign to the program. Check the ‘email immediately’ box to advise assignees by email. Use the Resend link to send a reminder email.
If the workflow feature is enabled, approval request emails will also be generated.

Assignees can also be imported. See the Xitracs Data Import Guide.

**Role Assignment**

If your system has the program roles function enabled and roles exist, portal users can be assigned, for example as a "Program Coordinator".

The start and end date for a user role can be defined as appropriate. If set, this will determine whether a user appears in the program roles report for a selected timeframe.

A comment may optionally be added to a user assignment. This will then be included in the report.

### 5.2.3 Report

A report of the program assessment can be generated. Select the cycles to be included and the format. If a PDF format is selected, an option to provide a side-by-side view of the selected cycles will be available. Attachments may also be included as part of a PDF file which is opened with Adobe Reader. Note that these attachments will be listed in the Adobe Reader navigation pane. Hyperlinks to these items are not supported.

If the Website option is selected, the report may be downloaded including all attachments with active hyperlinks. The download is a compressed .zip file which must be unzipped when the download is complete.

The report presentation format, including the banner graphic, can be customized via a template. See Control Panel > Templates.

Click the Reporting schedule link to define in which cycle an outcome should be assessed. The outcomes listed will be those defined for the program (program outcomes) plus any GenEd outcomes that you optionally add to the reporting schedule. Any program outcomes that have been set to ‘Inactive’ are listed at the bottom and marked as ‘Inactive’ [In].

In the schedule view, define the cycle in which an outcome is to be assessed by selecting the Report parameter.

### 5.2.4 Archive

Prior review reports from other systems can be stored in the system. The archive function lets you add these report files so that they can be managed within the context of the program in Xitracs.

Use the Folder function to create categories of reports. Archive items can consist of files or URL links.

### 5.2.5 Assessments

For those systems where the Assessment module is installed, you can generate an assessment report from selected semesters.

This tab can also be enabled or disabled via the Control Panel. See Program Settings > Options.

The PDF report may optionally be added as an artifact to selected field in the current reporting cycle. *Note that the target field must be configured to support file attachments.*
5.2.6 Feedback

Program coordinators and Portal users who are assigned as peer reviewers can input comments. Select the period of feedback information you wish to view.

5.2.7 Labels

The field names in a program can be changed if this function is enabled. See Control Panel > Program Settings. This is a convenient way of having a standardized field set across multiple programs, while still providing the flexibility to change one or more field names in a specific program.

Click on the Edit link for the field name you wish to change. Enter a new label value up to a maximum of 60 characters, including spaces.

The field name will now change to reflect this new label.

Note: This function is not available to Portal users.

5.2.8 Outcomes

By default, System users can add, edit or delete program outcomes. This function is also available to Portal users if the relevant parameter in the Control Panel is set.

The fieldset associated with the program must contain an outcome field to enable a program assessor to select from a list of available program and/or GenEd outcomes when editing the assessment report.

A program outcome may be set to Inactive. Inactive outcomes will no longer be available for selection and inclusion in a program assessment report. It does not affect any outcomes already included in a reporting cycle.

Note: Program Outcomes may also be imported via the Control Panel. See the Xitracs Data Import Guide.

5.2.9 Tags

The tags used in a specific assessment cycle can be viewed in word cloud format. This is an easy way of seeing the most commonly used terms in an assessment cycle. See also Administration > Manage Tags.

Note: The Tags tab can be disabled if required by a Xitracs Support technician. Contact Concord if you want this tab enabled or disabled.

5.2.10 Workflow

If the approval parameter is enabled for a program assessment field set, a workflow function will be enabled for any programs using that field set.

The workflow consists of 4 steps:
1. In preparation
2. Approval requested
3. Reviewed with comments
4. Approved
A program will start in Step 1. When ready, a portal user assigned as an Assessor (i.e. to write the assessment report) can change the workflow to Step 2. At this point, an email is generated to any portal user assigned as a Peer Reviewer. The peer reviewer can then set the workflow to Step 3 or 4, at which point an email is generated to the Assessor.

Program administrators/ coordinators can set any workflow step by clicking the Settings button in the Assessment view.

5.3 Search

5.3.1 Program Search

You can search across programs using one or more keywords. For example, enter the term "graduation rates" and the system will search for any programs where the response text and/or field short name matches the term.

Use the filters to narrow the search to include specific fields, groups, cycles or program types. The Course filter lets you select only those fields that are linked to a specific course. When you enter a course, the system will auto-search only for those courses that have been added to the program.

5.4 Summary

5.4.1 Program Snapshot

The program snapshot provides a graphical overview of the state of response completion for active programs by group. Completion percentages are shown for the Prior, Current and Next cycles for each program. Click on a progress bar to go to the assessment page for the selected cycle. If a program cycle has been set as skipped it will be displayed as Not Reported in the progress bar.

The Last Update column shows the date of the most recent assessment input. Click on the date to open the log. Information about the number of assessors and peers assigned to the program, plus plan, course and maps links, are also provided.

The Outcomes column displays the number of program outcomes (if defined). Click on this cell to view a list of these outcomes.

The Courses column displays the number of courses linked to the program (if defined). Click on this cell to view a list of these courses, by type and availability.

<table>
<thead>
<tr>
<th>Arts</th>
<th>Progress</th>
<th>Linked Resources</th>
<th>Assignments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literature [1]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>English</td>
<td>Prior</td>
<td>Current</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modern Languages [2]</td>
<td>No programs online</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Engineering</th>
<th>Progress</th>
<th>Linked Resources</th>
<th>Assignments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanical Engineering [2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Civil Engineering</td>
<td>Prior</td>
<td>Current</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mechanical Engineering</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Maps column displays "Y" if there are curriculum maps associated with the program.
The Assignments column display the number of assessors and peers assigned to the program.
5.5 Maps

5.5.1 Curriculum & Outcome Maps

Curriculum Maps

You can create and manage curriculum maps for a program and then map outcomes to courses with a level.

Curriculum maps consist of a set of rows and columns. In the default layout, the rows are the courses that are in a program, while the columns are the outcomes.

A map might look similar to the following example:

At the intersect of a course and an outcome, there is a cell where the level can be selected. Levels are defined using the Control Panel > Curriculum Maps > Map Levels function.

To View or Create a curriculum map, select a program group or department from the left menu and the select the Curriculum maps function link next to a program.

To Create a Curriculum Map

1. Click on the Create a new map link
2. Give the map a Name and Description
3. Select whether the map is to be created from the program outcomes or is to be an empty map
4. If an empty map, select the number of columns to include
5. Edit the Column label if desired (the default label is Outcome)
6. Edit the Row label if desired (the default label is Course)
7. Select the Level to be used
8. Click Submit and the new map will open

Once a map is open, click on the link in each cell to update the level, as required.

If the map was created from program outcomes (see step 3 above), you will not be able to delete these outcome columns unless the program outcome has been set to Inactive and displays the [Inactive] tag.

If the map was empty when it was created (see step 3 above), you can edit the column headers by clicking the edit icon. You can also remove column headers by clicking the delete icon.
In both types of map you can add GenEd outcomes by clicking the Add GenEd outcomes link. Select the outcomes group, set and the outcome you wish to add.

Courses are displayed in the first row, with links to the course details, course outcomes and course syllabus. In both types of map you can remove courses by clicking the delete icon. You can also add program courses that may not appear in the map by clicking the Courses link. This function will check to see if any courses have been added to the program since the map was created.

Close the map to return to a list of maps for the program. Click the Report link to output the map, including outcomes and course information.

Click the Edit link to set the status of a map, e.g. 'Under construction' or 'Current'.

**Outcome Assessment Maps**

For systems with the Xitracs Assessment module installed, you can generate a map showing where outcomes are assessed in a program. The map reflects the links that are defined in Assessment > Courses > Outcomes.

**Outcome Reporting Maps**

You can specify in which reporting cycle a specific program or GenEd outcome should be assessed by going to Programs > [Program] > Report tab > Reporting map.

5.6 **Self-Study**

On systems with the Program Review feature enabled, the Self-study tab will be available.

5.7 **Reports**

5.7.1 **Program Reports**

The Reports tab lists available output and exception reports, categorized by Courses, Maps, People and Programs.

Click on the View link next to a report, then select any relevant filters including the output format.

**Roles Report**

If program roles exist, a report will be available
5.8 Control Panel

5.8.1 Field Sets

**Program Assessment Field Sets**
The Field Set function provides the tool to build assessment fields that may then be used to assess a program. Assigning a field set to a program occurs when the program is started.

**Important**
A program assessment field set should normally include one field that is the Learning Outcome (see step 3 below). This is to allow an assessor to select from the available outcomes in an assessment cycle.

Only one field in the set should be the outcome.

To Create a Program Assessment Field Set
1. Click **Create** a field set.
2. Enter a **Name** and optional **Description** for the set.
3. Select the field-set **Type**: List, 3 Column, 4 Column or 5 Column. This determines the layout when the report is generated.
   *For a columnar fieldset, refer to the instructions below.*
4. Check whether the field set is to be **available**, i.e. selectable when a new program is created.
5. Click **Submit**.

Once you have created the field set, you now need to add the fields.
1. Click the **Fields** link next to the new set.
2. Click the **Add** a field link.
3. If the field is a **Learning Outcome**, check the outcome parameter.
   *If a field is an outcome, the assessor will be able to select and add an available outcome.*
   *The Edit box for an outcome field can be disabled. See Control Panel > Program Settings. Note this is a global setting for all fieldsets.*
4. Enter a **Name** and optional **Description** for the field.
5. Select the field **Type**. This determines the type of response required. *(Defaults to Text if the field is a program outcome - see above).*
6. Check the **Allow Attachments** box to allow a respondent to upload files in support of the input.
7. Select whether a field will be **Repeatable**. If selected, respondent will be able to create other instances of the field, e.g. create a new objective.
   *If a repeatable field has child rows, these will also be repeated. In the example below, creating an new objective will also create an associated Outcome, Metric and Result field.*
8. Check the **Links** box to allow a respondent to link a Program Outcome, External Outcome, GenEd Outcome or Plan (if the Planning Module is installed) to the field.
   *If a field is a program outcome (see 3 above), the respondent will not be able to link to another program outcome or link a GenEd outcome to another GenEd outcome.*
   If the Links option is checked and the field is not a Learning Outcome, you can optionally check the **Link-only field** parameter. In this case, no Edit function is provided in the portal.
9. Check the **Approval Status** box to allow a peer reviewer to select a status (e.g. Approved) for a field. *(See below re specifying status selections)*
10. Check the **Courses** box to allow a respondent to link a program course to the field. See also **Course Field Sets** below.
11. Enter an optional field **Key** if appropriate. You can use this to define a unique key value to a field for report analysis when output is to a spreadsheet.

12. Check the **Optional** box if a respondent can mark the field as Not Applicable.

13. Select the **Assessment Cycle** to which the input relates, and in which the field will be open to respondents. (See also **Next Cycle** parameter setting below).

   *In the example below, Field 7 Reflection is set to be open for input to the prior cycle, so this data can be added after the cycle has closed.*

14. If the autocode feature is enabled on your system, check the **Autocode** parameter if you want the system to generate a unique code when this field is first edited.

   *Available for text and rich-text fields only*

15. If the metric feature is enabled on your system, check the **Metric** parameter if you want the system to store the field value as a metric.

   *Available for numeric and percentage fields only*

16. Click **Submit**.

   To create a child field, click the **Add** link next to an existing field. See **Goal** and **Objective** in the example below.

<table>
<thead>
<tr>
<th>#</th>
<th>Field Name &amp; Detail</th>
<th>Type</th>
<th>Repeatable</th>
<th>Assessment Cycle</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Program Mission</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>2</td>
<td>Outcome</td>
<td>Outcome</td>
<td>No</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>3</td>
<td>Objective</td>
<td>Rich text</td>
<td>Yes</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>4</td>
<td>Assessment</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>5</td>
<td>Assessment Method</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>6</td>
<td>Metric</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>7</td>
<td>Result</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Edit Add Delete</td>
</tr>
<tr>
<td>8</td>
<td>Reflection</td>
<td>Text</td>
<td>No</td>
<td>Prior</td>
<td>Edit Add Delete</td>
</tr>
</tbody>
</table>

*Note: A Rich text field type includes a text editor in the response entry area.*

For fields that require a selection as a response, you will need to set the parameters.
1. Click on the **Parameters** link next to the new field.
2. Click **Create** a field parameter.
3. Enter the parameter details. The details will differ depending on the parameter type.
4. Click **Submit**.
5. Add additional parameters if appropriate.

⚠️ **Caution!** Deleting a field will remove the field and associated response data from all cycles. Use the range function instead (see below).

**Field Range Setting**

If your Xitracs system supports the program field range function, you will be able to set the start and/or end cycle for a field.

Fields will only appear when they are within a designated range.

*Contact Xitracs Support if this feature is no enabled on your system.*

To set a range
1. Click on the **Range** link next to the relevant field
2. Select the start and/or end cycle(s)
3. Click Submit

If you select a parent field that has children (for example Field #3 below), the child fields will be included in any range setting.

<table>
<thead>
<tr>
<th>#</th>
<th>Field Name &amp; Detail</th>
<th>Type</th>
<th>Repeatable</th>
<th>Assessment Cycle</th>
<th>Range Start</th>
<th>Range End</th>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Program Mission</td>
<td>Rich text</td>
<td>No</td>
<td>Current</td>
<td>#5 1/1/2019</td>
<td>Not set</td>
<td>Not started</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>2</td>
<td>Outcome</td>
<td>Learning Outcome</td>
<td>No</td>
<td>Current</td>
<td>Not set</td>
<td>Not set</td>
<td>Active</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>3</td>
<td>Objective</td>
<td>Rich text</td>
<td>Yes</td>
<td>Current</td>
<td>Not set</td>
<td>Not set</td>
<td>Active</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>4</td>
<td>Assessment</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Not set</td>
<td>Not set</td>
<td>Active</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>5</td>
<td>Assessment Method</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>Not set</td>
<td>Not set</td>
<td>Active</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>6</td>
<td>Matrix</td>
<td>Number</td>
<td>No</td>
<td>Current</td>
<td>Not set</td>
<td>Not set</td>
<td>Active</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>7</td>
<td>Result</td>
<td>Number</td>
<td>No</td>
<td>Current</td>
<td>Not set</td>
<td>Not set</td>
<td>Active</td>
<td>Edit Add Delete Range</td>
</tr>
<tr>
<td>8</td>
<td>Reflection</td>
<td>Text</td>
<td>No</td>
<td>Current</td>
<td>#5 1/1/2016</td>
<td>#6 12/31/2017</td>
<td>Expired</td>
<td>Edit Add Delete Range</td>
</tr>
</tbody>
</table>

Other Program Field Set Options

Click the Edit link next to a program field set to select additional options.
1. Check the Next Cycle parameter to have fields in this cycle always open.
2. Check the Approval parameter to enable the Peer Reviewer approval workflow feature for this field set.

Field Approval Status

A field Approval Status may be specified, such that a peer reviewer can set a field status (e.g. Approved) using the Comments function in the portal.
1. In the Manage Program Assessment Field Sets view, click the Manage field-level approvals link.
2. Add or Edit status options as required.
3. Check the Successful parameter if a status option is to be marked as successful (e.g. Approved).
4. Click Submit.

Columnar Field Set

With a columnar fieldset you can output specific contiguous fields under a learning outcome field in 3, 4 or 5 columns.

Course Link Field Sets

Course Link Field Sets provide a simple way to enter course data in the context of a program, when a course has been linked to a specific program field such as a goal or objective.

To Create Field Set
1. Click Create a field set.
2. Enter a Name and optional Description for the set.
3. Check whether the field set is to be available, i.e. selectable when a new program is created.
4. Click Submit.
   Once you have created the field set, you now need to add the fields.
1. Click the Fields link next to the new set.
2. Click the Add a field link.
3. Enter a Name and optional Description for the field.
4. Select the field Type. This determines the type of response required.

   Note: Course Outcome Fields can be either a Number or Percentage type.

5. Click Submit.

5.8.2 Manage Programs

The Manage Programs function allows a manager with control panel access or system administrator to create and activate programs.

Before you start to create programs, make sure you have first defined the field set(s) and groups you plan to use.

To assign a program to a department, the corresponding schools and departments must exist in the system. For systems with the Credentials module installed, see Credentials > Control Panel > Manage Departments. Otherwise, see Administration > System Configuration > Departments & Schools.

If you are linking courses to a program, these must already exist in the system. For systems with the Credentials module installed, see Credentials > Control Panel > Course Catalog. Otherwise, see Administration > System Configuration > Courses.

If you are linking disciplines to a program, these must already exist in the system. For systems with the Credentials module installed, see Credentials > Control Panel > Disciplines. Otherwise, see Administration > System Configuration > Disciplines.

To Create a New Program

1. Click the Create a new program link.
2. Enter a plan Name and Description. The name must be unique. You will receive an alert message if you enter a name that is already in use.
3. Select a program Type
4. Select a program Group
5. Select a School and then select a Department (if available). To assign these values, they must already exist in the system. See above.
6. Select a Discipline (Optional). To assign this value, disciplines must already exist in the system. See above.
7. Click Submit

As you add programs the list will look similar to the following:
The **Properties** link lets you control the status of a program, e.g. Online. You can also optionally set a program start date and terminate a program. Terminated programs will remain visible, but can no longer be edited unless an override parameter is set. Note that the override applies to system users only.

The **Outcomes** link lets you define and/or edit the program outcomes. An outcome can be linked to a field in an assessment field set.

Use the **Courses** link to add courses to the program. *These must already exist in the system. See above.* A course can be added using the search function and then adding it to the list. Note that a list must be of courses that are of the same course type. Also, once a course has been added, you can use the **Edit** link to change the course type.

The **Settings** function allows you to add or edit certain program-specific information. See **Program Settings**.

Once you are ready for the program to be activated, click the **Properties > Start** link. You will then be able to select the **Program Field Set** and **Course Link Field Set** (if applicable) to be used.

⚠️ When you start a program make sure you have selected the correct field set(s). You will not be able to change these once started.

### 5.8.3 Maps

Certain parameters for curriculum maps and outcome maps can be set.

**Course Types**

The type of course within a program can be defined. The default type is **Core**. Non-core selectable values are Elective and GenEd. Use the **Edit** link to change a type or the **Create** link to add new types. To assign a type to a course, see Control Panel > Manage Programs > Courses > [Course] > **Edit**. Course types (core versus non-core) determine which outcome map a course will belong to.

**Map Levels**

The Map Level function creates the list of mapping levels that may be selected when updating a curriculum map. Any number of lists may be created. Use the **Values** link to specify the drop-down selections that will be used when updating a map.

### 5.8.4 Outcomes

Outcomes, sometimes referred to as **Learning Outcomes** or **Student Learning Outcomes** can exist in Xitracs at various levels:

Outcomes are active and available for selection by default. You can set an outcome to inactive by clicking the **Edit** link. The outcome will remain visible, but can no longer be selected.

Optionally, set an **Inactive Date** for informational purposes. Inactive outcomes have an indicator [I] next to the outcome label.
Program Outcomes
Outcomes can be defined for each program. These can be manually added or imported. See the Xitracs Data Import Guide.

To Add a Program Outcome
1. Click the Outcomes link for the relevant program
2. Click Add an Outcome
3. Enter a short Label for the outcome and a description
4. Enter an optional Outcome Code
5. Click Submit

The Outcome Code field is optional and provided to make it easier to identify the outcome in certain reports.

Use the Edit and Delete link to update or remove an outcome.

GenEd & External Outcomes
Outcomes, other than those defined specifically for a program, can also be created. These outcomes may be GenEd (institution internal) or External (e.g. agency defined).

GenEd and external outcomes are managed in Outcome Sets, which in turn are managed in Outcome Groups.
A GenEd or external outcome can be linked to a field in an assessment field set. A GenEd outcome can also be included in a Curriculum Map.

You can create one or more Outcome Sets for a selected group. For example, under an external outcome group you might create two sets, "ABET Engineering 2017" and "ABET Computer 2017".

Click the Outcomes link to add or edit the appropriate outcomes to each set.

Course Outcomes
See Credentials > Course Catalog. Note that for systems where the Credentials module is not installed, this catalog information is managed via Administration > System Configuration > Courses. Each course is then mapped to the relevant program(s). See Programs > Control Panel > Manage Programs > [Program] > Courses.

5.8.5 Portal

Email Message
Portal users assigned to programs can be notified by email. The settings function will let you define the default email message.
Use the variables defined between <%%> to include this information in the body of the email. If you are including a specific sender email address, make sure that this will not be blocked by your institution's firewall.

Send Email
You can send an email to some or all program assignees.
Use the variables defined between <%%> to include this information in the body of the email.
Settings
Check the relevant parameter to control what information and which functions are available to Portal users.

5.8.6 Program CIP Codes

! This function requires the CIP-code feature license.

CIP codes can be added to programs via file import. Refer to the Xitracs Data Import Guide for more information.

One or more CIP codes can also be added on-screen to a program. See Program Settings.

5.8.7 Program Groups

Programs can be associated with a group, making it easier to organize and navigate program lists, for example, into academic and non-academic programs. A program can be linked to a subgroup via the Control Panel > Manage Programs > Edit function.

These groups and subgroups will appear when the Group view option is chosen by a user after selecting the main Programs tab.

5.8.8 Program Rubrics & Templates

Program Rubrics can be created on-screen or imported using an Excel® spreadsheet.

Note: These rubrics apply at the Program Level and provide a means for assessors, peers and program coordinators to score the quality of an assessment report. If the Assessment module is installed, rubrics can be defined and scored at the outcome level.

To Create a Program Rubric Manually

1. Click the Create rubric link
2. Enter a Name and Description for the rubric
3. Optionally, change the Row (criterion) label
4. Enter the number of Criteria (Rows)
5. Optionally, change the Column (level) label
6. Enter the number of Levels (columns)
7. Click Submit
8. An empty rubric with the selected number rows and columns will open
9. Click on a column or row label to edit the information and add an optional weight
10. Click on a cell to edit the rubric
11. Click the Close link to finish (you will be able to return by clicking the View link in the list of rubrics)

To Create a Rubric using MS Excel®
1. Add the text you want to appear as **Levels** in cells A2, A3, A4 and so on. Optionally, include a weight in square brackets [ ] at the end of the text. If no weight is included, a value of 1 is assumed.

2. Add the text you want to appear as **Criteria** in cells B1, C1, D1 and so on. Optionally, include a weight in square brackets [ ] at the end of the text. If no weight is included, a value of 1 is assumed.

3. Add the text you want to appear as the rubric in the appropriate cells, e.g. B2, C2 and so on.

4. **Save** the file, e.g. myRubric.xls, to a folder on your workstation.

**Example**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Content and purpose</td>
<td>Exceptionally effective for purpose, consideration, and alignment; exceptional audience adaptation</td>
<td>Adequate content, appropriate for purpose, consideration, and alignment; some audience adaptation evident</td>
<td>Content was inappropriate for the purpose, consideration, and alignment; minimal adaptation to the audience</td>
<td>Failed to meet assignment purpose; no adaptation for audience/consideration, language, knowledge, properties, cultural awareness</td>
</tr>
<tr>
<td>3</td>
<td>Organisation</td>
<td>Exceptionally clear organizational patterns, easily followed</td>
<td>Mostly organized and logical organization, logical progression of ideas, some unity of thought</td>
<td>Organisation is lacking; information is scattered, does not follow assignment structure, lack of unity in thought</td>
<td>No evident structure; repetitive ideas; impossible to follow</td>
</tr>
<tr>
<td>4</td>
<td>Central message</td>
<td>Exceptional use of information ideas/research examples that support the central ideas and main points</td>
<td>Some clarifying information ideas/research examples which support the central ideas and main points</td>
<td>Lack of information ideas/research examples that support the central ideas and main points</td>
<td>No data provided; information ideas/research examples fail to support the central ideas and main points</td>
</tr>
<tr>
<td>5</td>
<td>Contact, links, and oral communications</td>
<td>Information is conveyed in a clear, appropriate manner; Organisation, grammar, and format are used throughout</td>
<td>Information is conveyed in a clear, appropriate manner; Organisation, grammar, and format are used throughout</td>
<td>Information is conveyed in a manner that is somewhat unclear and difficult to follow; Organisation, grammar, and format are often incorrect and non-coherent</td>
<td>Information is conveyed in an unclear, inappropriate manner; text is difficult to follow; Organisation, grammar, and format are overall incorrect</td>
</tr>
<tr>
<td>6</td>
<td>Quality of sources</td>
<td>Appropriate; the use of sources is used; Sources are correctly cited</td>
<td>Appropriate sources of information are used; Sources are correctly cited</td>
<td>Most information sources are not appropriate or reliable; Sources are partially or incorrectly cited</td>
<td>Information sources may not have been used or may be inappropriate; Sources are incorrectly cited or not used at all</td>
</tr>
</tbody>
</table>

When you are ready to deploy a rubric, click the **Edit** link in the list of rubrics and check the **Available** parameter.

You can also control how a rubric can be used and reported by an assessor and peer reviewer.

To assign a program rubric see **Settings > Rubrics**.

**Manage Templates**

The format of a **program report** can be configured to provide a customized 'look-and-feel' using a template.

You can assign the **Website** or **PDF** template to be used for all programs by using the **Edit** link and setting the template as **Active**.

Website templates have a .xtm extension. PDF templates have a .xtf extension. Both can be provided by Concord as a professional service or customer developed.

**Note:** Template development requires knowledge of HTML and XSL. A design guideline document is available from Concord on request.

**To Upload a Plan Template**

1. Click the Website or PDF **Template Upload** link
2. **Browse** for a template file
3. **Edit** the template name as appropriate
4. Click **Submit**

The template name may be changed later if required by using the **Edit** link.
To remove a template from the system, use the **Delete** link. If the template is already assigned to a standard, it will be replaced by the system default website template.

If the template supports image graphics such as a banner, these may be changed using the **Image** link. Use the **Replace** function to upload a new JPEG image file which must have a .jpg extension.

*Note: The new image may be of any dimension, but care should be taken that the size is consistent with its position and appearance on the page when the report is rendered.*

### 5.8.9 Program Properties

Set the program status by selecting the relevant parameter:

**Started**
If a start date already exists in the system, it will display in the calendar view. If not, the calendar view will display today's date.
You can set or change the start date by updating the calendar and selecting the **Update** checkbox.

**Online**
Set a program to online to make it active and available to all assigned users.

**Terminated**
Set a program to terminated to make it inactive but still available for viewing and reporting.
Terminated programs may be edited by system users if the relevant option is set. See Program Settings.

**Offline**
Set a program to offline to make it inactive and unavailable to all assigned users.

### 5.8.10 Program Settings

**Options**
Check the parameter to allow editing of **terminated programs**. (This function is not available to portal users).

Check the parameter to allow the **re-labeling of fields** in the **assessment** view. (This function is not available to portal users).

Check the parameter to disable the Edit Box for a **field that is an Outcome**. This is a global setting and applies to all fieldsets.

Check the parameter to enable/disable the **Assessment** tab in the system user view.

Check the parameter to enable auto-update of status for any child fields. When enabled, a user may automatically update the status of any **fields** that are children of a parent field.

**Program Detail**

Additional information can be added to each program, for example to include information such as program start and end dates.
Specify the relevant field type. If the field type is **Selection**, use the Parameters link to define the available drop-down selections.

Once the fields are created, you can add the relevant information to each program by using the Manage Programs > [Program] > Settings > **Extended detail function**.

*Note: Any Start and End dates specified in the program detail are for information purposes only. Dates set here do not affect program availability. See Program Properties.*

**CIP Codes**

One or more CIP codes can be added to a program. Requires the **CIP code feature**. These codes can also be imported into existing programs.

**Rubrics**

You can specify the **Rubric** to be used for program-level assessment, depending on the **Type** of program. For each program type, choose the rubric to be assigned from the available list. Use the **View Selection** link to view a selected rubric.

**Roles**

Program roles can be defined, for example "Program Coordinator". Portal users can then be **assigned by role** to a program, with start and end dates as appropriate. See also, **program roles report**.

*Note: Role names are globally unique. If the Credentials module is installed and the role name is already in use, it cannot be used as a program role.*

**Student Enrollment Types**

For system where the Assessment module is installed, the types of student enrollment can be specified. The defaults are Major, Minor and Concentration. These can be changed and/or added to.

**5.8.11 Program Time Track**

Program assessments are managed in cycles which follow a specified time track. A time track must be defined with a cycle length and initial start date.

Each program will follow the assigned time track and the system will automatically open and close fields as they move from **Next** to **Current** or **Current** to **Prior** cycles. A new cycle is generated by the system automatically when it is required.

Before any program can be **started**, the time track must exist.

**To Create a Time Track**

1. Click the **Create a Track** link
2. Enter a **Name** for the track
3. Specify the **Cycle Length**, e.g. 1 Year
4. Select the **Initial Start Date**
5. Click **Submit**

The cycle length and initial start date parameters are used by the system to determine when each cycle will start and end. For example, if you specify a cycle length of one year with an initial start date of July 1, 2013, the system will determine that the initial cycle will close on June 30, 2014 and the subsequent cycle will then start July 1, 2014 and so on. Note that cycles are contiguous, so a six-month cycle length with an initial start date of July 1, 2013 will close on December 31, 2013 with the subsequent cycle starting on January 1, 2014 and closing on June 30, 2014.

To add cycles for earlier time periods, simply set the initial start date with an earlier year, e.g. July 1, 2012.

Important! Once the time track has been created, you will not be able to change the cycle length or initial start date. Contact Xitracs Support by opening a trouble ticket if you think you have created a time track with wrong parameters.

Click the **Cycles** link to view a list of the cycles that exist for the track.

The **Grace period** link lets you enter a length of time for which the fields will remain open to the assigned assessor(s) after a cycle as ended.

If you need an additional time track, for example, because the timeframe for non-academic programs is different, contact Xitracs support to have this enabled.

### 5.8.12 Program Types

You can categorize programs into types, e.g. Undergraduate, Graduate. These types can then be used as filters in Programs > **Reports**. The program type can also be used to determine which **rubric** will be assigned.
6 Xitracs Standards™

6.1 Overview

The Xitracs Standards™ module provides you with all the tools you need to prepare, manage and publish an agency compliance report.

Click on the Agencies tab to go to a list of agency standards available to you. The availability is determined by your membership of one or more teams.

If your standards list is empty or a particular standard is not listed, it is typically due to either: (1) you are not a member of any team or (2) you are a member of a team, but the team has not been assigned to any sections of the standard or (3) the standard has been set to Offline.

See the Teams function for further information about how to assign team members and Properties about how to set the status of a standard.

The list consists of Active Standards and optionally Retrieved Standards (see below) and will look similar to the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Version</th>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AACSB-BUS</td>
<td>AACSB Standards for Business Accreditation</td>
<td>2008</td>
<td>Online</td>
<td>Edit Evidence Other Preview Publish</td>
</tr>
<tr>
<td>CCNE</td>
<td>Commission on Collegiate Nursing Education</td>
<td>2011</td>
<td>Response</td>
<td>Edit Evidence Other Preview Publish</td>
</tr>
<tr>
<td>SACS</td>
<td>Southern Association of Colleges &amp; Schools</td>
<td>2011</td>
<td>Online</td>
<td>Edit Evidence Other Preview Publish</td>
</tr>
</tbody>
</table>

These are retrieved standards. They may be viewed but cannot be edited.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Version</th>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SACS</td>
<td>Southern Association of Colleges &amp; Schools</td>
<td>2008</td>
<td>View only</td>
<td>View</td>
</tr>
</tbody>
</table>

The Title and Description identify the accrediting agency that has published the standard.

The Version is the particular version of a standard as published by the respective agency.

The Status indicates the current state of the standard. This is managed via Control Panel > Manage Standards > Properties.

- Online - the standard is available for editing by assigned team members
- Response - the standard is in response mode. Only reports or responses may be added or edited and original narratives and evidence are locked. The number in parenthesis indicates the response cycle.
- Locked - the standard can be viewed by assigned team members but cannot be edited. If the standard is locked while in a response cycle, the number of the cycle will appear in parenthesis.

The Function column contains a number of links which will take the user to an operation in the Xitracs system. Availability of these links is determined by the type of team that you belong to for a specific standard. See the next section to understand how these functions work.

The list of standards may also include Retrieved Standards. These are standards that have previously been backed up by the System Administrator and are no longer active. You can only view a retrieved standard and it cannot be edited. The purpose of the retrieved standards list is to allow users to view a prior instance of a standards template, for example, to view or copy information.
6.2 Agencies

6.2.1 Project Summary

A project summary page is generated automatically for each agency self-study template.

The summary contains:

- A pie chart showing overall progress. There is also an option to set a due date for the report.
- A list showing various project statistics, plus workflow status.
- A list of project team members.
- A list of project tasks. Due dates set will appear on a team member's calendar and will optionally generate email alerts, if configured.
- A list of project team comments. These can be added as general comments by clicking the Add comment link. The list will also include any section-specific comments.

6.2.2 Editing a Standard

In the Edit mode, the Agency Template is available to add or edit narratives and evidence for each section and update the section status.

For consistency with most agency standards and to simplify navigation, the template is generally built with active headings that allow the user to drill-down into a particular section.

You can search for a narrative or requirement by keyword. If you have a manager role, all matching sections will be returned. For other team members, only matching rows assigned to your team are returned.

<table>
<thead>
<tr>
<th>Standard</th>
<th>More Detail</th>
<th>More Detail</th>
<th>More Detail</th>
<th>More Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>SECTION 1  THE PRINCIPLE OF INTEGRITY</td>
<td>More detail</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SECTION 2  CORE REQUIREMENTS</td>
<td>More detail</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SECTION 3  COMPREHENSIVE STANDARDS</td>
<td>More detail</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SECTION 4  FEDERAL REQUIREMENTS</td>
<td>More detail</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Certain sections may include a More Detail link, providing access to additional descriptive information published by the accreditation agency.

Clicking on a heading will open the sections under the heading, for example:
In the above example, the **Resources** icons for **Log**, **Narrative** and **Evidence** are displayed for all sections except for section 2.4, which is grayed out. This is because the user is not a member of any **team** assigned to section 2.4. Provided the section is not also designated as confidential (see below), members of other teams will be able to view the narrative and evidence but will not be able to edit them.
If the Xitracs Portal™ is installed, the assignment of one or more Portal Users will be indicated. If a section already contains evidence items, the evidence icon will turn green 🧪. Rolling over the icon with your mouse will display the number of items.

You can set a Due Date and Status for a section depending on your role in the system and team membership. If no date or status has previously been set and you are able to change the setting, a yellow square will display.

If a Confidential icon 📜 appears next to the description (as in section 2.4 above), this indicates that this section is restricted and the narrative and evidence are not viewable or editable by users who are not members of the assigned team. Also any evidence will not be available for reuse in other sections. Confidential sections can also be excluded when previewing or publishing a submission.

If the standard is in Response mode, an additional column will display. See Response Cycles for further information.

6.2.2.1 Log

Each time a user edits a section of the standard, the action is recorded automatically by the system. The last action is visible by placing the mouse cursor over the 📜 icon.

1. Click on the 📜 icon to see all actions for the section
2. A comment may be added manually by a user by clicking on the Post Comment link
3. If an unread comment exists, the log icon will change to include a flag 📜. See the Narrative function for more detail regarding comments.

In the log view you can also see which teams are assigned to a section and the team members.

The log is an integral part of the standard and is saved whenever a standard is archived. It is not included as part of the published submission.
6.2.2.2 Portal User Input

- This function is not available if the standard is in response mode.

If your system is configured with the Xitracs Portal™, users with access to the portal can be assigned to provide input to one or more sections of a compliance report.

If there are no portal users assigned, an icon with a red bar will appear. Click on the portal user icon to add one or more icon users to the selected row.

The portal icon will display once portal users are assigned and will turn green if there is input available. Click on the icon to view the input which can then be copied into the narrative and evidence as appropriate.

The Notify via email link will generate an email to the relevant portal users advising them of the assignment.

Note: Portal users are managed separately from Xitracs users. See Xitracs Portal for more information.

6.2.2.3 Narrative

The narrative for a section of a standard may be created or edited by clicking the icon in the Edit view.

- If there is no icon present it means that you are not a member of the team that has been assigned to a confidential section.

If the section has a status of Complete, you will not be able to edit the narrative.

When you start to edit a narrative, it will lock the editor for other users. Similarly, if the narrative is already being edited by another user it will be locked. If you have a Manager role you will be able to unlock the narrative. This is useful if the other user has accidentally left the narrative open.

To add a new or update an existing narrative, click the Edit narrative link. This will open the Text Editor and will also lock the narrative so no other users can edit it.

If the Edit link is not available, you are: (1) not assigned to a team for this section or (2) the narrative may be open for editing by another user and has been locked or (3) the manager has marked the section as complete and it can no longer be updated.

Use the text editor to enter new and/or edit the narrative and apply formatting, add images and hyperlinks. For more information see Using the Text Editor.

- After you add or edit narrative, do not forget to click the Submit button or else your changes will not be saved. This will also unlock the narrative for other users.

To view any previous versions of a narrative, click on the View History link. You can track changes by clicking on the Compare link next to an earlier version. Use the Copy as new version link to make a previous version the current narrative.

The Text Cleanup Tools link lets you access a number of tools that will help you resolve any formatting or bad hyperlink problems that are typically caused by copying and pasting text from an external source document.

Click on the link, select the options required and click Submit. The tools will perform the selected functions plus the automatic built-in cleanup. A new version of the narrative with the cleanup changes will then be generated.
When a standard is in **Response** mode, the narrative and evidence for the original submission or any prior response cycles can no longer be edited. Instead you will be able to input any post-submission review comments received from the relevant agency and enter responses for the current cycle. See **Response Cycles** for further information.

If the section has the **Include in Response** flag set in the **Response status**, the narrative icon will change to include a red dot 🔄, the section will be highlighted and will be included in the response submission.

To add/edit a report or response click the **Edit report** or **Edit response** link. Use the text editor in the same manner as for the narrative.

⚠️ **Information copied and pasted from other sources may contain proprietary formatting characters or invalid links. This may cause problems later when publishing a submission. If an invalid link problem is detected, a warning message will be displayed. You can check the quality at any time by using the Website Preview function and a pop-up window will open with the relevant section displayed.**

If there is a **new comment** that you have not read, a ⭕️ icon will appear. To add or show comments click the relevant link. When viewing comments, click the **Show all comments** link to display more than the most recent. Click on **Hide comments** to close the display.

   *Note: Comments are not included in the published submission and are not visible to external reviewers.*

If the section has been assigned to one or more **portal users**, a Portal responses link will appear. If there are any pending responses, an asterisk will also appear.
6.2.2.4 Evidence

The evidence for a section may be created or edited by clicking the icon in the Edit view. If the section already contains evidence items, the icon will change to green . Rolling over the icon with the mouse will display the number of items.

Evidence items are displayed either in alphabetical order or in a specified order. This is configurable. See Manage Standards > [Standard] > Properties.

Some agencies include information about the evidence required for certain sections. If this information is provided, an Evidence checklist link will appear next to the section number. Click on the link to view this information.

Evidence consists of files or Uniform Resource Locators (URL's) that are added to the section of a standard as supporting artifacts.

Items may be added in a number of ways:

1. From File on a local resource, e.g. your workstation's hard drive
2. By entering a URL
3. From the Xitracs Library
4. From the standard's current All Evidence list using the QuickPick function

The evidence page for the specific section will list any items currently being used, in an editable order, together with buttons to add new items.

If the section has a status of Complete or the standard is Locked, the edit buttons will not appear.

If the section is set as Confidential, you will have the option to designate individual items as confidential. These items are highlighted by the icon.

If the standard is in Response mode, the cycle information will appear. See Response Cycles for further information.

Note: If an item has been linked in the narrative, the delete icon will be replaced by . Click on the icon to view the links.

To Add a File

1. Click the File button
2. Enter an item Title
3. If the file is a PDF you will have the option to enter a page number where the document will open when viewed.
4. Enter an optional Description
5. If you are in a confidential section, an option to designate the item as Confidential will be available.
6. Locate the file to upload using the Browse button
7. Click Submit

Depending on the size of file, there will be a brief delay during the upload process after which a receipt page will display confirming the file has been added to the evidence list.

*Note:* Files with extensions .exe .bat .java .jsp .js will be rejected

To Add a URL
1. Click the URL button
2. Enter an item Title
3. Enter an optional Description
4. Enter the URL
5. Click Submit

> Take care when adding URLs as evidence. Most agencies require that evidence items are integral to the published submission. While a URL link to a general site, such as the institution website, would be acceptable, URL links to documents on a remote server may not be.

To Add an Item from the Library
1. Click the Library button
2. Search through the folders to locate the item
3. Click the check box next to the item(s) to be added
4. Click Submit
5. If the file is a PDF you will have the option to enter a page number where the document will open when viewed.
6. Enter an optional Description
7. Click Submit

*Note:* When an item is selected from the library, it is copied into the evidence list for the standard. If the original item in the library is later edited or deleted, it will not affect the copy of the item in the standard. This is important to maintaining the integrity of a published submission.

If a file is a multi-page PDF, an Extract pages link will appear. Click on the link to select one or multiple contiguous pages and create a new evidence item.

To Add an Item from the Existing Evidence List
The QuickPick function allows the user to select one or more items that have already been used as evidence elsewhere in the standard. This avoids having multiple copies of the same item when it is used in multiple sections throughout the standard. For example, if a Policy Document is to be used as evidence in Sections 2.1, 3.4 and 4.2, it need only be uploaded or copied from the Library once into Section 2.1; from then on the user can use the QuickPick function to link the same item to Sections 3.4 and 4.2.

1. Click the QuickPick button
2. *If the section containing the desired item is known*, choose the section number using the **drop-down selector** to display evidence items in use for that section of the standard. Note that only sections containing evidence are displayed. Sections that have a setting of **Confidential** are not listed.

3. *Alternatively*, click the **List all** link to display all evidence items used all sections.

4. Click the **checkbox** next to the item(s) to be added to the target section

5. Click **Submit**

   **Note:** Items added using the QuickPick function are linked and **not copied**. This means that if the item in the All Evidence list is edited or deleted, it will affect all instances of the item in the standard. This is particularly useful where a correction needs to be made to an evidence item. It need only be edited once in the Evidence List and all instances will automatically be updated.

---

**To Edit an Item in the Section Evidence List**

1. Click the **Edit** icon

2. If the file is a **PDF** you will have the option to enter a page number where the document will open when viewed.

3. Edit the item **Description** as appropriate

4. Change the **Sort Position** as appropriate (this is the position where the item will appear in the list if the **properties** are set to specific sort.)

5. Select **Exclude** from evidence list as appropriate (see below)

6. Click **Submit**

   **Note:** To edit the **Title** of an existing item, you must first view the item in the main Evidence list for the standard, then click Edit. Only users with a Manager role are able to view items from confidential sections in the main evidence list.

**To Exclude an Item in the Section Evidence List**

Items that have been added as evidence for a section may optionally be excluded from the evidence list by checking the **Exclude** box in the Item Edit mode. This is useful when certain items have been added solely for use as graphics in a section narrative. Excluded items are highlighted by the 📦 icon.

**To Delete an Item from the Section Evidence List**

1. Click the **Delete** icon

2. Click **Yes** to confirm

   **Note:** If you attempt to delete an evidence item that is linked in the narrative you will receive a message that you must first remove or change the link in the narrative.

   **Note:** Deleting an item from a section evidence list will remove it from that section only. If it is being used elsewhere, in other sections of the standard, it will continue to appear on the All Sections Evidence List.

**To Convert an Item to PDF**

If an evidence item is a Word file (.doc or.docx), you can convert it to a PDF file. Click the link and follow the steps.

   **Note:** If you choose to create a new file instead of replacing the existing Word file, be sure to update any links in the narrative.
6.2.2.5 Due Date

A date can be set by users who are members of a Manage Team to indicate when a particular section is due. The date is a visible aid to team members and is also used in the generation of the Due Date Report.

Due dates will appear on the team member's Calendar and will optionally generate email alerts, if configured.

The Set Date function is available to users who are members of the Manage Team.

- To set the date, click on the calendar icon, select a date from the pop-up and click Submit.
- To edit an existing date, click on the date, select a new date and click Submit.
- To clear an existing date, click on the date and click Clear.

6.2.2.6 Status

A status is used to indicate progress through the submission process. A standards matrix has two status columns when in normal online mode and a third status column when in response mode. The absence of a status is indicated by the symbol (if editable) or ".-".

A list of the default statuses is shown below. Note that the Response column only appears if the standard is in Response mode.

<table>
<thead>
<tr>
<th>Preparation</th>
<th>Judgment</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Compliance</td>
<td>OK</td>
</tr>
<tr>
<td>For Review</td>
<td>Partial Compliance</td>
<td>Information</td>
</tr>
<tr>
<td>Resubmit</td>
<td>Non Compliance</td>
<td>Problem</td>
</tr>
<tr>
<td>Approved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td></td>
<td>□ Include in Response</td>
</tr>
<tr>
<td>□ Add comment</td>
<td>□ Add comment</td>
<td>□ Add report</td>
</tr>
</tbody>
</table>

The ability to set a status is controlled by a user's Team Membership for a specific standard section, as follows:

The Preparation column indicates the status of preparation of each section.
- Users who are members of an Action Team can set a status of Draft or For Review
- Users who are members of a Review Team can set a status of Resubmit or Approved
- Users who are members of a Manage Team can set any available status, including Complete

Note: Sections that have been mapped from another standard will display a status setting of Auto.

The Judgment column indicates the status to be included in the submission.
- Users who are members of a Manage Team can set any available status

Note: If the relevant agency calls for the inclusion of the Compliance status, this will automatically be included with the published submission.
If the standard is in Response mode (see Response Cycles) the following additional options are available:

The **Response** column indicates the status of the review response from the relevant accreditation agency.

- Users who are members of a **Manage Team** can set any available status.
- The **Include in Response** checkbox indicates that the section is to be included in a published response. When checked, the Narrative icon will include a red dot and the background color of the row will change.
- The **Add Report** option will take the user to a text entry area where report information from the relevant agency may be entered.

**To set a status:**
1. Click the icon or the existing status link
2. In the pop-up, select an available status
3. Optionally, check the box to post a Comment (Except Response column)
4. Optionally, check the box to set the Response flag and add a Report (Response column only)
5. Click Submit

*Note: An inactive link indicates that the user does not have the privilege to edit the status. See team membership.*

**To clear a status:**
1. Click the Clear button in the status pop-up

*Note: This function is only available to Manage team members*
6.2.3 Evidence

When an evidence item is added to a section, it appears on the All Evidence List. This list shows all items (or by letter if mode selected), in alphabetical order of title, with the exception of items used only in sections designated as Confidential. These items are only visible to users with a Manager role.

You can verify URL evidence items at any time by clicking on the Check URLs link.

In the left column there is a series of icons which provide information and allow you to manage items.

1. Click on the icon to Delete an item. You will be asked to confirm the action.

   Once an item is deleted, it is removed from all sections where it is being used.
   To remove an item from only one section, use the Edit evidence link in the relevant section.

2. Click on the icon to Edit the item title and other optional settings.

3. Hold your mouse over the icon to see Where Used information for the item. A list of section numbers will be displayed.

   If an evidence item is included in one or more sections that have been set to ‘Exclude’, these sections will not be listed. See Section Settings.

4. Click on the icon to Replace the item. (Not available for URL items - Use the Edit function to change a URL).

In the middle column, the item Title is shown. This can be changed using the Edit function (see above). If an icon appears next to the title, it indicates the following:

- The item has been designated as Confidential.

   See Editing a Standard > Evidence for more information about confidential items and how to change this designation.

- The item has been designated as Restricted.

   Items with this designation will be included in the restricted documents folder when a website submission is published. This feature allows an additional level of access security to be maintained for these items. To change, click on the Edit icon. Note: The restricted designation does not apply to published submissions in a PDF or MS Word® format.

- The item has been designated as Excluded.

   Items with this designation will be excluded from the evidence lists (section level and all evidence). Use this function for items such as embedded graphics. To change, click on the Edit icon.
In the right column, there is a link to **View** the item and information about the **Type**. If the item is a file, the File Extension is shown, together with the file size in kilobytes (KB) and the date that the file was created.

*Note: Descriptive information does not appear in the evidence list. This is because this optional descriptive information relates only to the instance of an item in a section. For example, the same item could have Description A in one section and Description B in another section, and so on.*

Use the **Check duplicate files** link to list any files which have been added more than once. You can then merge selected files to remove duplication.

*Note: If a list of duplicate files contains both confidential and non-confidential items, merging them will result in the file being designated as non-confidential. This is because the item has already been referenced in non-confidential sections of the report.*

Users with a team role of Manager can download all the evidence by clicking on the **Download** link in the All evidence view.
6.2.4 Other Collateral

Other collateral items, such as a Quality Assurance Plan (QEP), may be linked to a published website submission if desired.

They are viewable by clicking on the relevant tab in the published submission website.

To enable Other Collateral linking see the Control Panel > Manage Standards > [Standard] > Properties function. This function also includes the Single or Multiple item setting.

If configured with a Single Collateral Item link

The recommended file format is PDF, although other formats may be uploaded if preferred.

To Associate an Item with a Standard
1. Click the Other function link
2. Click the Add new link
3. Browse for the file to upload (PDF format recommended)
4. Edit the Title as appropriate
5. Click Submit

Once a Plan has been uploaded, it may be replaced or deleted at any time.

To Replace a Collateral Item
1. Click the Other function link
2. Click the Replace link
3. Browse for the new (replacement) file to upload (PDF format recommended)
4. Edit the Title as appropriate
5. Click Submit

To Delete a Collateral Item
1. Click the Other function link
2. Click the Delete link
3. Click Yes to confirm or No to cancel
If configured with a Multiple Collateral Items link

Unlike a single item association, the multiple items function allows you to create a structure of folders and items. These items can be included as part of the published website submission and can be viewed by clicking the relevant (e.g. Other Items) tab.

To Create a Folder
1. Click the Folder+ button
2. Name the folder and add an optional description
3. Click Submit

*Note: You can add sub-folders by first clicking on the parent folder and the clicking the Folder+ button.*

To Edit a Folder
1. Click the Edit folder icon
2. Edit the folder name and/or description
3. Click Submit

To Delete a Folder
1. Click the Delete icon next to the folder
2. Click Yes to confirm

*Note: The delete icon will only appear for empty folders.*

To Add Items to a Folder
1. Click the Folder into which you wish to add items
2. Click the File, URL or Library button depending on the source
3. Add or edit the Title as appropriate
4. Add an optional description
5. Click Submit

*Note: If you do not select a folder, the items will be added at the same level as the existing list of folders.*

To Delete an Item
1. Click the Delete icon next to the item
2. Click Yes to confirm
6.2.5 Preview

The Preview function allows you to view how submission will look, without having to publish it. No evidence files are copied and are available for viewing only. You must have a Manager or Administrator role to have access to this function.

If the standard has been configured to allow partial publishing, a list of the top level sections to be included will be displayed. See standard Properties for more details. (This option is not available if the standard is in Response mode.)

If the standard is in Response Mode, only sections with “Include in Response” set to Yes will be included. See Response Cycles for further information.

A panel on the right of the page provides a summary report of the number and size of evidence items.

To Preview a Submission

1. Click the Preview link.
2. Select whether Narratives and/or Evidence are to be included in the preview.
3. Select whether Confidential Sections are to be included in the preview.
4. Select the Format for the preview submission. The default is a website view.
5. If the format is Website, optionally check the box to include a narrative search function on the webpage.
6. Alternatively, select a Web page (continuous single page), Portable Document Format (PDF) or Microsoft Word (MS Word®) document.
7. If the standard is configured to allow Partial publishing, select the sections to be included.
8. Click Submit. Depending on the size of the submission, the preview may take a few moments to generate.

Note: Previews in Website or Web page format cannot be saved and will reset when the browser window is closed.
6.2.6 Publish

The Publish function will generate a submission in a selected format, which can then be used for one or more of a Printed Copy, Website or Electronic Media such as CD, DVD or USB Flash drive. When a standard is published, all of the narrative and evidence (if selected) are copied as part of the submission file. Therefore, any subsequent changes made to the standard using the Edit function will have no affect on a previously published submission, until the standard is re-published.

You must have a Manager or Administrator role to have access to this function.

To see how a submission will look prior to publication, use the Preview function.

If the standard has been configured to allow partial publishing, a list of the top level sections to be included will be displayed. See standard Properties for more details. (This option is not available if the standard is in Response mode.)

If the standard is in Response Mode, only sections with "Include in Response" set to Yes will be included. See Response Cycles for further information.

A panel on the right of the page provides a summary report of the number and size of evidence items.

To Publish a Standard

1. Click the Publish link.
2. Select whether Narratives and/or Evidence are to be included in the publication.
3. Select whether Confidential Sections are to be included in the publication.
4. Select the Format
5. If the format is Website the submission may be published to a website location (if defined) or downloaded as a compressed (.zip) file. Check the box to include a narrative search function on the website, if required.
   
   Note: Website locations must be predefined. See Control Panel > Manage Standards > [Standard] > Website > Locations
6. Alternatively, select a Web page (continuous single page), Portable Document Format (PDF), Microsoft Word (MS Word®) document or ePub file format.
7. If the standard is configured to allow Partial publishing, select the sections to be included.
8. Click Submit. Depending on the size of the submission, it may take a few minutes to generate.

If you have published the submission as a downloaded compressed .zip file, you can copy the contents to a CD/DVD or USB Flash Drive as follows:

1. Unzip the file to an empty directory folder (e.g. Submission) on your workstation using your local utility (e.g. Winzip).
2. Copy the contents of the folder containing the unzipped files to the CD/DVD or Flash Drive. Do not copy the folder itself.

You can verify this after the copy is complete by checking the media and making sure that the index.html file is in the root.

The system will also include the autorun.inf file which will cause the index file to open automatically when the media is inserted, unless the security settings on the viewer’s workstation preclude execution of autorun files.
6.2.7 Response Cycles

Following final publication of a submission and if it is necessary to create responses to an agency review (e.g. a Focused Report), the properties of a standard may be changed to **Response mode**. This function is available via the Control Panel > Manage Standards > Properties function.

Once in this mode the original submission will be locked and the standard will enter Response Cycle 1. Reports (comments from an agency review) and Responses (to comments) may be entered for relevant sections of the standard and these may then be published as a response submission. If it is necessary to generate subsequent responses to an agency review of the response submission, the standard can be set to response Cycle 2 and so on.

⚠️ Once a standard is in Response mode, it cannot be returned to Online mode. Make sure you **backup** the standard before changing the mode to Response.

Standards that are in Response mode have a third status column which allows users with a Manager role to set a section response status.

Check the **Include in Response** box if you want to include the section in a response submission. The relevant section will be highlighted and the narrative icon will change to include a red marker 🔄. If you check the **Add Report** box before you click Submit the system will automatically take you to a page where you can enter agency comments and your response.

When you click on the **Narrative** and **Evidence** icons you can add Reports (Agency comments) and **Responses** (Response to agency comments), plus supporting evidence. The Cycle you are in is displayed. If there are any previous response cycles, you can view these and the original submission narrative and evidence by clicking the **View Cycles** link.

⚠️ You can only edit the cycle you are in. Information for the original submission and any previous response cycles can be viewed but not changed.

Once a response submission is complete, the next cycle can be started if necessary via the Control Panel > Manage Standards > Properties function.
6.2.8 Teams & Section Settings

Teams
System Users are assigned to a standards matrix through membership of a Team. There are three types of teams: Action, Review and Manage. The team type controls which functions in the Xitracs system are available to users. There can be multiple Action and Review teams, but there is only one Manage Team for the entire standard; users who are members of the Manage Team can edit or update the status of all sections.

! To have access to a complete set of manage functions, members of a Manage team must also have a user role of Manager.

<table>
<thead>
<tr>
<th>Functions available</th>
<th>Team type</th>
<th>Action</th>
<th>Review</th>
<th>Manage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Preparation Status (assigned sections only)</td>
<td>Action</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Set Compliance Status (all sections)</td>
<td>Review</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Response Status (all sections)</td>
<td>Manage</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Set Due Date (all sections)</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Add/Edit Narrative (assigned sections only)</td>
<td>Action</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add/Edit Evidence (assigned sections only)</td>
<td>Review</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Add/Edit Reports* (assigned sections only)</td>
<td>Manage</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Add/Edit Responses* (assigned sections only)</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Manage Teams</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Add/Edit Preamble (via Control Panel &gt; Settings)</td>
<td>Action</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Add/Edit Other Collateral</td>
<td>Review</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Preview Submission</td>
<td>Manage</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Publish Submission</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>View Reports</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Access Library**</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

* When standard is in Response mode. **If library assigned. See Administration > Groups.

Note: Preparation Status selections will differ depending on team type. See the Status section for more information.

There is one team of each type created automatically when an agency standard is first imported; these are the default teams and they cannot be edited or deleted. Additional Action or Review teams can be created as required, then edited or later deleted as appropriate. Creating additional teams is optional, however, it provides a greater level of granularity in assigning users to standards. For example, the preparation and review certain sections of a submission may relate to a specific department in the organization, say the Finance Department. By creating Finance Action and Review Teams, the relevant sections can be assigned only to the members of those teams, (see Manage Team Access below ). Users who are members of other Action or Review teams can view (unless the confidential designation is set - see below), but will not be able to edit these sections or update the statuses.

! A user must belong to an assigned team in order to have access to a standard. If a user belongs to a team that has not been assigned to one or more sections, the standard will not appear in the user’s standards list.
To Create a New Team
1. Click the Create a new team link
2. Enter a team Name
3. Enter a team Description
4. Select the team Type, either Action or Review
5. Click Submit

To Add Team Members
1. Click the Members link
2. Click the Add member link
3. Enter a User ID, Last Name or First Name to find the user (partial entry allowed)
4. Click Submit
5. Matched user(s) will be listed
6. Check the box next to the relevant user
7. Click Submit

To List Team Members
1. Click the List or Remove members link

To Remove Team Members
1. Click the List or Remove members link
2. Check the box next to the relevant user(s)
3. Click Submit

To Manage Team Access to Sections of the Standard
1. Click on the Manage team assignment link
2. In the matrix, click on an Action Team or Review Team cell
3. Select a team from the pop-up
   ! Note: You must first have created additional teams for them to appear in the pop-up. See Create a New Team above.

Settings
A row may be excluded from those listed in the Edit view and in the preview/publish view.

To Manage Excluded Rows
1. Click on the Manage team assignment and confidentiality/availability settings link
2. In the matrix, click on an Exclude cell
3. Select Yes or No from the pop-up
4. To exclude and entire section, click the Yes/No link next to the section row.
   ! Note: If you exclude a section, all of the rows in the section will be excluded irrespective of any individual row settings.
A section may be set as **Confidential**. This action will:

a. Prevent members of other teams from viewing the narrative and evidence.

b. Exclude any associated evidence from the main evidence list except for users with a Manager role.

c. Exclude the section from a previewed or published submission unless explicitly included.

*Note: You cannot assign the default Action or Review teams to a confidential section.*

**To Manage Confidential Sections**

5. Click on the Manage team assignment and confidentiality/availability settings link

6. In the matrix, click on a Confidential cell

7. Select Yes or No from the pop-up

### 6.3 Reports

#### 6.3.1 Reports

**Activity Log**

The Activity log lists, in descending chronological sequence, all of the user activity that has occurred for a standard in the Edit mode, including due date changes, status changes and evidence updates.

Included in the report are the Section Reference ID (where applicable), the Section Description, the Activity, Date and Time and the User Name.

The report can be grouped by date or section of the agency template. User posted comments will also appear in the activity log. To include only user comments in the report, check the box.

If the standard is in Response mode, the Cycle information will be shown.

**Due Date**

The Due Date Report lists all sections that meet a set of criteria. These can be Past Due and Due within a specified period of days.

The preparation Status may be filtered, as required. If the date filter of Past Due is selected, the status of Complete is excluded.

The report may be by due date or by section.

*Note: The sections in the generated report will be in View mode. Changes to a section must be made using the Edit function.*

**Link Check**

This report will check and verify the integrity of evidence links in each narrative.

Evidence items can be linked to text in a narrative. See Using the Text Editor for more about linking.
If the items have been correctly linked, the Xitracs system will automatically generate the correct URL for each link depending on the target destination of the published submission, (e.g. offline media such as a DVD or Flash Drive or a webserver).

However, if a link is suspected as being bad, it will be listed on the report with a reason. The most common cause is text that has been copied and pasted into a narrative from another source (e.g. a Word document or another narrative) which includes a hyperlink to an item that does not exist in the evidence list for the section. Go to the narrative for the relevant section and correct the link as shown in the highlighted error.

To validate the integrity of external URLs, use the Check URL function in the all evidence list.

**Portal**

This report lists any portal user activity in the selected timeframe. Click the Assigned People Report link to go to a list of sections and see which portal users are assigned.

**Progress**

The Progress Report lists the number of sections by status and as a percentage of total sections, for the agency standard selected.

**Word Count**

Certain agencies specify the preferred or maximum number of words that may be included in a submission. The Word Count report will list by section the number of words and characters used in the narrative, plus provide a total for the whole document. Use the View link to jump directly to the relevant section and edit as appropriate.

### 6.4 Control Panel

#### 6.4.1 Manage Standards

The Manage Standards function allows a manager with control panel access or system administrator to control which standards are available to users, plus perform a number of administrative activities.

As a first step, at least one standard must be imported into the system. One or more Agency Standard (xis) files will have been provided to you or pre-loaded by Concord, depending upon how many agency standards have been licensed.

**To Import a Standard**

1. Click the Import a standard link
2. Browse for the Standard import file (this will have a .XIS file extension, such as SACS-2008-01.xis)
3. Click Submit
4. The imported standard will be added to the active standard list.

The list of active standards will look similar to the following:
Each standard is listed with a **Title** and **Description**, plus a **Version** as published by the agency.

The **Status** of a standard determines its availability to team members. There are four possible settings:

- **Online** - the standard is available and may be edited by the assigned team members
- **Locked** - the standard is available for viewing only; it cannot be edited by the assigned team members
- **Response** - the standard is in response mode; the original submission can no longer be edited. The cycle number is shown in parenthesis.
- **Offline** - the standard is not available; it will not appear on the assigned team members list of standards

See the **Properties** section for more information about how to set a status.

See the **Backup & Archive** section for information regarding these functions.
An active standard may be removed from the list by using the **Remove** link, provided that it has a status of **Offline**.

⚠ **Removing an active standard is irrevocable and will delete all associated narratives and evidence.**

You should **backup** a standard before removing it. When you click on the Remove link you will be asked for confirmation and given the option to create a backup copy.

To be available, users must next be assigned to one or more of the standard's teams.
Click the **Teams** function link and follow the process described in the **Teams** section to achieve this.

Backup copies of standards may be added to the list of standards by clicking the **Retrieve backup** link.
This is a useful feature which allows an administrator and other users to look at earlier versions of a submission or restore it to active status. See the **Backup & Archive** section for information about how to create backup copies.

Once added they will appear in a separate list as in the example below.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Version</th>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Card Industry Data Security Standard Training at Evaluation Copy Only</td>
<td>Rel 1.1 Sep 06</td>
<td>Unavailable</td>
<td>Remove, Properties, Restore</td>
<td>View</td>
</tr>
<tr>
<td>SACS</td>
<td>Southern Association of Colleges &amp; Schools</td>
<td>2006 Edition</td>
<td>Available</td>
<td>Remove, Properties, Restore</td>
</tr>
</tbody>
</table>

By default, retrieved standards are set with a status of Unavailable and are not viewable by users. If required, a retrieved standard may be made available for viewing by changing the status to Available.

Users who are members of the standard's teams will have access via the Retrieved Standards area of their standards list.

**To Set the Status of a Retrieved Standard**

1. Click the **Properties** link
2. Select a **Status**
3. Add an optional **Comment** (this will appear below the standard description field)
4. Click **Submit**

A retrieved standard may be removed from the list by using the **Remove** link. The standard must have a status of **Offline** for this link to be active.

It may also be reinstated as the active online standard by using the **Restore** link.
6.4.1.1 Properties

The availability of an agency standard and its status through the preparation cycle is controlled via the Properties function.

To Set the Properties of an Active Standard

1. Select a Status There are four possible settings:
   - Online - the standard is available and may be edited by the assigned team members.
   - Locked - the standard is available for viewing only; it cannot be edited by the assigned team members.
   - Response - the standard is in response mode; the original submission can no longer be edited.
   - Any existing statuses and due dates may be cleared by checking the box. If the standard is already in response mode, you can start a new cycle by selecting the radio button.
   - Offline - the standard is not available; it will not appear on the list of active standards for assigned team members.

2. Add an optional Comment (this will display for each team member below the standard description field, but will not be included in any published version).

3. Select a Website Template to be used when publishing this standard (if none is available, the default template will be used). See the Presentation templates function for more detail.

4. Select a PDF Template to be used when publishing this standard (if none is available, the default template will be used). See the Presentation templates function for more detail.

5. Select a MS Word® Template to be used when publishing this standard (if none is available, the default template will be used). See the Presentation templates function for more detail.

6. Click the Collateral checkbox to allow Other collateral to be associated with the standard. Select the whether you wish to include a single item or multiple items with the published submission website.

7. Click the Partial publishing checkbox to allow selection of specific top level sections when Previewing or Publishing. (Not available if the standard is in response mode.)

8. If the agency standard is the Index to HLC Criteria, select the relevant AQIP standard for reference.

9. Click Submit

⚠ Once a standard has been set in Response mode, the original submission can no longer be edited. Do not set the Response status until a submission has been completed and published and a backup has been created. See Response Cycles for more information.

To Set the Properties of a Retrieved Standard

1. Select a Status There are two possible settings:
   - Available - the standard is available for viewing by the assigned team members; it cannot be edited.
   - Unavailable - the standard is not available; it will not appear on the list of retrieved standards for assigned team members.
6.4.1.2 Backup a Standard

A Backup is a snapshot of the active agency standards template at a point in time. A backup may be generated at any time and with a frequency that suits the policy of the organization. Regular backups are recommended to protect against data loss or system failures since they can be Restored. A backup copy may also be retrieved for viewing purposes.

**To Create a Backup of a Standard**

1. Click the **Backup** link
2. **Save** the compressed (.XBF) file to a local resource, or to a backup server if available

   *The file will be identified with the standard name and a timestamp. If the file is large it may take some time to download, depending on your connection speed.*

Once a submission cycle has been completed, a standard may be removed from the active list through the Archive function. This will generate a compressed file that will include: the Submission, the supporting Evidence, the Activity log and Team membership.

An archive is for record keeping purposes only and, unlike a Backup (see above), cannot be returned to an active state.

**To Archive a Standard**

1. Click the **Archive** link
2. **Save** the compressed file to a local resource
3. The standard will disappear from the active list

   *Note: If a standard has been archived and the organization is ready to start the next submission cycle, using the **same version** of the standard, import the standard matrix again to add it to the active list and start the new cycle. If the organization wishes to reuse information that was used in the previous submission, use the restore function (see below) and then edit the resulting matrix as appropriate.*

6.4.1.3 Restore a Standard

A backup of a standard can be made **Active** through the **Restore** function. However, there must already exist an active agency standards template of the same version for the restore to succeed. For example, a SACS Version 2007 backup cannot be restored into an active SACS Version 2008 agency template.

⚠️ **Caution!** The restore function will **replace** the current active version of the agency template. Any changes made to the submission between the date of the backup to be restored and the current version will be lost. Therefore, it is strongly recommended that a backup is made of the current active agency standards template before a retrieved backup is restored.

**To Restore a Backup of a Standard**

1. Click the **Restore** link
2. **Confirm** replacement of the current active standard
3. Select whether the standard will be **Offline** or **Locked** when restored. You will be able to change this setting later via the **Properties** function.
4. Edit the **Comment** as appropriate. The system will automatically include the date and time of the backup and retrieve actions.
5. Click **Submit**

   Depending on the size of the backup, the restore operation may take several minutes to complete. Once the restore is complete you will receive a notification if there were users as team members in the backup version that no longer exist in the system.
Settings

Each standard may have its own set of specific attributes for the published submission website or document (PDF or MS Word®) format.

*Note:* Some of these functions may not apply to custom designed website templates.

**Document Banner**

1. Click the **Banner** link
2. **Browse** for a suitable graphics file. This must be a GIF image file that conforms to the required dimensions. A minimum of 300dpi is recommended for good print quality.
3. Click **Submit**

**Document Cover Page**

1. Use the **text editor** to create or edit a cover page. (For certain agencies this information may have been pre-loaded as part of the standard.)
2. Check the **enable** box to include the page in the submission document.

**Document Header & Footer**

1. Enter text for the **title**, **header** and **footer** as appropriate.
2. Click **Submit**

**Preamble**

Click the Preamble function link to open the **Text Editor** and add an introduction to a submission in both website and PDF/MS Word® formats. When finished, click the Submit button and the preamble will be updated. It may be edited at any time as required.

**Website Banner**

1. Click the **Banner Upload** link
2. **Browse** for a suitable graphics file. This must be a GIF image file that conforms to the required dimensions.
3. Click **Submit**

*Images that exceed the recommended dimensions will cause problems with the tabs on the website.*

**Website Header & Footer**

1. Enter text for the **header**, **sub-header** and **footer** as appropriate to appear on each website page (excluding the welcome page).
2. Click **Submit**

**Website Locations**

Each licensed agency standards template will include a Built-in published website location with a type listed as INTEGRATED. This built-in location is not editable, however any existing content may be removed using the **Clear** function.

External access to the published website can be managed using the **Reviewers** function in the Administration menu.
Any published submission websites that existed prior to Version 3.1 of Xitracs will not be integrated. Concord will have created a location for the website and provided you with the viewer logon parameters. **Access to these earlier (non-integrated) websites cannot be managed using the Reviewers function.**

You can specify additional web-server locations for your submission. This is useful if you wish to set up an intranet site for internal review of a submission prior to publishing it to an externally accessible site.

1. Click the **Create** location link
2. Enter a **Name** for the location
3. Enter the **Server** information. This will typically be an IP address or FTP path.
4. Enter a **Logon** and **Password**
5. Enter a **Path**. This is a directory location on the server.

*Note: If you are hosting the website on your own server and are not familiar with these settings, contact your Network Administrator.*

**Website Tabs**

The standard website template format uses a tab metaphor to access the various parts of a submission. These labels can be edited if required. Check the box to enable/disable a tab.

If the standard is in **Response** mode, a tab is provided to link back to the original submission.

*Even if the Collateral tab is enabled it will not appear on the website unless an item has also been uploaded. See Edit Standard > Other.*

**Website Welcome Message**

The home page of the submission website includes an area for a welcome message. Use the text editor to add a message.

**Website About Tab**

Additional information may be added for the benefit of a published website viewer under the **About** tab. For example: how to navigate the site, where to get questions answered. In addition, optional links are provided to **Calendar of Events**, **Team Roster** and **Visit Agenda** information pages.

**Portal Email**

Customize the content of the email sent to portal users who are assigned to sections in an agency compliance report.

**Portal User Report**

View a list of assigned portal users.

**Portal Settings**

Control what portal users can see when editing a section of an agency compliance report.
6.4.2 Map Standards

The Map Standards function allows administrators to copy the supporting narrative and evidence from one standard to another. This is useful when an institution has multiple accreditation standards that contain similar sections, such as the Institution Mission and Goals. By mapping existing content, considerable time can be saved by avoiding the re-keying of duplicate information.

Mapping is a copy function which creates a new instance of the narrative and evidence in the target standard.

A standard may also be mapped automatically using an import file provided by Concord. This function is used, for example, when updated to a newer version of an agency standard.

To Map a Standard Manually

1. Select the Target standard
2. Click Submit
3. Select the Source standard (see below if the source standard is in Response mode).
4. Click Submit
5. For each applicable target row/section, select the relevant source using the drop-down
6. When complete, click Submit

Note: Only those target rows that are to be mapped need be identified in the drop-down; the remainder may be left blank.

If the source standard is in Response mode, a drop-down is provided to select the cycle to be used for copying narratives and evidence. The drop-down will default initially to the current cycle. You may select other available cycles, including the original submission. If you want to copy evidence from more than one cycle, for example the original submission plus the current response cycle, map using the first required cycle and then map again using the next required cycle and so on; the evidence will be copied cumulatively. Note however that the narrative is not cumulative and is overwritten with the last selected cycle.

To Map a Standard Automatically

1. Click on the import file link
2. Browse for the mapping (.xms) file provided by Concord
3. Check the box if you want the due dates from the source standard copied to the target standard
4. Click Submit

The system will look for the source and target standards defined in the file. If you do not have these loaded on your system the mapping will not function.
6.4.3 Multi-Use Standards

Multi-use Agency Standards Templates may be licensed from Concord and allow the client to create multiple instances of the same agency standards. For example, an institution that has different campuses or colleges that must each make an agency submission will benefit from the ability to create separate instances of an agency standards template.

To view the available multi-use standards, click on the link in Standards > Control Panel. If none are listed or one or more licensed standards is missing, contact your Concord representative.

To create a new instance of a standard, click the New link enter a Title and click Submit. Choose a title that will help identify this instance. You can add descriptive information later by using the Manage Standards > [Standard] > Properties function.

*Note: The title cannot be the same as an existing instance.*

Once the instance is created, it will appear on your list of standards. See Control Panel > Manage Standards. You may then assign team members, set properties etc.

To Remove a multi-use standard from the list, click the Remove link.

*Do not remove a multi-use standard from the list unless you have no further use of the template. Removing a standard template from the list will not affect any active instances that may exist.*

6.4.4 Portal Email Settings

Portal users assigned to sections of a compliance report can be notified by email. The settings function will let you define the default email message.

Use the variables defined between `<% %>` to include this information in the body of the email. If you are including a specific sender email address, make sure that this will not be blocked by your institution's firewall.

6.4.5 Presentation Templates

The published format of a submission can be configured to provide a customized 'look-and-feel' using a template.

You can assign a Website, PDF or MS Word® template to a specific agency standard via the Manage standards > Properties function.

Website templates have a `.xtm` extension. PDF templates have a `.xtf` extension. MS Word® templates have a `.xtr` extension. Templates can be provided by Concord as a professional service or customer developed.

*Note: Template development requires knowledge of HTML and XSL. A design guideline document is available from Concord on request.*

To Upload a Submission Template

1. Click the Website, PDF or MS Word® Template Upload link
2. Browse for a template file
3. Edit the template name as appropriate
4. Click Submit
The template name may be changed later if required by using the Edit link. If the template supports End-notes, use the Edit link to enable/disable. When the End-notes function is enabled, any evidence link within the narrative will be replaced by an end-note reference number.

To remove a template from the system, use the Delete link. If the template is already assigned to a standard, it will be replaced by the system default website template.

If the template supports image graphics, these may changed using the Image link. Use the Replace function to upload a new JPEG image file which must have a .JPG extension.

*Note: The new image may be of any dimension, but care should be taken that the size is consistent with its position and appearance on the page when the website is rendered. This can be verified by generating a preview of the standard. If the image does not look suitable, upload a replacement.*
7 Resource Library

7.1 Overview

The Resource Library module allows users to store and share documents for use in the creation of an accreditation or compliance submission. Any type of electronic file may be stored, including multimedia. In addition, URLs may also be captured. A familiar Folder metaphor is used to allow items to be categorized and sorted in a manner that best suits the system users. In addition, a Search function allows users to locate items by using keywords.

If the Multi-Library feature is installed, users with a System Administrator role can define additional libraries and assign users via the Groups function. The libraries available to a specific user will appear in a drop-down selector at the top of the folder list. See the example below. Put your mouse on the icon to open a pop-up description of the functions you may perform depending on the role.

When in a library, the functions available depend on your role as follows:

<table>
<thead>
<tr>
<th>Function/Role</th>
<th>Editor</th>
<th>Contributor</th>
<th>Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>View item</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Add item</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit own item</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Edit any item</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Delete own item</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete any item</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Add folder</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete folder</td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

7.2 Folders

Folders are a simple and familiar way to store and categorize items.

Click on the icon to Create a New Folder. Enter a Title for the folder and click Submit.

To add a folder Description, click the icon. Once added, the description may be viewed by putting your mouse pointer on the icon.

Multiple levels of folders may be created if desired.

To Open a Folder, click on the icon or the Title of the folder. An open folder displays the icon. Click on a folder link again to close.
To Close all folders, click on the Library Folders link at the top of the folder tree.

To Rename, Move or Delete a Folder or Edit a Folder Title, click on the icon. A folder and its content can be moved to another folder in the same library, or to another library in which the user has an Editor or Contributor role.
You also have the option to delete all items in a folder.

Note: A folder cannot be deleted if it contains items

### 7.3 Items

Items consist of an electronic file or a uniform resource locator (URL). Any type of electronic file may be added to the library, including multimedia objects.

**To Add an Individual Item**
1. Click on a folder where the item is to be added
2. Click the Add new item icon
3. Select the item type, File or URL
4. Add an item Title
5. Add optional Notes if appropriate
6. Click Upload
   
   Note: If the file is large, it may take some moments before the receipt page is displayed.

   Note: Files with extensions .exe .bat .java .jsp .js will be rejected

Folders and items can also be added to the library in bulk by using the Drag-and-drop feature. This is a useful way to copy an existing file from a local or networked drive.

**To Add Folders and/or Items in Bulk**
1. Open the library folder where you want to add the folders and/or items
2. Click the drag/drop function link
3. A Drop Zone panel will be displayed
4. Open Windows Explorer and size the window so the drop-zone is visible
5. Select the folders and/or items in Windows Explorer that you wish to copy
6. Drag them with your mouse into the Drop Zone
7. The selected folders and/or items will be copied into the open library folder

   Note: The drag-drop function uses a Java applet. It will not function unless your browser is configured to allow applets.

   Note: Files with extensions .exe .bat .java .jsp .js will be ignored and will not be added.

**To Edit an Individual Item**
1. Click on the icon next the item
2. To change the title and/or notes, click the **Edit** link
3. To move the item to another folder or library, click the **Move** link
4. To replace the item, click the **Replace** link
5. To delete an item, click the **Delete** link

A grayed-out properties icon indicates that you do not have permission to edit the item. See [library roles](#).

**Note**: Changes made to, or deletions made of library items will not affect documents (evidence) in standards or plans, even if they were previously copied from the library.

### 7.4 Search

Items in the Resource Library can be located by a search function. The system will look for a match in the item title, description and notes (if applicable).

Enter a search term in the box provided and click the **Search** icon or simply press the **Enter** key.

A list of any matching items will be returned.
8 Glossary

8.1 Glossary

The Glossary feature provides an alphabetical list of terms with explanations. Users with an Administrator or Manager role can add, edit and delete terms.

See also the Administration tab > Module Settings > Manage Glossary.
9 Administration

9.1 Overview

The Systems Administration Tab provides authorized users with access to key management functions for the Xitracs system. The tab is only available to users with a role of Administrator.

Administrative functions are grouped into six categories:

- Manage Users
- Module Settings
- System Configuration
- System Reports
- System Settings
- Xitracs Portal

Note: Not all functions described in this section may be available, depending on modules licensed or installed.

9.2 Manage Users

9.2.1 Add Users

The following sections describe the administration of System Users. Portal users, e.g. faculty and staff, are managed separately.

If the Credentials module is installed, see Control Panel > Manage Faculty & Staff members. Otherwise, see Administration > Xitracs Portal > Users.

Users can be added to the system individually or via an import file.

To Add an Individual User

1. Click the Add link
2. Enter a User ID. This will be used as the logon.
3. Enter Last Name, First Name and Email address
4. Enter a Password, or leave blank if the system is connected to a central authentication server. (See Authentication/Single Sign-On).
5. Optionally, set an Expiry Date for the password. This does not affect and central authentication.
6. In a multi-campus system, select a Campus from the drop-down. If no campus is selected the user will have access to all campus items.
7. Select a Role of User, Manager or Administrator (see table below)
8. Select whether the user has access to the Standards module, Credentials module, Planning module or Programs module

Note: If no option is selected, the user access will be limited to the Home page, Library and Calendar.

9. If the user has a role of Manager, access to a module Control Panel may also be selected. Users with a role of Administrator always have access to the control panel.

10. For users with Credentials module access, optionally select a File-Q role of Contributor and/or Processor. File-Q contributors can drag/drop files into a document queue. File-Q processors can view and profile documents in the queue.

11. Click Submit
The tabs and associated functions available to a particular user will vary depending on the user's role in the system. Users with an Administrator role will also have an Administration tab.

! Assigning a user to the Manage team for a standard or plan will not give access to all the manage functions unless the user also has a role of Manager or Administrator.

### Standards Module Tabs

<table>
<thead>
<tr>
<th>User Role</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Home</td>
</tr>
<tr>
<td>User</td>
<td>x</td>
</tr>
<tr>
<td>Manager</td>
<td>x</td>
</tr>
<tr>
<td>Administrator</td>
<td>x</td>
</tr>
</tbody>
</table>

### Credentials Module Tabs

<table>
<thead>
<tr>
<th>User Role</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Home</td>
</tr>
<tr>
<td>User</td>
<td>x</td>
</tr>
<tr>
<td>Manager</td>
<td>x</td>
</tr>
<tr>
<td>Administrator</td>
<td>x</td>
</tr>
</tbody>
</table>

### Planning Module Tabs

<table>
<thead>
<tr>
<th>User Role</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Home</td>
</tr>
<tr>
<td>User</td>
<td>x</td>
</tr>
<tr>
<td>Manager</td>
<td>x</td>
</tr>
<tr>
<td>Administrator</td>
<td>x</td>
</tr>
</tbody>
</table>

### Programs Module Tabs

<table>
<thead>
<tr>
<th>User Role</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Home</td>
</tr>
<tr>
<td>User</td>
<td>x</td>
</tr>
<tr>
<td>Manager</td>
<td>x</td>
</tr>
<tr>
<td>Administrator</td>
<td>x</td>
</tr>
</tbody>
</table>

### Assessment Module Tabs

<table>
<thead>
<tr>
<th>User Role</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Home</td>
</tr>
<tr>
<td>User</td>
<td>x</td>
</tr>
<tr>
<td>Manager</td>
<td>x</td>
</tr>
<tr>
<td>Administrator</td>
<td>x</td>
</tr>
</tbody>
</table>
Note: Users with a Manage role must also have the Control Panel access option selected. File-Q access requires an access role be selected.

9.2.2 Find Users

Existing users may be located by searching using the User Id, Last Name or First Name. Alternatively, click the List all users link.

User details may be edited and users may be deleted from the system via this function.

To Edit or Delete a User
1. Click the Edit link.
2. Search for the user or click the List all users link.
3. Click the Edit link next to a user to change details or the Password link to change the password.
4. In the Edit mode the user’s Last Name, First name, Email Address, Role and Module Access may be changed.
5. In a multi-campus system, select a Campus from the drop-down. (This option is available only when the Campus extension is installed.)
6. To Delete a user, check the box next to the name and click the Delete button.

9.2.3 Groups

Users may be assigned to one or more Groups. By default, every user is automatically assigned to the All User group. Each group may in turn be assigned membership of one or more Libraries, together with an associated role.

! The default All User group must have a role of at least Viewer in the default General Library.

To Create a Group
1. Click the Create a user group link
2. Enter a Name and Description
3. Click Submit

To edit or remove a user group, use the Edit and Delete links.

To Assign Library Access

Note: To create libraries, see Administration > System Configuration > Libraries.
1. Click the Libraries link
2. For each library to be assigned, select a group Role (see below) from the drop-down or leave blank if not to be assigned.
3. Click Submit

<table>
<thead>
<tr>
<th>Function/Role</th>
<th>Editor</th>
<th>Contributor</th>
<th>Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>View item</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Function/Role</td>
<td>Editor</td>
<td>Contributor</td>
<td>Viewer</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>Add item</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Edit own item</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Edit any item</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Delete own item</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Delete any item</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Add folder</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Delete folder</td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

To Assign a User to a Group

1. Select a user using the Find function
2. Click the Groups link
3. Check the box for each group membership required
4. Click Submit

To remove a user from a group, uncheck the appropriate box

*Note: A user cannot be removed from the All Users group.*
9.2.4 Import Users

Users may be added to or removed from the system using a file import. A file format specification is included in a separate document, Xitracs Data Import Guide.

9.2.5 User Access

For systems where the Credentials, Planning or Programs modules are installed, user access to specific departments can be controlled.

1. Go to Administration > Manage Users > Find
2. Click the Access link next to a user
3. Use the Edit link to define the Schools or Departments that the user can access

! When a school is selected, all departments in that school are included. Any specific department selections in that school will be ignored.
If no selections are made all schools and all departments will be available.
The Plan or Program View by Group option is not available to any user where access is restricted to specific departments.

Note: A user must also have access the to the module. See Administration > Manage Users > Find > [USER] >Edit.

9.2.6 User Settings

Certain user options can be controlled through the User Settings function.

Password Settings
Check the box if users will be allowed to change passwords. See also Authentication/Single Sign-On considerations.
The password attributes, such as minimum length, can also be specified.
Check the box if users are to be given a "Forgotten Password" link on the logon page.
The link will allow a user to enter a User ID and, (subject to User ID validation), request a password reminder be sent to the user email address of record.

Note: The forgotten password function cannot be enabled if users are not allowed to change their own passwords.

Calendar Alerts
Check the box to enable the calendar alerts function. This will generate emails to the relevant users to remind them of specified due dates in standards, plans and projects.
An individual user can opt out of receiving alerts by clicking on the User details link.
9.3 Module Settings

9.3.1 Alerts

Email alerts can be generated by the Xitracs system to advise users of calendar due dates.

If enabled, a setting will be available for each user via the User Details link.

**To Configure Alerts**

1. Set the Time at which email alerts will be sent (24 hour format)
2. Enter the sender's email address.
3. Enter the email Subject
4. Enter an email header and footer. (The automatically created alert information will be inserted between the header and footer.)
5. Click Submit.

**Note:** To receive alerts, each user must also enable the function via the User Details link.

9.3.2 Announcements

You can post announcements to appear on the Portal (Home Tab) and optionally set display dates. Longer announcements appear in shortened form with a "more..." link to allow a user to view the entire posting.

1. Click the Announcements link
2. Click the Create an announcement link
3. Enter a Title and Text of the announcement
4. Set a Display and Hide date (optional)
5. Click Submit
6. The announcement may be edited later using the Edit link

9.3.3 Banner

A custom graphic can be uploaded to appear on each page above the tab menu. This must be a JPEG image .jpg file and the dimensions should be 450 pixels wide by 45 pixels high.

1. Click the Banner Upload link
2. Browse for a suitable graphics file. This must be a .jpg file that conforms to the required dimensions.
3. Click Submit

9.3.4 Campuses

*Note: This function is only available on Xitracs systems with the Campus extension installed.*

For systems configured to support more than one campus, the Manage Campus function will be enabled.

Create, Edit or Delete a campus by using the appropriate link.

In multi-campus environments, users can be assigned to a specific campus via the Administration > Users function.
Schools can be associated with a campus via the Credentials Module > Control Panel > Manage Schools function.

**Note:** Once a school has been associated with a campus, the Delete Campus function is disabled. The school association must first be removed for the Delete function to be enabled. (See Credentials > Control Panel > Manage Schools).

### 9.3.5 Departments, Schools & Courses

The following applies only to those Xitracs systems where the Credentials module is **not** installed. For Xitracs systems with the Credentials Module installed, management of schools and departments is via the Credentials > Control Panel > Manage departments function.

#### Department and Schools

**Plans** and **Programs** can be linked to a department. Also, Xitracs Portal™ **users** must belong to a department. Departments are a subset of a school, therefore at least one school must exist in order to create a department.

Schools are the highest level of organization within an institution. For example: School of Business, School of Medicine. There must be at least one school defined in the system.

School **Names** must be unique. For example, there cannot be more than one "School of Business". However, "School of Business" and "Graduate School of Business" is acceptable.

In the system hierarchy, Schools have Departments, Departments have portal users.

**To Add a School Manually**

1. Click the **Schools** link
2. Click the **Create a school** link
3. Enter the **Name** and short **Description** for the school
4. Click **Submit**

**To Add or Remove Schools by File Import**

*See the publication “Xitracs Data Import Guide” for details on file content.*

1. Click the **Import Schools** link
2. **Browse** for the relevant import file
3. **Select the data Separator**
4. Click **Submit**

**To Edit a School**

1. Click the **Schools** link
2. Click the **Edit** link for the relevant school
3. Update the **Name** and **Description** as appropriate
4. Click **Submit**
Department **Names** must be unique. For example, there cannot be more than one “Finance Department”. However, “Finance Department” and “International Finance Department” is acceptable.

**To Add a Department Manually**
1. Click the **Departments** link
2. Click the **Create a department** link
3. Select a **School** with which the department is to be associated
4. Enter the **Name** and short **Description** for the department
5. Click **Submit**

**To Add or Remove Departments by File Import**
*See the publication “Xitracs Data Import Guide” for details on file content.*
1. Click the **Import Departments** link
2. **Browse** for the relevant import file
3. Select the data **Separator**
4. Click **Submit**

**To Edit a Department**
1. Click the **Departments** link
   Alternatively you can locate a department within the **Schools** listing
2. Click the **Schools** link
3. Click the **Departments** link for the relevant school
4. Click the **Edit** link for the relevant department
5. Update the **School** as appropriate
6. Update the **Name** and **Description** as appropriate
7. Click **Submit**

**Semesters**
Semesters are used in conjunction with Course Sections to establish the periods during which courses are delivered. This information is used to filter certain reports by semester or date range.

**To Create a Semester**
1. Click the **Semesters** link
2. Click the **Create a semester** link
3. Enter a **Name** for the semester, e.g. Spring 2014
4. Enter the **Start** and **End** dates for the semester
5. Click **Submit**

**To Edit or Delete a Semester**
1. Click the **Semesters** link
2. Click **Edit** or **Delete** next to the relevant semester
3. Edit the semester **Name** and/or **Dates** if appropriate
4. Click **Submit**

**Courses**

The Course Catalog is used by the Credentials module to map faculty qualifications to courses taught by semester. The information contained in the catalog can be imported easily by using text files. See the separate publication **Xitracs Data Import Guide** for information on how to prepare these files. The course catalog consists of two parts:

- **Courses** - these are the "parent" course catalog entries
- **Course Sections** - these are the actual instances of courses delivered

A Course must be linked to a Department and must have at least one Course Section. A Course Section must in turn linked to a Semester and one or more Faculty Members.

**To Add a Course Manually**

1. Click the **Courses** link
2. Click the **Create a new course** link
3. Enter the **Course Code**, **Title** and short **Description** (these field are required)
4. Select a **Department** from the drop-down
5. Click **Submit**

**Note:** If no department is available in the drop-down, there are no departments in the system - see **Schools and Departments** above.

**To Add or Remove Courses by File Import**

*See the publication "Xitracs Data Import Guide" for details on file content.*

1. Click the **Import Courses** link
2. **Browse** for the relevant import file
3. Select the data **Separator**
4. Click **Submit**

**To Edit a Course**

1. Click the **Courses** link
2. Click the **Edit** link for the relevant course
3. Update the **Title** and **Description** or other fields as appropriate
4. Click **Submit**

**To Add a Course Section Manually**

1. Click the **Courses** link
2. **Search** for a course or click **List all courses**
3. Click the **Sections** link for the relevant course
4. Click the **Create a section** link
5. Enter a **Code** and **Title**
6. Select a **Semester**
7. Click **Submit**

*Note: If no semester is available in the drop-down, there are no semesters in the system - see Semesters above.*

### 9.3.6 Glossary

Users with an Administrator or Manager role can add, edit and delete terms. Terms can also be imported. Refer to the Xitracs Data Import Guide.

Check the available parameter to allow:
- The rich text editor in the add/edit term view
- The glossary to be available to Portal users

### 9.3.7 Libraries

User access to the resource library may be managed by creating additional libraries. User assignment to one or more libraries is via user group membership with an associated role. The default General Library is automatically assigned to the All Users group and cannot be edited or deleted.

**To Create a Library**

1. Click the **Create** link
2. Enter a **Name** and **Description**
3. Click **Submit**

To edit or remove a library use the **Edit** or **Delete** link

### 9.3.8 Reviewers

External reviewer access to published submissions and credentials information can be managed.

**To Add an External Reviewer**

1. Click **Add** a reviewer
2. Complete the **Title** (optional) **Name** and **Email** fields *(the email is the reviewer logon)*
3. Enter a **Password**
4. Check the box if you wish the reviewer to have access to **Credentials** information online
5. Click **Submit**

**To Manage Reviewer Access to Published Submissions**

1. Click the **Standards** link for the reviewer
2. Select the relevant **Agency Standard** from the drop-down *(Standards with a status of 'Offline' will not be displayed)*
3. Set the **Availability Dates** as appropriate
4. Check the **Evidence** and **Restricted Evidence** boxes as appropriate
5. Click **Submit**

Use the **Edit** and **Delete** links to change or remove access to a published agency submission.

⚠️ Only standards published to a Xitracs integrated website can be managed. Websites published to other locations via FTP or HTTP must be secured externally.

⚠️ Any published submission websites that existed prior to Version 3.1 of Xitracs will not be integrated. Concord will have created a location for the website and provided you with the viewer logon parameters. Access to these earlier (non-integrated) websites cannot be managed using the Reviewers function.

**To Manage Reviewer Access to Credentials Information**

1. Click the **Credentials** link for the reviewer
2. Select the **Semesters, Document Types, Departments** and **Schools** that may be viewed
3. Click **Submit**

⚠️ The relationship of Schools and Departments is hierarchical. Therefore, selecting a school will automatically include all of the departments in that school.

To include individual departments, make sure the relevant school(s) are not selected.
9.3.9 **Spellchecker**

You can add custom words to the spellchecker dictionary that is used in the text editor.

To add words manually use the **Add** link. Alternatively, a list of words can be **Imported** from a .txt file with one word per line.

To remove a custom word from the dictionary use the **Delete** link.
9.3.10 Tags

Tags are a useful means of creating relationships. Tags can be assigned to library items, sections (rows) in agency standards and sections (rows) in plans. A tag may consist of a single word (e.g. "grades") or multiple words (e.g. "student retention"), but should not exceed 50 characters including any spaces.

The Manage Tags function list all tags used in the system. Click the View usage link to show where a tag is used.

9.3.11 Xitracs DataPort™

DataPort is an optional feature that automates the transfer of import files such as courses and faculty into Xitracs. It requires that batch jobs be created on the source data system to initiate the file transfer.

Your IT department will need to set this up. A separate publication is available which defines the process. Contact your Xitracs representative for more details.

You can view the file transfer log, check for reported errors and set the email address of those who will be notified when each transfer is made.

You can also test the transfer. Note that this action will update the Xitracs system with the imported data.

9.3.12 Xitracs DataView™

Xitracs DataView™ is an optional feature that lets you create a .accdb (MS Access®) snapshot file of database tables for ad hoc reporting and/or import into a statistical analysis program.

Click on the link to generate and download a snapshot file.

A separate publication is available which defines the tables. Contact your Xitracs representative for more details.

9.4 System Reports

9.4.1 Access Logs

The system records all user access (user and web) to items in the repository in chronological order. The log contains the User Name, User ID, Date, Time, Action, Item and Item ID. Log files can become large. System Administrators should download and clear logs on a regular basis.

View Access logs
1. Select the required Date Range.
2. Check the View radio button.
3. Click Submit.

Download Access logs
1. Select the required Date Range.
2. Check the Download radio button.
3. Click Submit.
4. Click Open to view in Excel or Save as a .xls file.
Delete Access logs

1. Ensure that you have saved a copy of the relevant log to a file.
2. Select the required Date Range.
3. Check the Delete radio button.
4. Click Submit.
9.4.2 Current Sessions

This report details the Name, User ID, time user Logged in, Last access and IP Address of users currently logged on to the system.

*Note: This is a real-time report. No log file is saved by the system.*

**View Current Sessions**
1. Select the required **Date Range**
2. Check the **View** radio button
3. Click **Submit**

**Download Current Sessions**
1. Select the required **Date Range**
2. Check the **Download** radio button
3. Click **Submit**
4. Click **Open** to view in Excel or **Save** as a .xls file

9.4.3 Software Updates

The update log displays a chronological list of software updates, including the Version Number, Date and Time of installation.

*Note: The current version number is displayed on the top right corner of the main Administration page*  

9.5 System Settings

9.5.1 Add-Ons™

Xitracs Add-Ons™ are separately licensed optional system extensions that are available from Concord.

An Add-On is loaded into your Xitracs system using the Administration > System Extensions > Xitracs Add-Ons link. Once loaded, it will be listed

For information regarding the functionality of a specific Add-On, see the documentation provided or contact your local Concord representative.
9.5.2 License

A License file is provided with the Xitracs software and contains parameters specific to the installing organization, including the number of users and standards supported and which features are enabled.

After the initial installation of the Xitracs system, the license file must be imported for the software to operate fully. If changes are made in the future, (e.g. you purchase additional features), you will be provided with a new license file to install the relevant changes.

To install a new license file:

1. Browse for the relevant license file which has been provided to you.
2. Click Submit
3. On the receipt page, click the Server link
4. Click the Reload link, then click OK
5. Logout and then Logon (each user will need to do this to access any new features)

9.5.3 Server

Certain settings for the application server can be configured by a System Administrator.

Server Configuration Options

Configuration Settings

Some functions in the system are controlled via Properties files. These are configured at the time of the system installation and generally are not changed unless there is a system configuration update, such as the addition of a new feature. To avoid having to restart the system when a property file change is being made, the configuration can be reloaded on the fly.

1. Click Reload
2. Click OK to confirm or No to cancel

Email/SMTP Server Settings

Enter the configuration details for the email server. This will be used for all system generated emails, such as Alerts or Survey invitations.

External Server Integration

Certain optional modules and Xitracs Add-Ons™ require integration with an external server. Refer to the documentation provided with the module for parameter settings.

System Cache

Certain parameters in the system are stored in cache memory to avoid multiple database accesses and to improve performance. The cache is automatically reset at intervals. If one of these parameters is changed by a Systems Administrator, there may be a delay in the change taking affect, particularly in multi-server environments.

The cache may be reset manually, to force an update.

1. Click Reset
2. Click OK to confirm or No to cancel
Authentication/Single Sign-On (SSO)

CAS, SAML and Proprietary Authentication

The Central Authentication Service (CAS) and Security Assertion Markup Language (SAML) are single sign-on protocols for the web. If your institution supports CAS or SAML, it can be configured in Xitracs to authenticate users.

Alternatively, proprietary SSO services such as Azure and Okta may be licensed and configured.

If the Auto logon parameter is set, a user will redirected automatically to the institution's sign in and, once authenticated, logged into Xitracs.

LDAP Authentication (Only available for local on-site installations).

In most institutions, user authentication is centrally managed using an LDAP compatible service. To enable the system to authenticate users via the LDAP server, the following parameters should be set:

1. Check Enabled
2. Enter LDAP Server URL
3. Enter User Path
4. Optionally, enter Active Directory Domain or for iPlanet specify the domain to prepend to the logins
5. Check Fallback to local password, if required
6. Enter Additional Servers, if required
7. Click Submit

Note: LDAP support is available for up to four servers. A user attempting to login to the system will be authenticated against the primary LDAP server. If no valid user is found then the next additional LDAP server in the sequence will be searched. If the user is not found in any additional server, the user will be rejected.

9.5.4 Updater

This function is not available for ASP (hosted) systems.

For clients with a locally installed Xitracs system, the Updater function provides a convenient way to download and install newer versions of the application.

Caution. The updater function should be used by an IT professional who is familiar with the local Xitracs system configuration.

If your Xitracs system is up-to-date, a message will be displayed. If there is a new version of the software available, it will be listed as Recommended Version available. If there is a later Optional Version, this will also be displayed. If you are unsure of which version to install, contact your Concord representative or open a support ticket. Click on the Download link to copy the update file down from the Concord software update server. When the download is complete, an Install link will appear next to the update file. Click on this link to initiate the update process.

Initiating the update process will cause the Xitracs application to go offline. You should make sure there are no users logged on before starting the update. You can check this via System Administration > Current Sessions.
Once started, the update process will take approximately five minutes. On completion, a message will be displayed and you will be able to logon to the Xitracs system again. The new version will be displayed on the main System Administration menu page. Sometimes, because of a local server permissions restriction, the Xitracs system may fail to restart automatically after the update. You will need to restart the Xitracs service manually.

### 9.5.5 Volumes

This function is not available for ASP based Xitracs systems.

Files uploaded to the repository are stored in a Volume. In the Xitracs system there is one volume defined (Main).

*Note: URLs and Text Notes are stored in the database and not in a volume*

If it is necessary to change the volume (for example because the existing disk is full) use the Edit function below.

⚠️ **Caution! Do not make any changes in this area unless you are familiar with the parameters.**

Before changing a volume, make sure all files on the existing volume are backed up and have been copied to the new volume.

#### To Edit a Volume

1. Click **Edit**. (Volume Names cannot be edited)
2. Edit **Path** and **Alternate Path**, as appropriate
3. Set **Status** as open
4. Click **Submit**

After the new volume has been defined, the Xitracs service will need to be restarted.

### 9.5.6 Website Store

*This function is not available for ASP (hosted) Xitracs systems.*

Agency standards template with an INTEGRATED website location will publish by default to the website store volume.

⚠️ **Caution! Do not make any changes in this area unless you are familiar with the parameters.**

Before changing a volume, make sure all files on the existing volume are backed up and have been copied to the new volume.

#### To Edit a Website Store Volume

1. Click **Edit**. (Volume Names cannot be edited)
2. Edit **Path** and **Alternate Path**, as appropriate
3. Set **Status** as open
4. Click **Submit**
After the new volume has been defined, the Xitracs service will need to be restarted.

9.6 Xitracs Portal™

9.6.1 Overview

The Xitracs Portal™ is an optional module that allows faculty and staff members to view and input certain information, without having to be a Xitracs system user. The Xitracs Portal makes it easy to gather information in a structured way, without these stakeholders having to learn a new system.

Depending on the modules licensed and tabs enabled, the following accessed by a portal user:

- Standards
- Credentials Base Data
- Credentials Qualifications
- Courses
- Surveys
- Plans
- Programs

Access to the Xitracs Portal is available:

1. Via direct logon to the portal URL at http://yourinstitution.xitracs.net/portal.htm if Concord is hosting your system. If your Xitracs system is locally installed, check with your Network Administrator.

2. Via a single sign-on (SSO) link, if the SSO function is installed.

9.6.2 Settings

If the Xitracs Portal™ is installed, the settings can be managed. Use the Libraries and Tabs functions to control what portal users are able to access. In addition, the graphics and welcome message on the portal home page may be edited. Note that portal users have access to libraries on a read-only basis. See Administration > Libraries for information on how to set up libraries.

A Forgotten Password and Self-Register link can also be enabled. These links will then appear on a portal user's logon page unless Single Sign-On (SSO) is also enabled. See Server Settings.

9.6.3 Users

The following applies only to those Xitracs systems where the Credentials module is not installed.

For Xitracs systems with the Credentials Module installed, portal users are added as faculty and staff members via the Credentials > Control Panel function.

Portal users must belong to a department. See Administration > System Configuration > Departments & Schools.

To Add a Portal User Manually

1. Click the Add link
2. Enter a Title (e.g. Professor, Doctor) - this field is optional
3. Enter a Last name and First name - these fields are required
4. Enter an **Email** address - this field is required
5. Enter and confirm a **Password**. See also Administration > Server Settings > Authentication/SSO if single sign-on is being used.
6. Select a **Department**
7. Enter a **UserId** and/or **Network Name** if used by your institutions - these fields are optional

**Note:** If no department is available in the drop-down, there are no departments in the system - see Manage Departments

### To Add or Remove Portal Users by File Import

*See the publication “Xitracs Data Import Guide” for details on file content.*

1. Click the **Import** link
2. **Browse** for the relevant import file
3. Select the data **Separator**
4. Click **Submit**

### To Edit a Portal User

1. Click the **Find** link
2. **Search** for a faculty member or click **List all**
3. Click the **Edit** link for the relevant portal user
4. Update the **Fields** as appropriate
5. Click **Submit**

### To Change a Portal User Password

*See also Administration > Server Settings > Authentication/SSO if single sign-on is being used.*

1. Click the **Find** link
2. **Search** for a portal user or click **List all**
3. Click the **Password** link for the relevant portal user
4. Update the **Password** as appropriate
5. Click **Submit**

### 9.6.4 User Logs

A **User logs** function is available. This allows an administrator to generate a portal user access report.

Select the date range to be included. The report includes the user, access date and duration, and source IP address.
10  Xitracs Add-Ons™

10.1 Overview

Optional features are available via the Add-Ons function.
Contact your local Xitracs representative to request more information, including pricing.

10.2 Catalog Publisher

The Xitracs Catalog Publisher Add-On™ is an optional feature that lets you publish the course catalog in the credentials module to a website, either in a downloaded compressed file format or direct to a webserver via HTTP or FTP.
More information is available from your Concord representative.

In addition to course and section information for selected semesters, the published catalog will also include any associated syllabi (both at course and section level), assigned faculty names, CVs and course section evaluations (if available).
The look-and-feel of the website can be customized using a template.

To Install the Catalog Publisher Add-On
1. Go to Administration > Systems Extensions > Xitracs Add-Ons
2. Click the Install link
3. Upload the relevant Add-On file (*.war) licensed from Concord
4. To uninstall the Add-On, use the Remove link

To Configure the Catalog Publisher Add-On
1. Click the Settings link
2. Upload a website template using the Template link
3. Edit the website template graphics using the Template images link

Click Links to see where the Add-On is referenced in the Xitracs system.

Refer to the Xitracs Data Import Guide for information regarding the import of syllabi, CVs and evaluations.

To Publish the Catalog
1. Go to Credentials > Control Panel > Xitracs Add-Ons > Publish Catalog
2. Select the published website destination (HTTP, FTP or local download)
3. Select the semester(s) to be included
4. Click Submit
   
   Note: For HTTP/FTP locations, the publish function will overwrite any existing catalog.
10.3 Credentialing Workflows

The Xitracs Credentialing Workflows Add-On™ is an optional feature that lets you manage the review and approval of new or existing faculty to teach specific courses.

Credentialing activities in the Xitracs Portal are managed via Workflows. Using this function, one or more portal users can be assigned to activities such as form completion or approval.

Credentialing workflows are defined in Templates. Click the Create template link to add a new workflow template.

A task workflow template is linked to a Xitracs module (e.g. Credentials) and consists of a sequence of Steps, each of which can be assigned to one of:

- The workflow initiator - the person who starts the workflow
- A team - either a specific team or to allow the initiator to select a team
- A role - to allow the initiator to select a role
- A person with a role - to allow the initiator to select a person with a specific role
- A specific person - to allow the initiator to select a person (from faculty & staff)

A Step can be one of four types:

- Form - The assignee completes the form associated with the step - see below
- Approval - The assignee(s) marks the step approved
- Signature - The assignee(s) marks the step as signed
- Notification - Sends an email only the assignee(s) - Typically set as the final step

If the step is a type Approval, there is a parameter to set a Discussion option if the assignee is not a single person. When this option is set, assignees will be able to post discussion comments which will be visible to the assignees only.

If the step is a type Notification, there is a parameter to set an Email Report option. When this option is set, a PDF copy of the credentialing report will be attached to the notification email.

If the step is a type Form, a Fields link will appear in the function column. Click this link to add fields to the form or edit/remove existing fields. Each field can be of a Type, depending on the input required at the associated step. If the type is Person the field will include a search look-up from faculty and staff in the system; check the Person Details parameter if you want a link to the selected person's details to appear in the form. If the type is Courses the field will include a search look-up from courses in the system.

You can specify the layout of fields in a form by specifying a Field Width and whether the next field should be Inline. (Note that there are a maximum of 12 columns available for each line of a form. For example, a width of 6 will occupy 50% of the row.) Check the No Label parameter to suppress the field name; this is useful if you have multiple rows of the same fields and do not need the column header repeated.

Check the Allow Attachments parameter to add a file upload capability for a field. You can also specify if at least one file must be uploaded in order to complete the form.
You can change the position sequence of a field in a form by clicking the **Edit** link for a field and then entering a new position number. You will get a warning message if you have duplicate position numbers in the form.

If a step is assigned to a person with a role or a specific person, you can specify whether the assignee is able to **send the workflow task back** to a earlier step, for example if not approved.

Click the **Access** link to assign the faculty and staff **roles** able to use a template when starting a workflow.

The **Report template** function controls the MSWord® .dotx template that is used when generating workflow reports in Word or PDF format.
Index

- A -

aaccsb 45
aaccsb activities 45
aaccsb reports 49
access logs 169
action row 86
action team 80, 139
Active Directory 172
active plans 73
active standards 121
activities 45
activity log 84
add comment 78, 125, 130
add document 127
add evidence 127
add faculty member 43
add from library 127
add hyperlink 76, 125
add image 76, 125
add narrative image 14
add outcome 101
add portal user 175
add program outcome 105
add response 130
add rubric 31
add students 38
add survey questions 95
add url 127
add user 157
Add-Ons 171
administration 157
alerts 162
announcements 162
announcements 12
approval 105
approval workflow 110
AQIP Projects 134
archive 142
artifact instructions 18
artifacts required 18
assessment methods 26, 28
assessment narrative 24
assessment PDF report 41
assessment required setting 26
assessment status 26
assessment time track 119
assessment workflow comparison 25
assessment workflow notes 24
assessment workflow progress 24
assessment workflow report 25
assessment workflows 23
assign plan to portal users 76
assign program rubric 118
autocode 101, 110
automap credentials 71

- B -

backup 142
banner 162
base data 66
blackboard 16, 17, 33
brightspace 16, 34
browser support 11
budget field 76
build a survey 95
build plan 86

- C -

calendar alerts 161
campus 162
canvas 16, 17, 33
CAS authentication 172
catalog 52
catalog fields 52
catalog labels 52
catalog publisher 177
change faculty & staff password 64
change field name 105
change password 13
change student password 38
check duplicate files 132
check URLs 132
CIP Code reports 49
CIP codes 44, 48, 57
CLOE import 34
collateral 134
comment 75, 124
comments 122
complete workflow 20
confidential evidence 132
confidential section 74, 122
confidential sections 139
control panel - credentials 51
control panel access 157
convert to PDF 127
copy a plan 89
course assessments 17, 26
course availability 52
course catalog 52
course eligibility 45
course eligibility tracking 69
course information 42
Course Link Field Set 110, 113
course outcome maps 108
course outcomes 26, 56
course qualifications 44
course reports 109
course sections 47
course syllabus 47
courses 44, 47
cover page 89, 147
create a program 113
create a survey 95
create workflow 18
credential reports 49
credentialing 58
credentials document types 66
credentials documents 46
credentials module 42
credentials report header and footer 70
curriculum maps 108
cycle 138
cycle length 119
departments 47
departments by school 47
direct outcome mapping 26
direct reports 64
disable outcome edit box 118
disciplines 61
distribute a survey 96
distribute plan 89
distribution lists 98
document banner 89, 147
document footer 89, 147
document header 89, 147
document settings 89, 147
document template 89
downloads 127
download evidence 132
due date 18, 77, 84, 130
duplicate evidence items 132
edit faculty & staff member 64
edit portal user 175
edit program outcome 105
edit standard 74, 122
edit students 38
edit user 159
eligibility 45
email alerts 13, 162
email plan 89
email SMTP settings 172
email survey link 96
email token 97
endnotes 151
evidence 127, 132
evidence checklist 127
evidence links 125
evidence list 132
exception reports 109
exclude evidence item 127
exclude sections 139
extended data 66
extended program detail 118
external outcome maps 108
external outcomes 114
external reviewers 166
extract pages 127
- F -
faculty & staff teams 58, 59
faculty base data 43
faculty courses 44
faculty credentials 43
faculty documents 46
faculty eligibility 52, 66
faculty extended data 43
faculty information 42
faculty qualifications 44
faculty roster 49
faculty status 66
faculty/staff member as student 64
feedback 46, 175
field result 101, 110
field sets 92
file-q role 157
File-Q™ drag/drop 50
File-Q™ feature 50
File-Q™ Workflow Channels 59
finish goal 82
focused report 138
folder description 153
folders 153
force complete 20
force next 20
forgotten password 175
free-form plans 73
FTP 89, 147
FTP upload 79, 137

- H -
header row 86
HLC Index to criteria 145
home page 12
home page calendar 12
hyperlink 76, 125

- I -
import 142
import assessment settings 40
import course outcome scoring methods and thresholds 40
import course outcomes 40
import faculty & staff members 64
import license 172
import plan portal assignments 89
import program data 118
import programs 118
import students 38
import user 161
inactive outcomes 114
inactive program outcome 105
indirect outcome mapping 26
information link 74, 122
information row 86
institution outcomes 114
introduction 147
iPlanet 172

- L -
LDAP 172
learning outcomes 114
library 153
library folders 153
library items 154
library role 159
library search 155
license 172
licensures 43
link a survey question 95
link errors 125
link field 101
link survey to a plan 97
link to evidence 14
link to plan 76
link to survey 76
linked outcomes 26
link-only field 110
LMS gradebook linking 17
LMS key 52
LMS name 52
LMS settings 33
LMS transfer 23
location 66
lock semester 63
log 75, 84, 124
logoff 11
logon 11
logout 11
logs 169, 171

- M -
manage campuses 162
manage departments 60
manage faculty & staff members 64
manage glossary 166
manage libraries 166
manage outcomes 37
manage plans 85
manage portal 175
manage programs 113
manage schools 62
manage semesters 63
manage standards 142
manage surveys 95
manage team 80, 139
map levels 114
map reports 109
map standard 150
map types 114
mapped outcomes 26
masquerade mode 64
matching courses 48
matching faculty 48
matrix 74
menu 13
merge duplicate files 132
method 28
method lock 28
methods 41
metric 110
modify rubric 31
move folder 153
move library item 154
move plan row 86
multi-use standards 151

- N -
narrative 76, 125
narrative cleanup 125
narrative format fixes 125
narrative history 125
narrative links 127
new plan cycle 89

- O -
other items 134
outcome assessment 28
outcome assessment maps 108
outcome course map 28
outcome datasets 28
outcome field 101
outcome map 28
outcome mapping 26
outcome reporting map 104
outcome reporting maps 108
outcome rubric 28
outcome types 114
outcomes 28
outcomes library 28
outcomes methods 28

- P -
partial publishing 136, 137, 145
password 11, 157
password expiry date 157
password settings 161
past due sections 84
paste from Word 14
PDF 79, 137
PDF page break 14
PDF template 151
permissions 77
plan cycle 89
plan cycle names 89
plan departments 93
plan groups 93
plan links 76
plan map 83
plan narrative 76
plan PDF template 93
plan portal email 97
plan portal settings 97
plan properties 85, 89
plan status 78
plan summary 83
plan template 79
plan track timeframes 94
plan tracks 94
plan website banner 93
plan website template 93
plan workflow 98
planning 73
plans 73, 145
plans list 73
portal 162
portal assessment email 40
portal assessment settings 40
portal assignments 122
portal banner 162
portal email 147
portal email settings 151
portal libraries 175
portal report 147
portal self-register 175
portal settings 175
portal tabs 175
portal user assignment 125
portal user department 163
portal user input 125
portal user logs 175, 176
portal user password 175
portal users 147
portal welcome message 175
post comment 75, 124
preamble 147
preview plan 79
preview submission 136
program archive 104
program assessment 101
program assessor 103
program assignment 103
program CIP codes 116, 118
program coordinator 103, 118
program course type 113
program courses 113, 118
program cycles 101, 119
program data import 118
program detail panel 115
program disciplines 113
program end 118
program end date 118
program enrollment 32
program enrollment types 118
program feedback 105
program field child status 118
program field label 118
program field labels 105
program field range 110
program field set results 110
program field sets 110
program groups 116
program log 106
program outcomes 113
program peer reviewer 103
program portal user settings 115
program properties 113, 118
program report 104
program report banner 104
program report template 115
program reports 109
program role assignment 103
program roles 118
program rubrics 116
program search 106
program start 118
program start date 118
program types 120
program workflow 105
programs email 115
programs overview 100
progress report 84
project summary 122
project tasks 122
project team 122
projects 134
properties 142, 145
publish catalog 42, 177
publish continuous web page 137
publish course catalog 177
<table>
<thead>
<tr>
<th>Index</th>
<th>185</th>
</tr>
</thead>
</table>

- **Q** -
  - QEP 134
  - qep enable 142
  - qualification settings 69
  - qualification type 69
  - qualification types 66
  - qualifications 43
  - Quality Enhancement Plan 134

- **R** -
  - recent activity 12
  - reinstate goal 82
  - rejected file extensions 127, 154
  - rename folder 153
  - replace evidence 132
  - replace library item 154
  - report 125
  - reporting schedule 104
  - resend survey email 97
  - reset cache 172
  - resource library 153
  - response 125
  - response completion 106
  - response cycle 138
  - response cycle names 147
  - response cycle settings 145
  - restore 142
  - restricted evidence 132
  - retrieve 142
  - retrieved plans 73
  - retrieved standards 121
  - review team 80, 139
  - reviewer access 166
  - reviewers 166
  - roles 43, 66, 80, 139
  - roster report header and footer 70
  - rubrics 31

- **S** -
  - SACSCOC roster template 70
  - SAML authentication 172
  - school listing 47
  - schools 47
  - scorer instructions 18
  - scorer map 20
  - search 155
  - search filters 106
  - section delivery 52
  - section faculty 52
  - section location 52
  - section type 52
  - section-level assessments 17
  - select course link field set 113
  - select program field set 113
  - semester LMS name 63
  - semesters 63
  - send programs email 115
  - server integration 172
  - session expiry 11
  - sessions 171
  - show comments 125
  - single sign-on 172
  - skip reporting cycle 101
  - snapshot 83, 106
  - software updates 171
  - spellchecker custom words 168
  - SSO 172
  - staff credentials 43
  - standards 121
  - standards activity log 141
  - standards due date report 141
  - standards link check report 141
  - standards list 121
  - standards presentation templates 151
  - standards progress report 141
  - standards word count report 141
  - start a program 113
  - start date 77
  - status 78, 130
  - status settings 145
  - storage location 174
  - student as faculty/staff member 38
  - student base data 32
  - student courses 32
student group 39
student groups 32
submission status 130
submission template 136, 137
supervisor 64
supporting documents 127
supporting narrative 125
survey activity 84
survey availability 95
survey dates 95
survey distribution 98
survey questions 84
survey respondents 97
survey responses 84
survey status report 84
surveys 83
syllabus 47
synchronize credentials 71
system administration 157
system cache 172
system level users 157

- T -
tabs 13
tag usage 169
tags 105, 169
task forms 58
task workflows 58
team assignment 80, 139
team type 80, 139
teams 59, 80, 139
template 85, 142
terminate a program 113
terminated program 118
text cleanup 125
text editor 14
thresholds 28
threshold labels 41
threshold lock 28
timeframes 94
track changes 125

- U -
updater 173
upload library item 154

user access 13, 161
user details 13, 161
user groups 159
user ID 11, 157
user role 13
user roles 157

- V -
volume settings 172
volumes 174

- W -
website banner 89, 147
website location 89, 137, 147
website settings 147
website store volume 174
website tabs 89, 147
website template 89, 147, 151
Word template 151
workflow 82
workflow access 58
workflow channels 98
workflow details 20
workflow inbox 74, 82
workflow list 23
workflow progress 20
workflow rubric comment field 41
workflow scoring option 41
workflow status 74
workflow steps 58, 98
workflow student source 41

- X -
Xitracs Add-Ons 171
Xitracs portal 175
xitracs system updates 173